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LICENSE TERMS AND CONDITIONS

FasTrak SoftWorks, Inc.

Licensor is the owner of all rights, including the copyright, in and to that certain set of executable computer programs identified

in the Registration Form, including design and structure thereof (the "Software"), together with all manuals and other written or

printed technical material provided with the Software to explain its operation and to aid in its use (the "Documentation").

Licensee wishes to have the right to use the Software, and Licensor is willing to grant such a right to Licensee on the terms and

conditions set forth herein.

1. GRANT OF LICENSE. In consideration of Licensee's payment of the license fee referred to below and Licensee's agreement

to abide by the terms and conditions stated herein, FasTrak SoftWorks, Inc. (referred to as "Licensor") grants Licensee a

nonexclusive right to use and display one (1) copy of the Software with respect to one microcomputer at a time for so long as

Licensee complies with the terms hereof. Licensor retains the right to terminate this Agreement and Licensee's rights at any time,

by written notice to Licensee, in the event Licensee violates any of the provisions hereof.

Licensor reserves all rights in and to the Software and Documentation not expressly granted to Licensee herein. Licensee agrees

to pay Licensor the license fee specified by Licensor as of the date hereof, payable in full upon deliver of a copy of the

Software and Documentation to Licensee. Licensee acknowledges that the license fee payable hereunder is consideration solely

for the right to use the Software, and payment thereof will not entitle Licensee to support, assistance, training, maintenance or

other services, or the enhancements or modifications to the Software which may subsequently be developed by Licensor, except

as otherwise expressly provided in this Agreement.

2. LICENSEE'S AGREEMENTS. Licensee agrees to comply with the terms and conditions set forth in this Agreement,

specifically including but not limited to the following:

a. Licensee will take all reasonable steps to protect the Software from theft or use contrary to the terms of this

Agreement.

b. Licensee agrees to pay Licensor additional license fees as specified by Licensor if and to the extent Licensee intends

to use or does use the Software in any way beyond the scope of this Agreement.

c. Licensee agrees not to modify the Software and not to disassemble, decompile, or otherwise reverse engineer of the

Software.

d. Licensee agrees to either destroy or return the original and all existing copies of the Software to Licensor within

five (5) days after receiving notice of Licensor's termination of this Agreement.

e. Licensee agrees not to disclose the Software or Documentation or any part thereof or any information relating

thereto to any other party, it being understood that the same contains and/or represents confidential information

which is proprietary to Licensor.

3. OWNERSHIP OF SOFTWARE. Licensee shall be deemed to own only the magnetic or other physical media on which the

copy of the Software provided to Licensee is originally or subsequently recorded or fixed, as well as any boards, key-locks, or

cables provided for use with the Software, but an express condition of this Agreement is that Licensor shall at all times retain

ownership of the Software recorded on the original diskette copy and all subsequent copies of the Software, regardless of the

form or media in or on which the original or other copies may initially or subsequently exist. This Agreement does not

constitute a sale of any copy of the Software to Licensee.

4. POSSESSION AND COPYING. Licensee agrees that the Software will only be displayed or read into or used on one (1)

computer at a time, at the location designated for notices to Licensee under paragraph 13, below. Licensee may change the

computer on which Licensee uses the Software to another computer at such location. Licensee agrees not to make copies of the

Software other than for its own use, all of which copies shall be kept in the possession or direct control of Licensee. Licensee

agrees to place a label on the outside of all copies showing the program name, version number, if applicable, and Licensor's

copyright and trademark notices in the same form as they appear on the original licensed copy

5. TRANSFER OR REPRODUCTION. Licensee is not licensed to copy, rent, lease, transfer, network, reproduce, display or

otherwise distribute the Software except as specifically provided in this Agreement. Licensee understands that unauthorized

reproduction of copies of the Software and/or unauthorized transfer of any copy of the Software is a violation of law and will

subject Licensee to suit for damages, injunctive relief and attorney's fees. Licensee further understands that it is responsible for

the acts of its agents and employees. Licensee may not transfer any copy of the Software to another person or entity, on either a

permanent or temporary basis, unless Licensee obtains the prior written approval of Licensor which will ordinarily be subject to

payment of Licensor's then current license transfer fee. Such approval will not unreasonably be withheld if Licensee advises

Licensor in writing of the name and address of the proposed transferee, such transferee is suitable in Licensor's sole judgement,

and such transferee agrees in writing to be bound by the terms and conditions of this Agreement. If the transfer is approved,

Licensee must deliver all copies of the Software, including the original copy to the transferee.



6. ENHANCEMENTS AND UPDATES. Licensor may from time to time release updates of the Software incorporating changes

intended to improve the operation and/or reliability of the Software. Such updates will be provided to Licensee at no charge

(except shipping charges and media costs) for a period of twelve (12) months from the date hereof, and Licensee agrees to install

all updates designated by Licensor as mandatory. Licensor may also offer enhanced versions of the Software from time to time

incorporating changes intended to provide new or enhanced features and/or capabilities, at such license fees as Licensor may

from time to time establish.

7. LIMITED WARRANTY AND DISCLAIMER OF LIABILITY. LICENSOR HAS NO CONTROL OVER THE

CONDITIONS UNDER WHICH LICENSEE USES THE SOFTWARE. THEREFORE, LICENSOR CANNOT AND DOES

NOT WARRANT THE PERFORMANCE OR RESULTS THAT MAY BE OBTAINED BY ITS USE. HOWEVER,

LICENSOR PROVIDES THE FOLLOWING LIMITED WARRANTY:

Licensor warrants, for a period of twelve (12) months only, that the Software shall be free from significant programming errors.

Licensor further warrants that it has full power and authority to grant the rights granted by this Agreement with respect to the

Software and that the use by Licensee of the Software and Documentation will not infringe the rights of others. In the event

Licensee believes that it has discovered one or more significant programming errors, Licensee shall immediately notify Licensor

of such fact in writing. If such notice is received by Licensor within twelve (12) months from the date hereof, Licensor shall,

within a reasonable time, subject to the demands of Licensor's other customers and subject to delays beyond Licensor's control

(including but not limited to labor trouble, illness, delays in shipment of materials, and bad weather), at Licensor's expense,

correct the programming errors. In the event Licensor is unable to correct the programming error within a reasonable time,

Licensee may elect to terminate this Agreement and receive a refund of the licensee fee paid hereunder. For purposes hereof, a

programming error is "significant" only if, as a result thereof, the software does not substantially perform the functions

described in the Documentation. Licensor does not warrant that the operation of the Software will be uninterrupted or error

free. EXCEPT FOR THE ABOVE EXPRESS WARRANTY, LICENSOR MAKES AND LICENSEE RECEIVES NO

WARRANTIES, EXPRESS, IMPLIED, STATUTORY OR OTHERWISE, AND LICENSOR SPECIFICALLY DISCLAIMS ANY

IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

THE REMEDY PROVIDED HEREIN IS EXCLUSIVE. UNDER NO CIRCUMSTANCES WILL LICENSOR BE

RESPONSIBLE FOR DIRECT, INDIRECT, INCIDENTAL, CONSEQUENTIAL OR OTHER DAMAGES OR LOST

PROFITS. LICENSEE ACKNOWLEDGES THAT THE LICENSE FEE HEREUNDER IS NOT ADEQUATE FOR

LICENSOR TO ASSUME OBLIGATIONS TO LICENSEE GREATER THAN THE EXPRESS REMEDY PROVIDED

ABOVE.

8. GOVERNING LAW. The validity and performance of this Agreement shall be governed by Wisconsin law, except as to

copyright and trademark matters which are governed by United States laws and international treaties. This Agreement is deemed

entered into in Wisconsin. All lawsuits arising out of this Agreement shall be brought in a court of general jurisdiction in

Milwaukee, Wisconsin. Licensor shall be entitled to recover its costs and expenses (including attorney's fees) incurred in

enforcing its rights under this Agreement.

9. WAIVER. The failure of Licensor to enforce any of the provisions hereof shall not be construed to be a waiver of the right to

enforce such provisions at a later time or to enforce any of the other provisions hereof.

10. EFFECT OF TERMINATION. The expiration or termination of this Agreement shall not affect the obligations of Licensee

which by their character are of continuing nature.

11. INTEGRATION. This Agreement sets forth the entire understanding and agreement of the parties shall be bound by any

conditions, definitions, warranties or representations with respect to any of the terms or conditions hereof other than as

expressly provided in this Agreement. This Agreement may only be modified by a writing signed by the party to be charged.

12. BINDING EFFECT. This Agreement shall be binding upon and shall inure to the benefit of the parties hereto and their

respective successors and assigns, subject to the limitations on the transfer of Licensee's rights to the Software provided in

paragraph 5, above.

13. NOTICES. All notices shall be in writing and shall be hand delivered or sent by U.S. mail, first class, postage prepaid, if to

Licensor at its address first above written, and to Licensee at the address indicated in the Registration Form. A party may change

its address for notices at any time by notice to the other party in the manner provided herein, but each party may have only one

address for notices at a time.

14. REGISTRATION FORM. The Registration Form is a part of this Agreement and is incorporated herein by reference. This

Agreement will not take effect, and Licensee will have no rights whatsoever with respect of the Software, unless and until the

Registration Form is duly executed and returned to the Licensor and is accepted by Licensor.
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Welcome to FTVersionTrak

Thank you for choosing FTVersionTrak, FasTrak SoftWorks' powerful file change man-

agement system for storing and archiving sensitive files and projects.
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Customer Support

It is our goal that customers become proficient users of our software as quickly and easily

as possible. With that in mind, FasTrak makes available a number of support options. Com-

monly asked questions can usually be answered with this online help, the user manual, or

by visiting our website at www.fast-soft.com. Our website features easy-to-access FAQs,

technical resources, and system documentation.

For real-time how-to help and advanced troubleshooting, contact FasTrak's customer cen-

ter and speak directly with a technical support representative. Our trained experts offer

convenient, accurate, and prompt assistance.

Customer Support 262.238.8088

Customer Support Fax 262.238.8080

Email support@fast-soft.com

Website www.fast-soft.com

You can also send questions, comments, and suggestions to:

FasTrak SoftWorks, Inc.

PO Box 240065

Milwaukee, WI 53224-9003

- 14 -
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What is FTVersionTrak?

FTVersionTrak is a powerful file change management system for storing and archiving sens-

itive files and projects.

FTVersionTrak is critical to the successful management of change-sensitive information

over an extended period of time. This software enables users to track, view, and report

changes made to files, folders, and multi-file projects. FTVersionTrak can be easily in-

tegrated within FasTrak's 505 WorkShop and PLC WorkShop for Modicon suites to

efficiently manage and control precise and complex PLC programs, and is capable of archiv-

ing files of any type, such as *.DOC, *.XLS, *.BMP, and *.PDF, as well as FasTrak PLC

programming files.

Powerful Version Control

The core of FTVersionTrak is the Repository File System, a central and secure location for

files and folders stored in the FTVersionTrak database. This compressed database looks

and behaves like the familiar Windows Explorer tree structure. The master copy of a file

stored in FTVersionTrak is not accessed directly by the user. Rather, FTVersionTrak cre-

ates a copy of the file when the user retrieves it from the repository. A copy of the file is

then placed in the user's working directory, where it becomes editable once the user

checks it out from the repository. No two users may check out the same file at the same

time.

Change Management

While the file is checked out, any changes made to the file appear only in the user's work-

ing directory. Once the user checks the file back into the repository, FTVersionTrak

creates a new version of the file, along with an automatic, detailed history. Versions housed

in the repository may be checked in and out, searched for, listed with history, compared, re-

viewed, renamed, deleted, or rolled back.

- 15 -
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Additional Features

l Familiar and easy-to-use folder tree structure

l Support forelectronic signingofdocuments (portions ofCFR21 Part 11 Standard)

l Printable version history list

l Ability to create version histories for archived files

l User-defined state transitioning

l Multiple version labeling options

l User-configurable log of user actions

l Configurable automatic deletion of obsolete files

l Seamless integration with PLC WorkShop products

l Support for electronic signing of documents (compliant with portions of FDA 21
CFR Part 11)

l Printable version history list

l Ability to create version histories for archived files

l User-defined state transitioning

l Multiple version labeling options

l User-configurable log of user actions

l Configurable automatic deletion of obsolete files

- 16 -
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Specifications

l Database Technology – FTVersionTrak is delivered with MS SQL Server 2008
Express. It may also be used with MS SQL Servers.

l Powerful Security – Combined with two levels of security – server-based and re-
pository-based – FTVersionTrak offers the highest protection for your valuable
data. For maximum flexibility, user- and group-based permissions may be set, with
these permissions based on both Windows and SQL Authentication.

l PLC Program Support – Designed to integrate with FasTrak's 505 and Modicon
PLC programming software.

l Windows Compatibility – Designed and tested under Windows XP, Windows
Vista, Windows 7, Windows 8, and Windows 10.

l Product Upgrades – Regular product upgrades may be obtained by convenient
download from www.fast-soft.com. Notifications via email are sent for all major
feature releases.

l Customer Service – When you contact us for support, you will receive im-
mediate and accurate solutions to your questions, resulting in less downtime. You
will have access to the engineers who design our software packages.

l Site Licenses – Keyless site licenses are available, which eliminate tracking and
lost keys.

l Annual Maintenance Agreements – Following expiration of the one-year war-
ranty period, maintenance agreements – which include unlimited technical support
and product upgrades – are available for purchase on an annual basis.

- 17 -
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FTVersionTrak PE Overview

FTVersionTrak PE is a slim, lightweight version of the software that is designed spe-

cifically for users of PLC WorkShop for Siemens 505 and PLC WorkShop for Modicon.

FTVersionTrak PE combines the most valuable features of the advanced edition, including

limitless version histories, side-by-side comparisons of logic programs, and seamless in-

tegration with PLC WorkShop, into an easy to use, more affordable package.

FTVersionTrak PE requires very little time to install and set up, so that you may begin to

take advantage of the benefits of using the software immediately. The interface has also

been simplified, so that access to all areas of the software can be made from the imbedded

FTVersionTrak PE Toolbar located in PLC WorkShop.

To learn more about how to use FTVersionTrak PE with your PLC WorkShop product,

see the Using FTVersionTrak with PLC WorkShop Quick Start Guide or view the online help

topics included with your copy of PLC WorkShop.

- 18 -
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Version Control

One of FTVersionTrak's main functions is version control, which is the ability to maintain

and track many versions of a single file, including a history and comments of the changes to

the file through each version.

Version control is a critical component in managing change-sensitive information over an

extended period of time. Using FTVersionTrak for version control efficiently addresses

many common challenges to managing change-sensitive information, some of which are lis-

ted below.

Group Coordination

When multiple people are changing content within a file or group of files, it is important to

make sure that everyone is aware of the changes being made. FTVersionTrak achieves this

by allowing only one user to be able to edit a file at one time. The master copy is auto-

matically updated with each change once it is checked in, assuring that everyone has access

to the latest changes.

Version Tracking

Archiving and tracking of older versions of PLC programs and other files permits retrieval

for bug tracking and comparison to newer versions. A new version of the file is created

each time a user checks in a file, but older versions are still accessible. This allows a roll-

back to an older version if the new version is unnecessary, incorrect, or not applicable to a

different situation.

Cross-Platform or Reusable Data

Instead of storing and keeping track of multiple files that only differ slightly depending on

their application, FTVersionTrak can maintain a single instance of a file with different ver-

sions that reflect its varying applications.

- 19 -
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Getting Started

This user guide will guide you through setting up and using FTVersionTrak to protect and

manage your change-sensitive files. It is divided into three sections to help users get star-

ted using FTVersionTrak as quickly as possible.

NOTE: The following first two sections only apply to the

advanced edition of the software, and are not applicable to

FTVersionTrak PE. FTVersionTrak PE users should skip

directly to Using FTVersionTrak. or view Using

WorkShop with FTVersionTrak in the PLC WorkShop

help.

Working in the Main Window

This section illustrates the feature-rich interface that makes FTVersionTrak such a power-

ful yet easy to use change management application. This section will guide you through all

the different menu options, toolbar buttons, and view options.

Using the Repository File System

This section introduces you to the concept of the repository - the virtual file management

system FTVersionTrak uses to manage and organize files. This section details how to cre-

ate, connect to, and protect a repository, as well as how to add, edit, and remove files and

folders within the repository. System administrators and project managers should start here.

Using FTVersionTrak

This section describes the version control features that all project members will encounter

when using FTVersionTrak. This section details the method of setting up a local machine

to check files in and out, tag files with information that will make them easier to track and

manage, and view that information to get a clear picture of project status.

- 20 -
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Introduction to the Main Window

The FTVersionTrak main window is the starting point for all work. The key features of the

window are labeled next to the following sample.

- 23 -
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Using the Title Bar

The title bar spans the top of the FTVersionTrak window.

Use the title bar for three purposes:

n To identify the application being used. In the example above, it is FTVersionTrak.

n To move the window.

n To change the size or position of the window.

- 24 -
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Using the Menu Bar

The following menus appear in the main window, just below the title bar.

The following list describes the commands available in each menu. Not all menus and com-

mands displayed may be available, depending upon the operation in progress. The

commands available in each menu are also subject to availability based on your edition of

the software.

File

l Create New Repository – This command creates a new FTVersionTrak re-

pository. You may also create a new repository by clicking the toolbar button
or by pressing CTRL+N.

l Connect to Repository – This command is used to connect to an existing FTVer-

sionTrak repository. You may also connect to a repository by clicking the
toolbar button or by pressing CTRL+C.

l Disconnect from Repository – This command closes the active repository but
leaves FTVersionTrak open. This command can only be accessed from the menu.

l Repository Info – Selecting this command will display the Repository In-
formation dialog box, which contains information about the repository, such as the
name of the repository, the name of the server it resides in, the size of the re-
pository, when it was created, and who created it.

l Create New Folder – This command creates a new folder within the active re-

pository. You may also create a new folder by clicking the toolbar button or
right-clicking a repository folder and then clicking New Folder from the shortcut
menu.

l Set Working Directory – This command item is used to designate a folder on a
local machine to store working copies of files retrieved from FTVersionTrak. You

may also set the working directory by clicking the toolbar button, pressing
CTRL+W, or right-clicking a repository folder and clicking Set Working Dir-
ectory from the shortcut menu.

- 25 -
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l Add Files – This command is used to select new files from the local machine to
add to the active repository. You may also add files to the repository by clicking

the toolbar button or by right-clicking a repository folder and then clicking
Add Files from the shortcut menu.

l Add Folder – This command is used to add a folder and its contents to the re-
pository as either a repository folder or a multiple file unit that functions as a
single repository file. You may also add folders to the repository by clicking the

toolbar button or by right-clicking a repository folder and then clicking Add
Folder from the shortcut menu.

l Label – This command applies a label to the contents of a repository folder. This
label is associated with the latest version of each file in the repository folder and
can be used as a "snapshot" of the state of the contents of the folder at the time

the label was applied. You may also apply a label by clicking the toolbar but-
ton or by right-clicking a repository folder and then clicking Label from the
shortcut menu.

l Share – This command is used to place a repository file into another repository
folder. Though a shared file is located in two or more folder, it retains all of its his-
tory, including versions, labels, and electronic signatures.

l Properties –This command item is used to view or modify the properties of the
selected file or folder.

l Generate File System Report – This command will generate a report of the act-
ive repository file system. You may also generate a file system report by pressing
CTRL+G.

l Exit – This command closes the FTVersionTrak application. You may also exit

FTVersionTrak by pressing ALT+F4 or by clicking the title bar button.

Edit

l Edit File – Selecting this command automatically checks out the selected re-
pository file, launches the application associated with the file, and opens the
selected file, making it ready for editing. You may also edit a file by double-click-
ing the file or by right-clicking the repository file and then clicking Edit File from
the shortcut menu.
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l View File – Selecting this command after selecting a repository file launches the
application associated with the file and opens the selected file in read-only mode,
allowing you to see the file but not edit it. You may also view a file by right-click-
ing the repository file and then clicking View File from the shortcut menu.

l Delete – Select this command to remove the selected file or folder from the
FTVersionTrak main window without removing the file or folder from the re-
pository completely. You may also delete a repository file or folder by selecting

the item to delete and then pressing DELETE, clicking the toolbar button, or
by right-clicking the item to delete and clicking Delete from the shortcut menu.

l Rename – Select this command to rename the selected repository file or folder
while retaining all the version history of the file or folder. You may also rename a
file or folder by right-clicking the item and then clicking Rename from the short-
cut menu or by selecting the item to rename and single-clicking the name of the
file or folder.

l Restore – Select this command to restore a deleted repository file or folder to the
FTVersionTrak main window. Restore is only available when the View Deleted
Items option is enabled and a deleted item is selected. You may also restore a file

by clicking the toolbar button or right-clicking the deleted item and clicking
Restore from the shortcut menu.

l Destroy – Select this command to completely and permanently remove a re-
pository file or folder, as well as any associated version history, from the
repository. Destroy is only available when the View Deleted Items option is en-
abled and a deleted item is selected. You may also destroy a file or folder by right-
clicking the deleted item and then selecting Destroy from the context menu.

l Select – Select this command to quickly search for and select items displayed in
the main window. You may also accomplish this by pressing CTRL+S.

l Select All – This command selects every repository file displayed in the main win-
dow. You may also accomplish this by pressing CTRL+A.

l Invert Selection – Selecting this command highlights all items in the main win-
dow that have not been selected, and deselects currently selected items.

View

l Search – Select this command item to search for items in the repository. You may

also search by clicking the toolbar button.

- 27 -



FTVersionTrak User Guide
Chapter 2 – Working in the Main Window • Using the Menu Bar

l Unit Contents – Select this command to view the contents of a multiple file unit.
You may also view unit contents by double-clicking on the file unit.

l Deleted Items – Select this command item to view all repository files and folder
that have been deleted, as well as active repository files and folders. Selecting the
command again will hide the deleted items.

l Status Bar – Select this command item to display the status bar at the bottom of
the main window. Selecting the command again will hide the status bar.

l Activity Log – Select this command to view actions taken by users within the
FTVersionTrak repository.

l Refresh – Select this command to refresh the main window to display the most re-

cent changes. You may also refresh by clicking the toolbar button or by
pressing F5.

Version

l Get Local Copy – This command retrieves a copy of the file from FTVer-
sionTrak and places it on your local machine. You may also get a file by clicking

the toolbar button or right-clicking a repository file or folder and then clicking
Get Latest Version from the shortcut menu.

l Check Out – Select this command to check out the latest version of a repository

file or folder to edit the item. You may also check out an item by clicking the
toolbar button or by right-clicking an item and then clicking Check Out from the
shortcut menu.

l Check In – Select this command item to write changes made to a local file back
to the repository and create a new version of the file. You may also check in an

item by clicking the toolbar button or by right-clicking a checked out item
and then clicking Check In from the shortcut menu.

l Undo Check Out – Select this command to undo a checkout, undo edits to the
contents of the file in the repository, and retain the current version. You may also

undo a check out by clicking the toolbar button or by right-clicking a checked
out item and then clicking Undo Check Out from the shortcut menu.
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l Sign Document – Select this command to place an electronic signature on a re-
pository file or change the file's version state. You may also electronically sign a

file by clicking the toolbar button or by right-clicking a repository file and
then clicking Sign Document from the shortcut menu.

l History – Select this command to view a repository file's version history. You

may also view version history by clicking the toolbar button or by right-click-
ing a repository file and then clicking History from the shortcut menu.

Tools

l Compare Files – Select this command to compare two files for differences. You

may also compare files by clicking the toolbar button.

l Compare Folders – Select this command to compare two repository folders for

differences. You may also compare folders by clicking the toolbar button.

l Scheduled Tasks – Select this command to schedule and organized automated

tasks. You may also schedule tasks by clicking the toolbar button.

l Server Security – Select this command to manage server-level security. You may

also manage server security by clicking the toolbar button.

l Repository Security – Select this command to manage repository-level security.

You may also manage repository security by clicking the toolbar button.

l Network Setup – This command is used to configure your Modicon network
communication settings to automatically connect your PLC WorkShop files man-
aged in FTVersionTrak to the hardware on the plant floor.

l Email Service Setup – This command item allows you to configure the settings
related to email. The settings are divided into the following areas: server con-
figuration, email accounts, mailing lists, and email templates.

l Notifications Viewer – Select this command to view notifications.

l File Version States – Select this command to manage repository file version
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states.

l Options – Select this command to set global options within FTVersionTrak.

Help

l Contents – Select Contents to access the online help.

l Update Key – Select this command to update your software key license.

l About – Select About to display the current version of FTVersionTrak, license in-
formation, and installed components.
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Using the Main Toolbar

The main toolbar, located just below the menu bar in the FTVersionTrak main window, dis-

plays a row of icons that represent options you are likely to use frequently.

Icon Description Icon Description

Create New Repository Connect to Repository

New Folder Set Working Directory

Add Files Add Folder

Label Share

Delete Restore

Search Refresh

Get Check Out

Check In Undo Check Out

Sign Version History

Compare Files Compare Folders

Schedule Tasks Server Security

Repository Security
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Using the Folder Tree

The left pane of the Reversion main window contains the folder tree. Similar in appearance

to Windows Explorer, the folder tree is a listing of the folders in the repository.

The folder tree enables logical organization of repository files. Folders can be grouped

based on subprojects within the repository, users working on the project, or whatever the

project requires. The folder tree always contains a root folder, which by default is given the

name $ and cannot be deleted, destroyed or renamed. The folder tree is automatically re-

freshed periodically to reflect any changes that may have been made to the repository.

However, you may choose to manually refresh by clicking Refresh on the View menu,

clicking the toolbar button, or pressing F5.

All folder management is done within the folder tree. Subfolders of the $ root folder may

be created, renamed, deleted, and destroyed. View deleted folders in the folder tree by

clicking Deleted Items on the View menu. Only one folder may be selected or modified

at once. Modify a folder using the menu bar, the main toolbar, or right-clicking a folder and

using the folder context menu. When a folder is selected, the contents of the folder appear

in the right pane of the main window, known as the File List. Folders may be selected

either by clicking them or navigating to them using the arrow keys.
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Folder Context Menu

The following list describes the commands available on the folder context menu in FTVer-

sionTrak. To access the folder context menu, right-click a repository folder in the folder

tree. The commands available in the folder context menu are subject to availability based

on the operation in progress.

n New Folder– This command creates a new subfolder within the selected folder.
You may also create a new folder by clicking New Folder on the File menu or by

clicking the toolbar button.

n Add Files– This command is used to select new files from the local machine to
add to the selected folder. You may also add files to the repository by clicking

Add Files on the File menu or by clicking the toolbar button.

n Add Folder – This command is used to add the contents of folders from the local
machine to the repository or to create a multiple file unit from a selected folder.
You may also add folders by clicking Add Folder on the File menu or by clicking

the toolbar button.

n Set Working Directory– This command is used to designate a folder on a local
machine to store working copies of files retrieved from the selected repository
folder. You may also set the working directory by clicking Set Working Dir-

ectory on the File menu, clicking the toolbar button, or pressing CTRL+W.

n Search – Select this command to search the contents of the selected folder. You

may also search by clicking Search on the View menu or by clicking the tool-
bar button.

n Compare – This command compares the contents of the selected repository
folder to the contents of the associated working directory. You may also compare

folders by clicking Compare Folders on the Tools menu or by clicking the
toolbar button.

n Get Local Copy– This command retrieves the latest versions of the contents of a
repository folder and places it on your local machine. You may also get files by

clicking Get Latest Version on the Version menu or by clicking the toolbar
button.
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n Check Out – Select this command to check out the latest version of the contents
of a repository folder to edit the items. You may also check out an item by click-

ing Check Out on the Version menu or by clicking the toolbar button.

n Check In – Select this command to write changes made to local files back to the
repository folder and create new versions of the files. You may also check in a

folder by selecting Check In on the Version menu or by clicking the toolbar
button.

n Undo Check Out – Select this command to undo a checkout and undo edits to
the contents of the repository folder and retain the current versions. You may also
undo a check out by clicking Undo Check Out on the Version menu or by click-

ing the toolbar button.

n Label – This command applies a label to the contents of a repository folder. This
label is associated with the latest version of each file in the repository folder and
can be used as a "snapshot" of the state of the contents of the folder at the time
the label was applied. You may also apply a label by clicking Label Files on the

File menu or by clicking the toolbar button.

n History – Select this command to view a repository file's version history. You

may also view version history by clicking the toolbar button or by right-click-
ing a repository file and clicking History on the shortcut menu.

n Delete Folder– Select this command to remove the selected folder from the
folder tree without removing the folder from the repository completely. You may
also delete a repository folder by clicking Delete on the Edit menu, selecting a

folder and then pressing DELETE, or clicking the toolbar button.

n Rename Folder – Select this command to rename the selected repository folder
while retaining all the properties of the folder. You may also rename a folder by
clicking the Rename command on the Edit menu or by selecting the folder and
then single-clicking the name of the folder.

n Attach/Detach Notifications – Select this command to attach or detach Email
notification templates to events related to the selected folder.

n Properties – This command is used to view or modify the properties of the se-
lected folder. You may also view folder properties by selecting a folder and then
clicking Properties on the File menu.

n Restore Deleted Folder– Select this command to restore a deleted repository
folder to the folder tree. The Restore Deleted Folder command is only available
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when the View Deleted Items option is enabled and a deleted folder is selected.
You may also restore a folder by clicking Restore on the Edit menu or by clicking

the toolbar button.

n Destroy Deleted Folder– Select this command item to completely and per-
manently remove a repository folder, as well as any associated folder properties or
history, from the repository. The Destroy Folder command is only available
when the View Deleted Items option is enabled and a deleted item is selected.
You may also destroy a folder by clicking Destroy on the Edit menu.
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Using the File List

The right pane of the FTVersionTrak main window contains the file list. Similar in ap-

pearance to Windows Explorer, the list displays the file contents of a selected repository

folder.

The file list displays the status of the files in the repository. Status columns display in-

formation such as file names and types, which files are checked out, where and to whom

they are checked out, which files have been deleted, and the size of compressed and work-

ing files. The file list is automatically refreshed periodically to reflect any changes that may

have been made to the repository. However, you may choose to manually refresh by click-

ing Refresh on the View menu, clicking the toolbar button, or pressing F5.

Most file management operations may be done in the file list. Files may be added, renamed,

deleted, and destroyed. View deleted files in the file list by clicking Deleted Items on the

View menu. Multiple files may be selected at once by pressing the CTRL key and clicking

individual files in the file list or by clicking Select or Select All on the Edit menu. Modify

a file using the menu bar, the main toolbar, or right-clicking a folder and using the file con-

text menu.

Sort the file list by clicking on the column headings. Reverse the sort by clicking a

column again. Determine how the file list columns are displayed by dragging and dropping

the columns to reflect the order you want to use.
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File Context Menu

The list below describes the file context menu items available inFTVersionTrak. Toaccess the

file context menu, right-click arepository file in the file list. The commands available in the file

context menu are subject toavailability basedonthe operation inprogress.

n Edit File –Selecting this command automatically checks out the selected re-
pository file, launches the application associated with the file, and opens the
selected file, making it ready for editing. You may also edit a file by double-click-
ing the file or by clicking Edit File on the Edit menu.

n View File – Selecting this menu item after selecting a repository file launches the
application associated with the file and opens the selected file in read-only mode,
allowing you to see the file but not edit it. You may also view a file by clicking
View File on the Edit menu.

n Schedule to Upload – Select this command to create an upload task for the se-
lected file. You may also schedule an upload task by clicking Scheduled Tasks

on the Tools menu or by clicking the toolbar button. This command is only
available if the selected repository file is a 505 or Modicon FasTrak file (*.FSS or
*.FMD).

n Get Latest Version – This command retrieves a copy of the file from FTVer-
sionTrak and places it on your local machine. You may also get a file by clicking

Get Latest Version on the Version menu or by clicking the toolbar button.

n Check Out – Select this command to check out the latest version of a repository
file to edit it. You may also check out a file by clicking Check Out on the Ver-

sion menu or by clicking the toolbar button.

n Check In – Select this command to write changes made to a local file back to the
repository and create a new version of the file. You may also check in an item by

clicking Check In on the Version menu or by clicking the toolbar button.

n Undo Check Out – Select this command to undo a checkout, undo edits to the
contents of the file in the repository, and retain the current version. You may also
undo a check out by clicking Undo Check Out on the Version menu or by click-

ing the toolbar button.

n Compare – If one file is selected, this command compares the selected repository
file with the working copy. If two files are selected, this command compares the
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two selected repository files. You may also compare files by clicking Compare

Files on the Tools menu or by clicking the toolbar button.

n Sign Document – Select this command to place an electronic signature on a re-
pository file or change the file's version state. You may also electronically sign a

file by clicking Sign Version on the Version menu or by clicking the toolbar
button.

n History – Select this command to view a repository file's version history. You
may also view version history by clicking History on the Version menu or by

clicking the toolbar button.

n Delete – Select this command to remove the selected file from the file list
without removing the file from the repository completely. You may also delete a
repository file by clicking Delete on the Edit menu, by selecting the file and then

pressing DELETE, or by clicking the toolbar button.

n Rename – Select this command to rename the selected repository file while re-
taining all the version history of the file. You may also rename a file by clicking
Rename on the Edit menu, or by selecting the item to rename and then single-
clicking the name of the file or folder.

n Attach/Detach Notifications –Select this command to attach or detach Email
notification templates to events related to the selected file.

n Properties –This command is used to view or modify the properties of the se-
lected file. You may also view file properties by clicking Properties on the File
menu.

n Restore Deleted Files – Select this command to restore a deleted repository file
to the file list. The Restore command is only available when the View Deleted
Items option is active and a deleted file is selected. You may also restore a file by

clicking Restore on the Edit menu or by clicking the toolbar button.

n Destroy Deleted Files – Select this command to completely and permanently re-
move a repository file, as well as any associated version history, from the
repository. The Destroy command is only available when the View Deleted
Items option is enabled and a deleted file is selected. You may also destroy a file
or folder by clicking Destroy from the Edit menu.
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File List Column Headings

The following list describes the columns that are displayed in the file list. To access the

column context menu, right-click the file list column heading.

l Name – This column displays the file name as it appears in the repository.

l Type – This column displays the application associated with the file. When you
edit or view the file, this application will automatically be launched. If there is no
application associated with the file, the information in this column will appear as
EXT file, where EXT is the file extension.

l Date – This column displays the date the repository file was last modified. If a file
is added to the repository but not modified, it will retain the date it was last mod-
ified, not the date it was added to the repository.

l Working File Status – This column displays one of three states of the user's
working copy compared to the latest version in the repository:

n Current –The working copy is identical to the repository file.

n Out of Date – The working copy is older and different than the re-
pository file.

n Absent – No working copy exists in the user's working directory.

l Compressed Size – This column displays the size in kilobytes (KB) of the re-
pository file.

l Working Size – This column displays the size in kilobytes (KB) of the working
copy.

l Checked Out To – This column displays the username (if any) that a file is
checked out to.

l Checkout Location – This column displays the location (if any) that a file is
checked out to.

- 39 -



FTVersionTrak User Guide
Chapter 2 – Working in the Main Window • Using the Status Bar

Using the Status Bar

The status bar spans the bottom of the FTVersionTrak window, presenting various status

information. To display the status bar, click Status Bar on the View menu.

The left side of the status bar displays information or describes the current operation. To

display information about any command or toolbar button, move the mouse pointer over

the item.

Login information appears on the right side of the status bar. The far right side of the status

bar displays the user information. Next to that is the name of the server the user is cur-

rently logged into.
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Viewing Deleted Items

Deleting files and folders in FTVersionTrak is nondestructive, meaning that deleted files

and folders still exist within the repository. Deleting an item merely removes the file or

folder from view within the main window and prevents its from being modified, pending

restoration. Deleted items may be viewed in the main window by clicking Deleted Items

on the View menu.

Deleted items may be restored or destroyed. Restoring a deleted item removes the delete

status and makes the item available to be checked out. Destroying a deleted item removes

the item, as well as any associated history, completely and permanently from the repository.
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Using the Repository File System

FTVersionTrak organizes your projects using the Repository File System. The Repository

File System is a simple yet powerful tool for tracking and securing change-sensitive files.

A repository is a collection of files and folders that you store in FTVersionTrak. You can

add, delete, edit, and share files within a repository. A repository looks and behaves much

like Windows Explorer, but has higher functions of file history, version control, and secure

change management. Repositories reside within a SQL Server database, which can only

be accessed through FTVersionTrak. Files are stored as archives in the repository.
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Creating a Repository

Before you can begin adding files to FTVersionTrak, you must have a repository to manage

them in. If no repository has been created for your project, the first step is to create one.

NOTE: FTVersionTrak Pro users may only create one re-

pository per license.

To create a repository:

1. Click CreateNewRepository ontheFilemenu orpressCTRL+N. The Create New
Repository dialog boxappears. (This dialogboxcanalsobe accessed fromthe Connect
toRepository dialogbox. See Connecting toaRepository formore information.)

2. The default server is listed in the Server box. To select another server, click
Browse. The Browse for Server dialog box appears.
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3. If the server you want to use is not displayed in the Server list, click Find Data-
base Servers to search for all available servers. Click the server you want and then
click OK to return to the Create New Repository dialog box.

NOTE: If the server you are looking for still does not ap-

pear on the list, contact your system administrator or see

SQL Server Setup for setup information.

4. Type the name of the new repository in the Repository Name box.

NOTE: The repository name cannot contain spaces or spe-

cial characters.

5. Click OK when finished. The Master Login dialog box appears.

5. ClickOKtocreate the repository. By default, Windows Authentication is selected– this
is the only authenticationmethod that canbe usedwhencreatingnew repositories:

NOTE: Whichever user creates a repository automatically

becomes the administrator of that repository, granting the

user all repository privileges. See Repository Security for

more information.
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Connecting to a Repository

Multiple repositories can be created and accessed by users depending on project needs and

storage space. Each repository may have its own set of users, and each user may have its

own set of Repository Permissions within each repository. After the administrator creates a

repository, other users might need to connect to it.

To connect to an existing repository:

1. Click Connect to Repository on the File menu, click the toolbar button, or
press CTRL+C. The Connect to Repository dialog box appears.

2. If you have connected to any repositories previously, they appear in the Select a Re-
pository list. If no repositories have been previously connected to, or if the
repository you want to use is not listed, click Browse. The Browse for Repository
dialog box appears.
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3. The default server is listed in the Server box. To select another server, click
Browse. The Browse for Server dialog box appears.

4. If the server you want to use does not appear in the Server list, click Find Data-
base Servers to search for all available servers. Select the server you want to use
from the list and then click OK to return to the Connect to Repository dialog box.

NOTE: If the server you are looking for still does not ap-

pear on the list, contact your system administrator or see

SQL Server Setup for setup information.

5. Select the Login to Server Manually check box to force a manual login to the
server. Use this option if a different user usually logs in automatically and the login
needs to be changed.

6. Click Find Repositories to search for available FTVersionTrak repositories located
on the server.
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7. Select the repository you want to use from the Available Repositories list and then
click OK when finished to return to the Connect to Repository dialog box.

NOTE: If the repository you are looking for still does not

appear on the list, contact your system administrator or see

the Administrator Guide for setup information.

l Click Remove to remove a repository from the Select a Repository list. Click-
ing Remove does not delete the repository – it only removes the repository
from the list.

l Click New to Create a New Repository.

8. Select the repository and click Connect. The Master Login dialog box appears.
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9. Select the mode of authentication from the Authentication box:

l Windows Authentication: This option utilizes the local Microsoft Windows
user accounts to log on to the server. If this option is selected, the user currently
logged in to Windows will appear in the Username text box. No password is ne-
cessary, and the login information cannot be edited.

l SQL Authentication: This option uses the login information located on the
server itself. Selecting this option will prompt for both a username and password.
See your system administrator for more information.

10. Click OK to connect to the repository.
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Removing and Destroying Repositories

The Connect to Repository dialog box provides options for removing and destroying re-

positories.

To remove a repository, select the repository and then click Remove. When a repository is

removed, the repository will no longer automatically appear in the Connect to Repository

dialog box. The repository is not deleted from the server, however, and you can still con-

nect to the repository by clicking Browse and locating the repository on the server.

To destroy a repository, select the repository and then click Destroy. When a repository is

destroyed, the repository is permanently deleted from the server. Once destroyed, a re-

pository cannot be restored.
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Adding Files to the Repository

Before FTVersionTrak can begin securing your files, they must be added to the repository.

Adding files to the repository creates the first version of the file in the repository.

1. Click Add Files on the File menu or click the toolbar button. The Select Files
to Add dialog box appears.

2. Browse to the files located on your computer that you wish to add to the FTVer-
sionTrak repository. Press and hold CTRL while selecting to select more than one
file. Click OK when finished. The Add Files to Repository box dialog appears.

3. Click Browse to add additional files.

4. Optional: Enter a comment in the Comment box. This comment is added as a tag to
all of the files listed under Files. This optional comment can be used to identify the
state or significance of the added file(s), or as a search tag.
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Adding Folders to the Repository

Entire folders and their contents, including any subfolders, may be added at one time from

a local machine to the repository, allowing for fast transference of files to the repository

and an efficient means of retaining a file structure similar to the local source.

To add a folder and its contents to the repository:

1. Click Add Folder on the File menu or click the toolbar button. The Add
Folder dialog box appears.

2. Enter the path of the folder you wish to add in the Folder box or click Browse to
navigate to the folder on the local machine.

3. Under Add as, select the method by which you would like to add the folder.

n Individual Files – Adds the folder and its contents as separate files. The folder
and its contents are managed as individual files and folders in the repository.

n Folder Unit – Adds the folder and its contents as a single multiple file unit. The
folder and its contents are managed as a single file in the repository.

4. Select theRecursive boxtoalsoaddany subfolders of the selected folder to the reposit-
ory.
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Multiple File Units

Some software applications, like Microsoft Word and Excel, store their documents in a

single file.

But other applications, like TISOFT and Siemens Step 7 store single projects in a family of

files. For these applications, the entire family of files is required to access their complete

projects.

FTVersionTrak can store a family of related files as a group called aMultiple File Unit. Al-

though Multiple File Units contain multiple files, FTVersionTrak treats a Multiple File

Unit as a single file. For example, if a Multiple File Unit contains a family of 15 files, check-

ing out the Multiple File Unit checks out all 15 files. Similarly, other operations, like

checking in and getting previous versions of that Multiple File Unit accesses all 15 files.

There are two types of multiple file units: file units and folder units.

n A file unit is a single repository file that represents a group of related files defined
by a user-configurable XML configuration file.

n A folder unit is a single repository file that represents the contents of a folder.

Like in Microsoft File Explorer and Windows Explorer, double-clicking a file in FTVer-

sionTrak can launch the application associated with that file type.

Double-clicking a Multiple File Unit can also launch its application, if one is associated

with the Multiple File Unit.

But if an application is not associated with the Multiple File Unit, a window that lists its

files opens, like the one illustrated below. If a file in this list is associated with an ap-

plication, then double-clicking that file launches its application.
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File Unit Definitions

There may be instances in which a single change to a program or a project affects more than

one file at one time. It may be very difficult to determine which files are affected by a

single change at any given time, which may inadvertently cause major problems to the pro-

ject later. For example, a user may check out a single file from the repository and edit that

file in the associated program. The edits made may change data in other files that are pro-

tected by the repository. When the user checks the file back in, the only changes that are

written to the repository are from the single file; any other files that may have changed on

the user's local machine retain their original state in the repository. One way to prevent this

problem is by creating file units for these types of files.

Defining and creating file units is an efficient way to manage groups of files whose changes

are dependent on each other. Edits made to file units are atomic, meaning that changes are

written all at once to every file residing in a file unit when checked in to the repository, or

no changes are written at all.

Files units are defined by user-configurable XML files. These configuration files can be

used to define the types of files and folders to include in the file unit. They can also be

used to determine the program or project associated with the files and folders, and the man-

ner in which the unit will be named.

Creating XML Configuration Files

Extensible Markup Language (XML) configuration files can be created using any text editor

such as Microsoft Notepad. FTVersionTrak File Unit Definitions created using XML must

contain certain elements to function properly. These elements are described later. If you

are unfamiliar with XML, many free resources are available on the internet that explain

XML syntax in detail.

Two functioning examples of File Unit Definitions (TISOFT Program and Step 7 Project)

are included with FTVersionTrak. By default, these files are located in C:\Program
Files\FasTrak SoftWorks, Inc\FTVersionTrak\units. Any ad-

ditional File Unit Definitions must be saved in this folder to properly function.

XML StandardElements

l <unit> This element defines the XML file as a File Unit Definition. All files
must contain this element as the root.
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n type= Use this attribute to enter a name for this type of file unit. This
name will appear in the Type column of the file list.

l <directory> This element defines specific directories and subdirectories to in-
clude in the file unit.

n name= Use this attribute to enter the name of a directory to include in
this file unit.

n includesubdirectories= This attribute can either be true or false. If
true, the unit includes the contents of all subfolders of the folder
defined in the directory name= attribute.

l <masterfile> Use this element if all the files to be included in the file unit follow
a definable naming convention. This element is only valid as the first child of the
unit or the directory. Only one masterfile can be present in the file.

n name= This attribute defines the name of the master file. This name
will appear in the Name column of the file list.

l <includefile> This element defines which types of file or specific files to in-
clude in the file unit. This element is only valid as a child of the unit or the
directory.

n name= This attribute defines the name(s) or type(s) of the files to be in-
cluded in the unit.
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Creating Repository Folders

Besides adding a folder and its contents to the repository, new repository folders may

also be created to customize the file structure of the repository.

To create a repository folder:

1. Click Create New Folder on the File menu or click the toolbar button. A
new folder is created.

2. The default name of the created folder is New Folder. Type the new name of the
folder within the highlighted text box and press ENTER when finished.
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Renaming Files and Folders

To rename files and folders:

1. Select the item to rename and click Rename on the Edit menu, right-click the item
and then select Rename from the shortcut menu, or single-click the item name.

2. An edit box appears around the item name; you can type your changes in the edit
box.

NOTE: Renaming a file or folder does not affect that item's

versions, comments, or other history attributes.

NOTE: File extensions cannot be renamed in the re-

pository.
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Deleting Files and Folders

Deleting a file or folder in FTVersionTrak removes it from the main window and prevents

users from checking the item(s) in or out. Deleted items can be viewed and restored.

To delete a file or folder:

1. Select the file or folder and then click Delete on the Edit menu, click the tool-
bar button, or right-click the item and then click Delete from the shortcut menu.
The item is deleted and removed from view.

NOTE: A deleted item can still be viewed and even re-

stored to the repository. To completely and permanently

remove a file or folder from the repository, it must be des-

troyed.
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Restoring Deleted Files and Folders

Deleting files and folders in FTVersionTrak is a non-destructive process, meaning that if

an item is deleted by mistake, that item, including all history and version information, can

be restored to the repository. To restore a deleted file or folder:

1. Make sure that you can view deleted itemsin the main window. A deleted item ap-
pears with an "X" in front of it as shown in the following picture.

2. Select the deleted item you would like to restore and then click Restore on the

Edit menu, click the toolbar button, or right-click the item and then click
Restore from the shortcut menu. The deleted item is restored.
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Destroying Files and Folders

Destroying a file or folder in FTVersionTrak permanently removes the file from its re-

pository, along with all version information. Files and folders that have been destroyed

cannot be restored.

To destroy a file or folder:

1. The file or folder must first be deleted.

2. Make sure you can view deleted items in the main window. A deleted item appears
with an "X" in front of it as shown in the following illustration.

3. Select the deleted file or folder to be destroyed and then click Destroy on the Edit
menu, or right-click the item and then click Destroy from the shortcut menu. A
confirmation message appears.

4. Click Yes to continue and destroy the file or folder. Click No or Cancel to return
to the main window.
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NOTE: Destroying a file or folder completely removes the

item from the repository, including all versions and their ac-

companying histories, and cannot be undone. Destroying a

folder will also destroy any subfolders and files contained

within it.
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Setting the Working Directory

The Working Directory is a directory apart from the repository (usually within the user's

local file system). This directory is used to store copies of the files within the repository

that may be edited after being Checked Out.

Each folder in the repository (including the root repository folder) can be set with its own

working directory. To set a working directory for a folder in the repository:

1. Click Set Working Directory on the File menu, click the toolbar button, press
CTRL+W, or right-click the repository folder and then click Set Working Dir-
ectory from the shortcut menu. The Set Working Directory dialog box appears.

2. Specify the working directory that will be used.

l Click Inherit the working directory from the parent folder to create a working
directory relative to the directory set for the parent folder.

l Click Use a specific working directory to specify another working directory,
then type the directory you want to use or click Browse to browse to the dir-
ectory you want to use.

3. Select the Apply to all sub-folders check box to copy any subfolder within the cur-
rent repository folder to your working directory.

4. Click OK to return to the Repository window. The current working directory now
appears directly below the main window.
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NOTE: If the new working directory does not appear, re-

fresh FTVersionTrak by clicking Refresh on the View

menu, clicking the toolbar button, or pressing F5.

5. Click the displayed path of the working directory at any time to display its contents
in Windows Explorer. For example, in the preceding illustration, clicking
C:\FTVersionTrak opens this folder in Windows File Explorer.
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Getting Files and Folders

The Get action retrieves a version of a file from the repository and places it in the working

directory as a read-only copy to review or check out.

To get files or folders:

1. In the FTVersionTrak main window, select the target file, group of files, or folder.

2. Click Get Local Copy on the Version menu, click the toolbar button, or right-
click the item and then click Get Local Copy on the shortcut menu. The Get dia-
log box appears.

3. Under Version, select the options of the version you would like to get.

l Click Latest Version to retrieve the latest version of the file, group of files, or
folder and place in your working directory.

l Click Version and then type or select the version of the file or folder you want to
retrieve and place in your working directory.

l Click Latest Version of State and then click the repository file state of the file,
group of files, or folder you want to retrieve and place in your working directory.
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l Click Labeled Version and then click the label of the file or folder you want to re-
trieve and place in your working directory.

4. In the To box, type the directory where the retrieved file, group of files, or folder
will be placed. Or, click Browse to select the directory.

5. Select the Ask before replacing writable copies check box to display a con-
firmation message before overwriting existing local writable copies.

6. Select the Make local copywritable check box to remove the read-only status
from the selected working copies.

NOTE: Making working copies writable is not re-

commended for files you wish to keep under version

control. Do not select this option if you plan on checking

out and editing the file.

7. If an entire folder is being retrieved, select the Recursive check box to get the tar-
get folder's subdirectories and respective contents and place them in your working
directory.
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Get File Versions

FTVersionTrak stores previous versions of files in its History.

A working copy of a single version can be retrieved with the Get feature. Retrieving work-

ing copies of multiple versions of the same file requires using the Get feature repeatedly.

However, the Get File Versions feature provides a single operation that extracts working

copies of multiple versions of the same file.

To access the Get File Versions feature, use any of the methods below to launch the Get

File Versions Options dialog:

a. Select a file in the main window, and select Get File Versions... from the Version
menu

b. Right-click a file in the main window, and select Get File Versions... from the float-
ing context menu

c. Select a file in the main window, click the History toolbar button, and click Ex-
tract when the History dialog appears

d. Select a file in the main window, select History... from the Version menu, and
click Extract from the History dialog

e. Right-click a file in the main window, select History... from the floating context
menu, and click Extract when the History dialog appears

When the Get File Versions dialog appears, the name of the selected Repository File and

the number of versions appear near the upper left corner. In the example below, there are

13 versions of file ALL.FSS.
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Any continuous number of versions within the Version Range can be specified in the

From Version and To Version settings.

In the example below, versions 3 through 12 will be extracted.

Each extracted version shares the same file name. To avoid duplicating files names, a

unique identifier is added to each extracted file's name.

These identifiers are specified in the File Name Options. The Version Number Prefix

contains the text that follows the original file name, but precedes the actual version num-

ber. The Version Number Suffix contains the text that follows the actual version

number. The octothorpe "#" indicates where the actual version number appears.

The Version File Name will be box illustrates an example of how the identifier will be ad-

ded to the original file name.

The Destination setting specifies the location to which the extracted file will be copied.

Enter the desired path, or click Browse... to select the location.

If desired, the extracted files can be copied to their own subfolder under the Destination

path. The current date will be used as this subfolder's name. Check the Create subfolder

with current date as its name checkbox, and select the preferred date format from the

dropdown list.

When all selections are made, click OK.

Based on the settings in the example above, the extracted files appear in their new sub-

folder, as illustrated below.

- 72 -



FTVersionTrak User Guide
Chapter 4 – Using FTVersionTrak • Get File Versions

- 73 -



FTVersionTrak User Guide
Chapter 4 – Using FTVersionTrak • Checking Out Files and Folders

Checking Out Files and Folders

To make changes to a file in FTVersionTrak, it must first be checked out. Checking out a

file places a writeable copy of the file within the user's working directory. If the file is

already present in the working directory (following a Get action, for example) then FTVer-

sionTrak removes the read-only status on the file while it is checked out.

To check out files or folders:

1. In the FTVersionTrak main window, select the target file, group of files, or folder.

2. Click Check Out on the Version menu, click the toolbar button, or right-click
the item and then click Check Out on the shortcut menu. The Check Out dialog
box appears.

3. In the To box, enter the directory in which to place the working copy or click
Browse to select the directory.

4. Select the Do not get local copy check box if you do not wish to Get the version
of the Repository file while checking the file out.

NOTE: Using the Do not get local copy option only

checks out the file. This is helpful if your working copy is

different than the latest version within FTVersionTrak.
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5. If a folder is being checked out, select the Recursive check box to check out any
subfolders and their contents.

6. Optional: In the Comment box, enter a comment about the check out . This com-
ment may be edited when the file or folder is checked in. Click OK when finished.

After checking out a file or folder, the following options are available:

n Check In the file or folder to write any edits to FTVersionTrak and create a new
version.

n Undo the Check Out to cancel any changes made to the file or folder.
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Undoing a Check Out

After checking out a file or folder, if you decide not to save any changes to the repository

or create new versions, you may undo the checkout. Undoing a checkout leaves the file or

folder in the state it was in before you checked it out. No new version is created, and no re-

cord of the checkout will be left.

To undo a checkout:

1. Click Undo Check Out on the Version menu, or click the toolbar button.
The Undo Check Out dialog box appears.

2. Under Local Copy, specify what you want to do with the local copy:

l Select Replace to replace the local copy of the checked out file with the latest
version within the repository.

l Select Leave to leave the existing copy of the checked out file on your local
system.

l Select Delete to delete the local copy from the location of the check out. If
the file was checked out to a location other than the working directory, the loc-
ation indicated at check out will be deleted and any other copies will be
retained.

3. If performing an undo check out on a folder, select the Recursive check box to ap-
ply the undo to all subfolders and their contents.
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4. Click OK when finished to return to the main window.
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Check In

Check in the file or folder to write changes to the master copy located in the repository.

After you check the file in, other users will be able to Get the modified file, view the

changes you have made to the file, and check out the file to work on it as well.

To check in a file or folder:

1. In the FTVersionTrak main window, select the checked out file(s) or folder(s) you
would like to check in and then click Check In on the Version menu, click the

toolbar button, or right-click the item and then click Check In on the shortcut
menu. The Check In dialog box appears.

2. Optional: In the Comment box, type a comment for the check in (optional). If a
comment was entered during checkout, it will appear by default.

Select the Use Checkout Comment check box to use this comment.

3. The From box displays the local path where the new version will be written from
(usually the working directory). Click Browse to select a different directory.
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4. Under Local Copy, specify what you want to do with the local copy

l Select Leave to leave the working copy of the file on your local system after the
check in.

l Select Keep checked out to write any changes to the repository but keep the
item(s) checked out to you.

l Select Delete to delete the working copy of the file from your local system after
the check in.

5. If a folder has been selected for check in, the Recursive check box can be selected.
Select this check box if you would like to check in any files and folders within the
selected folder.

6. Click Compare to Repository Version to compare the difference between the
version being checked in and another version in the repository.

7. Click OK when finished to check in the items.

NOTE: If there are no differences between the file you are

checking in and the file in the repository, a new version of

the file will not be created. In other words, the check out

and the subsequent check in of a file that has not changed

will not appear in the version history.
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Editing a File

One option you can use when editing files protected by FTVersionTrak is to get a fileinto

your local directory, check outthe file, launch the application associated with the file, open

the file, and proceed to edit it. You may also choose to do all of the above actions in one

step by using the Edit File command.

To check out and edit a file in your working directory:

1. In the FTVersionTrak main window, select the file you want to edit and then click
Edit File on the Edit menu, or right-click the file and then click Edit File on the
shortcut menu. The following message appears:

2. Click the Yes button to continue. A copy of the file is sent to your working dir-
ectory, the file is checked out, the application associated with the file is launched,
and the file is opened within the application.

l Select the Do not show this again check box to disable this dialog in the fu-
ture. Once disabled, the dialog may be restored by clicking Options on the
Tools menu and then clicking Reset Notifications.

NOTE: FTVersionTrak associates an application with a file

based on information from Microsoft Windows. If no ap-

plication is associated with a file, it must be opened and

edited manually. Selecting Edit File will result in the fol-

lowing message:
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3. When you are finished editing the file, save the file within its application and check
in the file to FTVersionTrak.
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Viewing a File

If someone has checked out a file in FTVersionTrak, it does not mean you are completely

locked out of the file. You may always view any file as read-only within the file's associated

application.

To view a file:

1. In the FTVersionTrak main window, select the file you wish to view and click
View File on the Edit menu, or right-click the item and then click View File from
the shortcut menu.

2. The latest version of the file is sent to your working directory, the application as-
sociated with the file is launched, and the file is opened as read-only within the
application.

NOTE: FTVersionTrak associates an application with a file

based on information from Microsoft Windows. If no ap-

plication is associated with a file, it must be opened and

edited manually. Selecting Edit File will result in the fol-

lowing message:
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Signing a Version of a File

Users have the ability to electronically sign a file, which conforms to portions of the FDA's

21 CFR Part 11 regulations on electronic signatures. The electronic signature includes a

date and time stamp as well as a user comment. Signatures can be used as an approval

method to verify that a certain user has reviewed and approved a selected version of a re-

pository file, and can also be used to advance the version state of the repository file.

Signature requirements can be configured in Repository Options on the Signature Re-

quirements tab.

To electronically sign a file:

1. In the main FTVersionTrak window, select the file you want to sign and then click

Sign Version from the Version menu, or click the toolbar button. The Sign
Document dialog box appears.

2. The File and Username boxes contain the selected file and current user. Type the
current user's password in the Password text box.

3. Select the current version state of the file from the State box.
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4. Optional: Type any comments in the Comment text box.

5. Click OK when finished.
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Labeling Folders

Placing a label on a file or folder associates a text identifier with the latest version of the se-

lected file or group of files in the selected folder. Labeling is a convenient way to tag the

current project state of a large number of files.

Adding a Label

To label a file or folder:

1. In the FTVersionTrak main window, select the file or folder you want to use and

then click Label on the File menu, click the toolbar button, or right-click the
item and then click Label on the shortcut menu. The Label dialog box appears.

2. In the Label box, type the label to associate with the selected file (or each file if se-
lecting a folder). You may add further comments to the label in the Comment text
box. Click OK when finished. The label is applied to the latest version of the file.
Folder labels are applied to the latest version of each file, as well as the files in each
subfolder.
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Using Labels

Labels are viewed within the file's history, along with the file's versions and Electronic Sig-

natures. See History for more information about accessing the History dialog box.

1. Select the Show Labels check box. Any labels associated with the file will be
shown.

2. The label appears as a version entry in the History dialog box, directly above the ver-
sion associated with the label. The contents of the label appear in the Label
column.
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Sharing Files and Folders

Sharing a repository file in FTVersionTrak means that the file will exist in two or more re-

pository folders. Repository actions such as check outs and check ins and version history

apply equally to each location of the shared file. For example, a file located in folder

$/Folder A is shared to $/Folder B. If the file located in $/Folder B is checked out, it will

also be checked out in $/Folder A.

To share a file among folders:

1. In the FTVersionTrak main window, select one or more files and then click Share

Files from the File menu or click the toolbar button. The Share File(s) Among
Folders dialog box appears.

2. More files may be shared by clicking Browse and then selecting additional files to
share or by typing the path and the name of the files in the Files box.

3. Designate the folder that will share the file(s) by typing the path and the folder name
in the Tobox or by clicking Browse and then selecting the folder. Click OK when
finished.
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Viewing Version Histories

Each file and folder that is managed by FTVersionTrak is given its own history. As you

check out, edit, and check in files and folders, the history is updated to reflect these

changes. Viewing history is the best way to get a clear picture of the changes a repository

item has gone through.

History of a File

To view a file's history:

1. In the FTVersionTrak main window, select a file and then click History on the Ver-

sion menu, click the toolbar button, or right-click the item and then click
History from the shortcut menu. The History dialog box appears.

The History dialog box displays all the version information of the selected file. Each ver-

sion displayed in the History dialog box contains the following information:

l No. – The number of the listed version.

l Username – The name of the user that created the listed version.

l Computer – The name of the computer upon which the version was created.
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l Date – The date and time the listed version was added to the repository.

l State – The version state of the file when it was added to the repository.

l Label – The name of a label applied to the file.

l Comment – The contents of the optional comment created when the file was
checked in.

The following two optional version histories may be viewed by selecting the appropriate

check boxes at the bottom of the History dialog box:

l Show Labels – Select this check box to display any associated labels with the re-
pository file. Each label will appear as a separate version of the file, with the tag
Label substituted for the version number.

l Show Electronic Signatures – Select this check box to display any electronic sig-
natures associated with the repository file. Each signature will appear as a separate
version of the file, with the tag "Signature" substituted for the version number.

The buttons on the right side of the History dialog box are used to manage a file's history:

l Close – Closes the History dialog box.

l Compare – Selecting a version and clicking Compare will compare the selected
version with the copy in the user's working directory. Selecting two versions and
clicking Compare will compare the two versions to each other.

l View – Launches the application associated with the selected version, and opens
the version of the file within the application as a read-only document.

l Get– Retrieves the selectedversionof the file to the user's local working directory.

l Sign – Electronically signs the selected version of the file. Can also be used to
change the version state.

l Delete –Deletes the selected version of the file.

l Rollback – Deletes all versions of the file that are more recent than the selected
file. Rollback is only available if the file has more than one version.

l Properties – View the properties of the selected version. Can also be used to
change the version comment.

l Report – Generates a history report of the selected repository file.
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History of a Folder

To view a folder's history:

1. In the FTVersionTrak main window, select a folder and then click History on the

Version menu, click the toolbar button, or right-click a folder and then click
History on the shortcut menu. The History dialog box appears.

The Folder History dialog box displays a log of activity upon the repository folder with up

to four columns of information:

l Username – The name of the user that made the change to the folder.

l Date – The date and time the change to the folder occurred.

l Label – The name of a label applied to the folder.

l Action – A description of the action logged.

The following optional version history may be viewed by selecting the appropriate check

box at the bottom of the History dialog box:

l Show Labels – Select this check box to display any associated labels with the re-
pository folder. Each label will appear as a separate version of the file, with the tag
Label substituted for the version number.

The buttons on the right side of the Folder History dialog box are used to manage a file's

history:
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l Close – Closes the History dialog box.

l Report – Generates a history report of the selected repository folder.
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Searching with FTVersionTrak

Introduction to Search

FTVersionTrak's Search features enable you to find and utilize the files you need quickly

and efficiently. You can search for files by name, comment, folder, date, or even by user.

The Search Results dialog box opens in a new window, so as not to disrupt your current

view, and provides convenient options for immediate action on your search criteria. An in-

formation-packed Search Report can be created instantly after the search as well.

To search FTVersionTrak:

1. Click Search on the View menu, or click the toolbar button. The Search dialog
box appears.

2. Select your search criteria:

l Under Search in, click In All Folders to search all folders within the Re-
pository. Clicking In Select Folder Only or In Select Folder and All
Subfolders will activate the Choose Folder box. Click Browse to select the
folder.

- 92 -



FTVersionTrak User Guide
Chapter 4 – Using FTVersionTrak • Searching with FTVersionTrak

l Under What do you want to search for?, click File to search file names or
click Comment to search comments recorded during the check in/check out
process. Type the search string you want to search for in the File or Comment
box.

NOTE: Comment search syntax supports logical operator

searching. File search syntax supports both wild card and lo-

gical operator searching.

3. Select the Extended Options check box to display further search options.
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4. Specify your extended search criteria:

l Select the Date check box to activate the After and Before options. Select the
After check box to limit the search to files last edited after the specified date.
Select the Before check box to limit the search to files last edited before the spe-
cified date. Selecting both allows you to search by the specified date range.

l Select the User check box to limit the search to files edited by a specific user or
comments entered by a specific user.

l Select the State check box to limit the search to files tagged with a specified Ver-
sion State. The State check box is only displayed when searching for Files.

l Select the File Name check box to limit the search to files with a specified file
name. The File Name check box is only displayed when searching for Com-
ments.

l Select the Checked Out (To) check box to limit the search to files Checked
Out to a specified user or comments associated with a file currently checked out
to a specified user.

5. Click Search to initiate the search. The Search Results dialog box appears, dis-
playing the output of the search.

File Search Syntax

These search options are available when searching files.

n The file pattern may consist of an unlimited number of search terms

n A single search term cannot contain spaces
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n Operators and search terms must be separated by a space

n The * and ? symbols are valid in file search as wildcard symbols

n Symbols and search terms must not be separated by a space

n A search term must precede and follow all OR operators

n A search term must follow all NOT operators

n All OR operators must come before all NOT operators

n Search terms and operators are not case sensitive

Symbol Application Example

* Represents any

number of char-

acters. Can

precede, fol-

low, or be in

between any

number of char-

acters to

search.

pl* searches for any term starting with

"pl"

*le searches for any term ending with *le

fa*st searches for any term beginning

with "fa" and ending with "st"

? Represents a

single char-

acter. Can

precede, fol-

low, or be in

between any

number of char-

acters to

search.

pl? searches for a three-letter term be-

ginning with "pl"

?le searches for a three-letter term be-

ginning with "le"

fa?st searches for a five-letter term be-

ginning with "fa" and ending with "st"
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Operator Application Example

OR Will display search res-

ults for the search

term preceding as well

as the search term fol-

lowing the operator.

version OR trak searches for

terms containing "version" as well

as terms containing "trak"

NOT Will remove search

results for the term

following the op-

erator.

version NOT trak searches for

terms containing "version" but will

remove terms containing "trak", in-

cluding terms that contain both

"version" and "trak"

NOTE: The usage of the symbols and operators as il-

lustrated above only apply for a file search. See Comment

Search Syntax for more information.

Examples:

To search for a filename that ends in "fss" or begins with "workshop":

*fss OR workshop*

To search for a filename that ends in "fmd" or "fss" but does not contain "example":

*fmd OR *fss NOT *example*

Comment Search Syntax

These search options are available when searching comments.

n The comment pattern may consist of an unlimited number of search terms

n A single search term can contain spaces

n Operators and search terms must be separated by a space

n The * and ? symbols are not valid in comment search as wildcard symbols

- 96 -



FTVersionTrak User Guide
Chapter 4 – Using FTVersionTrak • Searching with FTVersionTrak

n If using operators, each search term containing "or" or "not" must be surrounded
by a *

n A search term must precede and follow all OR operators

n A search term must follow all NOT operators

n All OR operators must come before all NOT operators

n Search terms and operators are not case sensitive

Operator Application Example

OR Will display search

results for the

search term pre-

ceding as well as

the search term fol-

lowing the

operator.

version OR trak searches for terms con-

taining "version" as well as terms containing

"trak"

NOT Will remove

search results for

the term following

the operator.

version NOT trak searches for terms con-

taining "version" but will remove terms

containing "trak", including terms that contain

both "version" and "trak"

NOTE: The * and ? symbols are not valid as wildcard sym-

bols within a comment search and will only produce results

if the symbols exist as part of the comment itself. However,

when searching for the words "or" and "not" within a com-

ment, the words must be enclosed within asterisks to

differentiate them from logical operators. See the examples

below. See File Search Syntax for more information.

Examples:

To search for a comment that contains the phrase "the quick brown fox" but does not con-

tain "the lazy dog":

the quick brown fox NOT the lazy dog
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To search for a comment that either contains the phrase "the quick brown fox" or contains

the phrase "the lazy dog" but does not contain the word "jumped":

the quick brown fox OR the lazy dog NOT jumped

To search for a comment that either contains the word "fox" or the word "not" but not the

word "dog"

fox OR *not* NOT dog

Using Search Results

FTVersionTrak displays the output of a Search in the Search Results dialog box. However,

instead of only displaying the results, you can perform common commands on the results

of the search, independently of the main window. To perform a command on a search res-

ult, right-click the item in the Search Results dialog box and then click the command you

want to perform from the shortcut menu.

For example, to check out a file that is listed in the Search Results dialog box, right-click

the file and then click Check Out on the shortcut menu.
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Generating Reports

Introduction to Reports

Generate up to ten different types of reports with FTVersionTrak's reporting feature.

These reports can be viewed, saved, printed, and copied into other documents for max-

imum flexibility.

To generate any of the available reports, a dialog box similar to the one below appears with

options to customize the report to be generated.

Under Include, indicate the information to include in the report.

l Author - Include an author name in the report header

l Date - Include the date and time the report was generated in the report header

l Server and Database - Include the name of the server and the repository that
the report was generated from in the report header

l Headers - Include header names of the reported data in a column structure

Under Data to report, indicate which data to include in the report.
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l Select As displayed to include all types of data in the report.

l Select Select data to report to specify which data is included in the report. Select
the check boxes of the data you want to include in the report. Clear the check
boxes of the data that will not be in the report. The types of data will vary de-
pending on the type of report being generated.

The buttons onthe right side of the dialogbox determine the format of the generated report:

l View - Opens the report as a *.TXT file in Microsoft Notepad.

l Save - Opens a Save As dialog box to save the report as a *.TXT file.

l Print - Opens a Print dialog box to send the report to a printer.

l Copy - Copies the file to the Windows Clipboard tobe inserted intoanotherdoc-
ument.

Any additional comments or information may be entered in the Comment text box.

File System Report

This report lists the contents and related information of a selected repository folder and its

subfolders.

To generate the FTVersionTrak File System report:

1. Select the repository folder from the folder tree that will be the starting point of the
report and then click Generate File System Report on the File menu, or press
CTRL+G. The File System Report dialog box appears.
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2. Under Include, indicate the information to include in the report:

l Author - Include an author name in the report header.

l Date - Include the date and time the report was generated in the report header.

l Server and Database - Include the name of the server and the repository that the
report was generated from in the report header.

l Headers - Include header names of the reported data in a column structure.

3. Optional: Enter an optional comment to attach to the report in the Comment box.

4. Under Data to report, click As displayed to include all data in the report or click

Select data to report to select which data to include from the following list:

l Name – Include the name of the file.

l Type – Include a description of the associated application of the file.

l Working File Status – Include the status of the working copy.

l Compressed Size –Include the size of the file as it exists in the repository.

l Date –Include the date the file was last modified.
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l Checked Out By – Include the username of the user who checked out the file, if
any.

l Check Out Location – Include the path of the working directory of the person
who checked out the file, if any.

l Working Size – Include the actual size of the file as it exists in a user's working
directory.

5. Select the format of the report to generate using the buttons on the right side of the
File System Report dialog box:

l View – Opens the report as a *.TXT file in Microsoft Notepad.

l Save – Opens a Save As dialog box to save the report as a *.TXT file.

l Print – Opens a Print dialog box to send the report to a printer.

l Copy –Copies the file toWindows Clipboard tobe inserted intoanotherdocument.

History Report

This report lists version history and related information of a selected repository file.

To generate the FTVersionTrak History report:

1. Select the repository file and then click History on the Version menu, click the

toolbar button or right-click a file and then click History on the shortcut menu.
The History dialog box appears.
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2. Click Report. The History Report dialog box appears.

3. Under Include, select which items to include in the report header.

l Author – Include an author name in the report header.

l Date – Include the date and time the report was generated in the report header.

l Server and Database – Include the name of the server and the repository that
the report was generated from in the report header.

l Headers – Include header names of the reported data in a column structure.
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4. Enter an optional comment to attach to the report in the Comment text box.

5. Under Data to report, select which data to include in the report. Click As dis-
played to include all data in the report or click Select data to report to select
which data to include from the following list:

l Version – Include the version number.

l Username – Include the username of the user who created the version.

l Date – Include the date and time the version was created.

l State – Include the repository file state of the version.

l Comment – Include the check in comment attached to the version, if any.

l Computer – Include the name of the computer upon which the version was
created.

l Label – Include any labels attached to the repository file.

6. Select the format of the report to generate using the buttons on the right side of the
History Report dialog box:

l View – Opens the report as a *.TXT file in Microsoft Notepad.

l Save – Opens a Save As dialog box to save the report as a *.TXT file.

l Print – Opens a Print dialog box to send the report to a printer.

l Copy –Copies the file toWindows Clipboard tobe inserted intoanotherdocument.

Search Results Report

This report lists the results of a search and its relevant information.

To generate the FTVersionTrak Search Results report:

1. Perform a search on the repository. The Search Results dialog box appears.
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2. Click the Report toolbar button . The Search Report dialog box appears.
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3. Under Include, select which items to include in the report header:

n Author – Include an author name in the report header.

n Date – Include the date and time the report was generated in the report
header.

n Server and Database – Include the name of the server and the repository
that the report was generated from in the report header.

n Headers –Include headernames of the reporteddata inacolumnstructure.

4. Enter an optional comment to attach to the report in the Comment box.

5. Under Data to report, select which data to include in the report. Click As dis-
played to include all data in the report or click Select data to report to select
which data to include from the following list:

l Name – Include the file name.

l Repository Folder – Include the repository folder in which the file is located.

6. Select the format of the report to generate using the buttons on the right side of the
Search Report dialog box:

l View – Opens the report as a *.TXT file in Microsoft Notepad.

l Save – Opens a Save As dialog box to save the report as a *.TXT file.

l Print – Opens a Print dialog box to send the report to a printer.

l Copy –Copies the file toWindows Clipboard tobe inserted intoanotherdocument.

Compare Files Reports

These reports list the results of a comparison of two Modicon FasTrak files, two 505

FasTrak files, or two text files.
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CompareFilesReports

These reports list the results of a comparison of two Modicon FasTrak files, two 505

FasTrak files, or two text files.

CompareModiconFasTrak FilesReport

This report contains the results of a comparison of two Modicon WorkShop files. To gen-

erate the Compare Modicon WorkShop Files Report:

1. Compare two Modicon FasTrak files. The Compare FasTrak Files Results dialog box
appears.

2. Click Generate Report. The Compare Files Report dialog box appears.
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3. Under Include, select which items to include in the report header.

l Author – Include an author name in the report header.

l Date – Include the date and time the report was generated in the report
header.

l Server and Database – Include the name of the server and the repository that
the report was generated from in the report header.

l Headers – Include header names of the reported data in a column structure.

4. Enter an optional comment to attach to the report in the Comment box.

5. Under Data to report, select which data to include in the report. Click As dis-
played to include all data in the report or click Select data to report to select
which data to include from the following list:

l Logic

l PLC Configuration

l Traffic Cop

l ASCII Ports

- 108 -



FTVersionTrak User Guide
Chapter 4 – Using FTVersionTrak • Generating Reports

l Modbus Ports

l Configuration Extensions

l Segment Scheduler

l Segment Information

l Loadables

l Symbols

l 0x Registers

l 1x Registers

l 3x Registers

l 4x Registers

l 6x Registers

l Coils Used

l Disabled States

l ASCII Messages

l Logic Documentation

l Address Documentation

l Print/Display/Editor Setup

l Differences Only

6. Select the format of the report to generate using the buttons on the right side of the
File System Report dialog box:

l View – Opens the report as a *.TXT file in Microsoft Notepad.

l Save – Opens a Save As dialog box to save the report as a *.TXT file.
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l Print – Opens a Print dialog box to send the report to a printer.

l Copy – Copies the file toWindows Clipboard tobe inserted intoanotherdoc-
ument.

Compare505 FasTrak FilesReport

This report contains the results of a comparison of two 505 WorkShop files. To generate

the Compare 505 WorkShop Files Report:

1. Compare two505 FasTrak files. The Compare FasTrak Files Results dialogboxap-
pears.

2. Click Generate Report. The Compare Files Report dialog box appears.
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3. Under Include, select which items to include in the report header.

l Author – Include an author name in the report header.

l Date – Include the date and time the report was generated in the report
header.

l Server and Database – Include the name of the server and the repository that
the report was generated from in the report header.

l Headers – Include header names of the reported data in a column structure.

4. Enter an optional comment to attach to the report in the Comment box.

5. Under Data to report, select which data to include in the report. Click As dis-
played to include all data in the report or click Select data to report to select
which data to include from the following list:

l Show Different Only

l Logic

l PLC Configuration

l XY Registers
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l Control Relays

l WXY Registers

l V-Memory

l K-Memory

l TCP

l I/O

l Profibus I/O

l Forced I/O

l Sequencer Scan Time

l Alarms

l Loops

l SmarTunes

l Ramp/Soak

l Address Documentation

l Logic Documentation

l Print/Display/Editor Setup

6. Select the format of the report to generate using the buttons on the right side of the
File System Report dialog box:

l View – Opens the report as a *.TXT file in Microsoft Notepad.

l Save – Opens a Save As dialog box to save the report as a *.TXT file.

l Print – Opens a Print dialog box to send the report to a printer.
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l Copy –Copies the file toWindows Clipboard tobe inserted intoanotherdoc-
ument.

CompareText FilesReport

This report contains the results of a comparison of two text files. To generate the Com-

pare Text Files Report:

1. Compare two text files. The Text Difference dialog box appears.

2. Click Generate Report. The Compare Files Report dialog box appears.
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3. Under Include, select which items to include in the report header.

l Author – Include an author name in the report header.

l Date – Include the date and time the report was generated in the report
header.

l Server and Database – Include the name of the server and the repository that
the report was generated from in the report header.

l Headers – Include header names of the reported data in a column structure.

4. Enter an optional comment to attach to the report in the Comment box.

5. Under Data to report, select which data to include in the report. Click As dis-
played to include all data in the report or click Select data to report to select
which data to include from the following list:

l Same

l Inserted

l Deleted

l Modified
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l Line Numbers

l Text Lines

6. Select the format of the report to generate using the buttons on the right side of the
File System Report dialog box:

l View – Opens the report as a *.TXT file in Microsoft Notepad.

l Save – Opens a Save As dialog box to save the report as a *.TXT file.

l Print – Opens a Print dialog box to send the report to a printer.

l Copy –Copies the file toWindows Clipboard tobe inserted intoanotherdoc-
ument.

LiveCompareReport

Content coming soon.

Compare Folders Report

This report lists the results of a folder compare and its relevant information.

To generate the FTVersionTrak Compare Folders report:

1. Perform a folder compare on two folders. The Compare Folders dialog box appears.
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2. Click Generate Report. The Compare Folders Report dialog box appears.

3. Under Include, select which items to include in the report header:

n Author – Include an author name in the report header.

n Date – Include the date and time the report was generated in the report
header.
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n Server and Database – Include the name of the server and the repository
that the report was generated from in the report header.

n Headers –Include headernames of the reporteddata inacolumnstructure.

4. Enter an optional comment to attach to the report in the Comment box.

5. Under Data to report, select which data to include in the report by clicking As dis-
played to include all data in the report or clicking Select data to report to select
which data to include from the following list:

l Show Different Only

l Name

l Relative Path

l Date

l Compressed Size

6. Select the format of the report to generate using the buttons on the right side of the
Compare Folders Report dialog box:

l View – Opens the report as a *.TXT file in Microsoft Notepad.

l Save – Opens a Save As dialog box to save the report as a *.TXT file.

l Print – Opens a Print dialog box to send the report to a printer.

l Copy –Copies the file toWindows Clipboard tobe inserted intoanotherdocument.

Activity Log Report

This report lists the results contained in the Activity Log.

To generate the FTVersionTrak Activity Log report:
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1. Start the Activity Log by clicking Activity Log on the View menu. The Activity
Log dialog box appears.

2. Click Generate Report. The Report dialog box appears.

- 118 -



FTVersionTrak User Guide
Chapter 4 – Using FTVersionTrak • Generating Reports

3. Under Include, select which items to include in the report header:

n Author – Include an author name in the report header.

n Date – Include the date and time the report was generated in the report
header.

n Server and Database – Include the name of the server and the repository
that the report was generated from in the report header.

n Headers –Include headernames of the reporteddata inacolumnstructure.

4. Enter an optional comment to attach to the report in the Comment box.

5. Under Data to report, select which data to include in the report. Click As dis-
played to include all data in the report or click Select data to report to select
which data to include from the following list:

l Date – Include the date and time of the recorded.

l User – Include the username and workstation name of the user who initiated the
activity.

l Action – Include the tag describing the action of the logged event.

l Message – Include a more detailed comment on the nature and location of the
logged event.

6. Select the format of the report to generate using the buttons on the right side of the
Compare Folders Report dialog box:

l View – Opens the report as a *.TXT file in Microsoft Notepad.

l Save – Opens a Save As dialog box to save the report as a *.TXT file.

l Print – Opens a Print dialog box to send the report to a printer.

l Copy –Copies the file toWindows Clipboard tobe inserted intoanotherdocument.
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Administrator Guide

The FTVersionTrak administrator is responsible for managing and maintaining the security

of change-sensitive files. As the administrator, you will install and configure FTVer-

sionTrak based on the version control needs of your project or company. Many of

FTVersionTrak's most powerful features are intended to only be used by the administrator.

The following topics illustrate these features in detail, while assuming little about you, the

prospective FTVersionTrak administrator. Anyone with a basic understanding of Microsoft

Windows can be an effective FTVersionTrak administrator using this guide. In the event

that a question arises that is not adequately addressed by this guide, please contact FasTrak

SoftWorks Customer Support.
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System Requirements

FTVersionTrak Client Requirements

The following is required to install FTVersionTrak:

l Operating systems supported:

l Windows XP Professional Sp1A or later

l Windows Vista (Business or Enterprise)

l Windows 7 Professional, Enterprise, or Ultimate

l Windows 8 and Window 8.1

l Windows 10

l 100 MB free disk space

l FTVersionTrak requires Microsoft Data Access Components (MDAC) v2.7.
MDAC 2.7 will be installed or updated automatically to meet this requirement.

l FTVersionTrak requires the .NET framework 2.0 or higher; this component will
be installed or updated automatically to meet this requirement.

NOTE: You must be logged in as the administrator to in-

stall FTVersionTrak. In addition, User Access Control must

be disabled to install and use FTVersionTrak.

MS SQL Server Express Database Requirements

The following is required to install the SQL Server database:
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l Operating systems supported:

l Windows 10

l Windows 8

l Windows 7

l Windows Server 2008

l Windows Server 2008 R2

l Windows Server 2003 Service Pack 2

l Windows Vista Service Pack 1

l Windows XP Service Pack 3

l PCs:

l 32-bit systems

l Intel or compatible 1 GHz or faster processor (2 GHz or faster
recommended)

l Minimumof256 MB ofRAM( 1 GB ormore is recommended)

l 1 GB of free hard disk space

l 64-bit systems

l 1.4 GHz or higher processor (2 GHz or faster recommended).

l Minimum of 256MB of RAM (1 GB or more is recommended)

l 1 GB of free hard disk space
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NOTE: You must be logged in as the administrator to in-

stall the SQL Server database. In addition, User Access

Control must be disabled to install the SQL Server database.

Disabling User Access Control (UAC)

Windows User Access Control (UAC) must be disabled in order to install and use FTVer-

sionTrak. Log in as a Windows Administrator and follow the instructions below to disable

UAC for Windows Vista, 7, 8, 10, and 11.

Windows 10 and11

1. From Control Panel, select User Accounts > User Accounts > Change User
Account Control Settings.

2. Move the slider to Never notify.

3. Restart the computer, so changes take effect.

Windows7 and8

1. Open User Account Control Settings by clicking the Start button and then clicking
Control Panel. In the search box, type uac, and then click Change User Account
Control settings.

2. To turn off UAC, move the slider to the Never notify position, and then click OK.
If you are prompted for an administrator password or confirmation, type the pass-
word or provide confirmation. You will need to restart your computer for UAC to
be turned off.

WindowsV ista

1. Open User Accounts by clicking the Start button, clicking Control Panel, clicking
User Accounts and Family Safety (or clicking User Accounts, if you are con-
nected to a network domain), and then clicking User Accounts.
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2. Click Turn User Account Control on or off. If you are prompted for an ad-
ministrator password or confirmation, type the password or provide confirmation.

3. Clear the Use User Account Control (UAC) to help protect your computer
check box to turn off UAC and then click OK. You may need to restart your com-
puter for UAC to be turned off.
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Installation

Installation Instructions

1. Insert the FTVersionTrak CD into your computer’s CD-ROM drive.

2. The Install Wizard should start automatically. If not, open the file explorer, select
the CD-ROM drive in the left pane, and run the setup.exe file.

3. The FTVersionTrak Install Shield Wizard appears. This utility determines if any ne-
cessary software components must be installed to support FTVerionTrak. Below is
an example of items that the Wizard may install. Click Install.

4. Click Install to begin Installation.

NOTE: You must be an Administrator to install FTVer-

sionTrak.
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5. The Microsoft .NET Framework installation beings.

6. Accept the Microsoft .NET Framework terms and conditions, then click Install to
begin the installation.
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7. When installation is complete, click Finish to continue.
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8. The following screen gives you the option to install Microsoft SQL Server. Click
Yes to install SQL, or click No to skip this step.

9. After installation of SQL is complete, the following screen gives you the option to
install Sentinel Protection Driver (FT-KEY Driver). Click Yes to install the Sentinel
Protection Driver, or click No to skip this step. This step is required for use of
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FTVersionTrak with keyed licenses.

10. After installation of Sentinel Protection Driver is complete, the FTVersionTrak cli-
ent Install Shield Wizard appears. Click Next.
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11. Accept the FasTrak license terms and conditions, then click Next to continue.

12. Enter a user name (required) and organization name (optional). Click Next to con-
tinue.
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13. On the Setup Type window, select Complete. Click Next.

14. Select who should have access to the FTVersionTrak application. Click Install.
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15. After installation of the FTVersionTrak client is complete, click Finish to complete
installation.

Demo Mode Restrictions

If using this software without a license, you may run FTVersionTrak in demo mode, which

restricts the application to limited functionality. Running FTVersionTrak in demo mode

gives you the opportunity to try out all of FTVersionTrak's powerful features before buy-

ing a license for it.

When you start FTVersionTrak without a license the following message appears:
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Click Demo to run FTVersionTrak in demo mode.

The following restrictions apply when using FTVersionTrak in demo mode:

Users will be able to:

l Create one repository.

l Add any of the 10 included example files in the repository.

l Create up to four versions of any one file.

l Compare versions of any of the included example files.

Once you have reached your file and version limit, if you would like to continue evaluating

the demo, you can reset the repository and start again by clicking Restore Respoitory to

Factory State on the File menu. This function will clear all data from the repository and

reset any configured settings to their defaults.

Please note that you cannot add any files to the repository other than the sample files

provided with the demo, and that these files cannot be altered in any way prior to adding to

the repository. Attempts to add modified sample files or any other files to the repository

while in demo mode are restricted and will result in an error.

If you do not have a license and would like to receive the full functionality of FTVer-

sionTrak, contact the FasTrak sales department at sales@fast-soft.com or call

262.238.8088.
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Setup and Troubleshooting

Introduction to Setup and Troubleshooting

Use the information in this setup and troubleshooting guide to determine the setup that

best meets your user requirements and to troubleshoot problems associated with con-

necting to SQL Server.

SQL Server Setup

The Client/Server Model

FTVersionTrak functions as a client of Microsoft SQL Server. This means that FTVer-

sionTrak can do little on its own. The computer on which SQL Server is installed and

running contains all the data that FTVersionTrak reads from, writes to, manages, and pro-

tects. This computer, in conjunction with the SQL Server software, is the server in our

client/server model. Any user who wants to use FTVersionTrak to access the data on the

server must be able to connect to it somehow. If the FTVersionTrak client is located on a

different machine than SQL Server, the client and server use the TCP/IP communications

protocol to communicate with each other. In this way, many FTVersionTrak clients can

connect to the same instance of Microsoft SQL Server to access common data con-

currently.
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Why SQL Server?

Ease of Accessibility – Because all client/server communications are handled by SQL,

FTVersionTrak can communicate any way that SQL Server can communicate. Fur-

thermore, file accessibility can be granted to any client.

Quick and Efficient Data Retrieval – When searches are performed, data such as files,

comments, keywords, users, and versions, is retrieved much more quickly. Moving and re-

naming files also occurs faster.

Powerful and Flexible User Authentication – Both SQL and Windows authentication

protocols are supported simultaneously allowing you to take advantage of the benefits of

each type.

l Windows-based authentication is more secure and easier to use. Passwords don’t
need to be remembered and credentials are not passed over a network.

l SQL-based authentication is faster to set up, and access may be provided to a re-
pository without giving access to the rest of the Windows network. A typical
username / password combination is employed, which will exist only for the data-
base server. This means you don’t have to create a new domain member for
temporary access by consultants, and security is managed independently from net-
work security.

Data Protection – The SQL database exists separately from the files that users will be edit-

ing. The process of editing, deleting, and renaming files happens only on the user’s local

machine, not the FTVersionTrak database. Each time a change is made, FTVersionTrak

makes a note of the change while keeping the original data intact and retrievable.

Data Integrity – The SQL database also exists separately from FTVersionTrak itself. If a

program error occurs in FTVersionTrak or even if FTVersionTrak is completely un-

installed and reinstalled, the data remains intact. The entire database can also be backed up

as a single file for portability and added security.

Connection Problems

TroubleshootingConnectionProblems

As networking and security components become more complex, the number of factors pre-

venting a user from connecting increases. Connecting to the FTVersionTrak repository will
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likely be one of the more common problems an FTVersionTrak user will face. Though by

no means comprehensive, this troubleshooting guide outlines the most common causes of

connection problems, and possible solutions to these problems.

NOTE: This information is written under the assumption

that you have administrative access to computer being con-

figured. Your organization's network security policy may

prevent a normal user from accessing and/or editing the ap-

plications and utilities described in this guide. You may

require assistance or support from your system administrator

or whoever in your organization is in charge of network se-

curity to proceed with this troubleshooter.

Step One: Check SQL Server Setup

Follow the steps outlined in SQL Server Setup to verify that SQL Server is configured to

accept remote connections.

Step Two: Set Local Security Policy for Windows Authentication

Step Three: Check Firewall Settings

Step Four: Check Anti-Virus Settings

SettingLocal Security Policy

By default, many Windows installations force network logins that use local accounts to be

authenticated as Guests. FTVersionTrak requires that network logins that use local ac-

counts must authenticate themselves. To accomplish this, the server machine's Local

Security Policy must be changed to permit local users to authenticate as themselves. Ask

your IT or network administrator for assistance, or consult your Windows documentation

for the specific procedures to follow for your version of Windows. The following in-

structions describe how to change the local security using Windows XP Professional (other

versions of Windows may require different instructions):

1. Choose Control Panel on the Start menu.

2. In Control Panel, double-click Administrator tools.

3. In the Administrative tools window, double-click Local Security Policy.

4. Under Security Settings, open the Local Policies folder.
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5. In the Local Policies folder, select Security Options.

6. In the Policy column, find Network access: sharing and security model for
local accounts and double-click it.

7. In the Network access: sharing and security model for local accounts dialog
box, change the setting from Guest only - local users authenticate as Guest to
Classic - local users authenticate as themselves and click OK.

8. Close the window and restart the computer.

CheckingFirewall Settings

Dependingonthe type of firewall usedat yourorganization, you may need toaddFTVer-

sionTrak andSQLServeras exceptions inorder togrant remote users access to

FTVersionTrak. Consult the documentation that came withyourfirewall, or talk toyourIT or

network administrator, forassistance inconfiguringyourfirewall foruse withFTVersionTrak.

CheckingAnti-V irus Settings

Anti-virus programs such as Symantec's Norton AntiVirus and McAfee VirusScan can also

block programs from permitting incoming communication requests. SQL Server must be

permitted to accept incoming requests to allow remote FTVersionTrak users to access a re-

pository. See your IT or network administrator, or consult the documentation that came

with your anti-virus software, for additional information about program access permissions.
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Modicon Network Set Up

Introduction to Modicon Network Setup

Modicon Network setup enables you to assign default communication paths within your

Modicon network to individual PLC WorkShop files. When you launch these files in

FTVersionTrak, they automatically connect to the assigned PLC, allowing you to edit logic

resident on the PLC while ensuring that the latest version of the program is being used.

NOTE: This feature is not available in FTVersionTrak PE.

Network Setup is available for Modbus, Modbus Plus, and TCP/IP networks, as well as hy-

brid networks containing any combination of the three. By mapping out your Modicon

network, Network Setup can route any PLC WorkShop for Modicon program file stored in

your FTVersionTrak repository to any Modicon PLC on your network.

Just as with all files secured with FTVersionTrak, a Network Setup configuration file is

stored in the FTVersionTrak repository and retains its own version history as the con-

figuration changes. One network configuration can be created for each repository.

NOTE: Modicon Network Setup is intended only for ad-

vanced users with administrative access to network

infrastructure. The hardware-specific information detailed in

this guide is provided as a courtesy only; please consult the

relevant hardware documentation for complete details about

specific hardware configuration.

Before you begin, please review the Network SetupPrerequisites andverify that you have ac-

cess toall ofnecessary network hardware, configurationapplications anddocuments, and

hardware manuals. Specific hardware manuals are noted throughout this guide where relevant.

l Network Setup - familiarizes you with the Network Setup dialog box and its func-
tions and describes configuration options in detail.

l Working with Network Setup - provides a more user-oriented viewpoint to net-
work configuration and details tools for administrating the configuration.

l Assigning and Connecting to PLCs - describes the practical application of the
completed network configuration and how it is utilized by end users.
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Network Setup Prerequisites

The following is required in order to assure that Modicon Network Setup works correctly

in every instance of use.

l Each FTVersionTrak client computer must have connectivity to the FTVer-
sionTrak repository in which the Modicon Network Setup is configured.

l Each FTVersionTrak client computer must act as a node on the network con-
figured in Modicon Network Setup.

l Each computer on which the FTVersionTrak client is installed must also have in-
stalled a licensed copy of PLC WorkShop for Modicon, version 5.70 or above.

Network Setup

Network SetupDialogBox

The Network Setup dialog box is where you will construct and configure your Modicon

network by adding and connecting Computers, PLCs, and Network Link Devices. From

this dialog box you can also perform version control features on the network configuration,

such as archiving, importing and exporting, and viewing history.

To access Network Setup:

1. Click Network Setup on the Tools menu. The Network Setup dialog box appears.
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The Network Setup dialog is divided into four areas:

l Network Setup Toolbar - use to quickly select the most commonly-used com-
mands within Network Setup

l Network Tree - displays a list of Modbus, Modbus Plus, and TCP/IP net-
works and their associated devices

l Device List - displays a list of network node devices, divided by tabs into
three device types: Computers, PLCs, and Link Devices.

l Configuration Properties - displays a list of configurable parameters available
for the selected network node device.

Network SetupToolbar

The Network Setup Toolbar appears along the top of the Network Setup dialog box and

gives the user quick access to the dialog box's most commonly-used functions. See Work-

ing with Network Setup for more detailed information about these functions.
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l New – adds a new Network, Computer, PLCs, or Link Device to the working net-
work configuration

l Save – saves changes made to the working network configuration, making the con-
figuration current

l Archive – backs up the current network configuration to History

l Import – loads an exported configuration file to the working configuration

l Export – saves the working configuration to a file on the local machine

l History – displays a list of archived configurations

l Compare – compares the contents of two configurations to each other

l Network Report – generates the contents of the working configuration in a stand-
ardized format

l PLC Report – generates a list of PLC destination assignments for WorkShop files
in the repository

l Options – displays additional Communication Setup options

n Help – launches the online help

Network Tree

The Network Tree is a catalog of interconnected network node devices arranged within

one of three supported network protocols: Modbus, Modbus Plus, and TCP/IP. After net-

work node devices are configured, they can be added as members of user-defined networks

sorted by network protocol.

Before working in the Network Tree, gather all relevant network planning documents that

accurately describe the relationship between your network devices. See the Modicon Modbus

Plus Network Planning and Installation Guide for printable network planning documents or see

the Network Setup Walkthrough for an example network.

To add networks and devices to the Network Tree:

1. On the Network Setup Toolbar, click New, point to Network, and then click MB
Network, MB+ Network, or TCP/IP Network. Or, right-click the desired net-
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work type, point to New, and then click Network on the shortcut menu. The new
network appears in the Network Tree below the selected network type.

2. By default, the network is named "New Network". Enter a unique name for the net-
work so that it can be easily identified. Examples include naming by network
location, function, or administrative responsibility. See Adding Networks and
Devices for more information.

3. Add all devices that are members of the network by dragging devices from the
Device List and dropping them onto the desired network in the Network Tree. Or,
right-click the network, point to Add, and then click the type of device to add on
the shortcut menu.

NOTE: You cannot add devices to the Network Tree until

they have been created in the Device List. However, device

configuration properties can be edited at any time.

4. Delete a network by selecting the network to delete and pressing the Delete key or
by right-clicking the network and then clicking Delete on the shortcut menu. De-
leting a network will also delete all device connections associated with the network.
The network devices themselves are not deleted.

DeviceList

INTRODUCTION TODEVICELIST

The Device List is a set of tabbed windows in the Network Setup dialog box that contains

all configurable network devices. Use the Device List to create, view, and edit network

devices before assigning them to networks. The three types of network devices that are

configurable in Modicon Network Setup are:
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l Computers - Computers must have both PLC WorkShop for Modicon and the
FTVersionTrak client installed, at least one valid communication port with which
it connects to the Modicon network, and connectivity to the FTVersionTrak re-
pository containing the Network Setup configuration. See Network Setup
Prerequisites for more information.

l PLCs - Valid PLCs are any PLCs supported by PLC WorkShop for Modicon Ver-
sion 5.70 and above. See the PLC WorkShop for Modicon user manual for
supported PLCs.

l Link Devices - Link devices connect multiple networks together, including net-
works of different protocols. Modicon Network Setup supports six different
network link devices listed below. See Link Device Configuration Properties for
more information on each supported link device.

Supported Link Devices are:

l BP85 Modbus Plus Bridge - Allows you to connect two Modbus Plus net-
works. See the Modbus Plus Network Planning and Installation Guide (890 USE 100 00)
Rev. 6.0 for more information.

l BM85 Modbus Plus Bridge Multiplexer - Provides four serial ports to connect
Modbus devices or networks to a Modbus Plus network. See the Modicon Modbus
Plus Network BM85 Bridge Multiplexer User's Guide (890 USE 103 00) Rev. 1.0 for
more information.

l 174 CEV300 10Modbus toEthernetBridge -Allows you toconnect TCP/IPnet-
work devices toModbus network devices. See the 174 CEV300 10ModiconTSX
MomentumModbus toEthernetBridgeUserGuide (890 USE155 00) formore information.

l 174 CEV 200 30 Modbus Plus to Ethernet Bridge - Allows you to connect
TCP/IP network devices to Modbus Plus network devices. See the 174 CEV
200 30 Modicon TSX Momentum Modbus Plus to Ethernet Bridge User Guide (890 USE
151 00) for more information.

l 174 CEV 200 40 Modbus Plus to Ethernet Bridge - Allows you to connect
TCP/IP network devices to Modbus Plus network devices, with more advanced
capabilities than the 174 CEV 200 30 device, such as dynamic routing and address
filtering. See the Modbus Plus to Ethernet Bridge 174 CEV 200 40 User Guide (890
USE 191 00) for more information.

l Cyberlogic® MBX® Bridge - A software-based link device that allows you to
connect any combination of Modbus, Modbus Plus, and TCP/IP networks. See
the MBX® Bridge Helpmanual for more information.
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COMPUTERS

Computers on your Modicon network are added to the Device List using the Computer

tab. Computers can be connected to the network via Ethernet port (TCP/IP), COM port

(Modbus), or SA85 port (Modbus Plus), or any combination of the three. Modicon Net-

work Setup supports up to three Ethernet ports, up to two SA85 ports, and up to 16 COM

ports on a single computer.

TO ADD A COMPUTER TO THE DEVICE LIST :

1. On the Network Setup Toolbar, click New, then click Computer. Or ,click the
Computers tab, right-click anywhere in the Device List, point to New, and then
click Computer on the shortcut menu. The new computer appears on the Com-
puters tab.

2. By default, the name of the new device is "Computer". Enter a unique name for the
new device.

NOTE: It is recommended to name the computer the

same as it appears on the network for consistency. This

name can be changed at any time by right-clicking the com-

puter and then selecting Rename from the shortcut menu.

A new name can also be entered in the Name box on the

Properties tab.

3. Select the computer to view and edit its configuration properties, which appear be-
low the Device List.
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See Computer Configuration Properties for more information on configuring com-

munication settings.

TO DELETE A COMPUTER FROM THE DEVICE LIST

1. Delete computers from the Device List by right-clicking a computer on the Computer
tab and then clicking Delete from the shortcut menu. Or, select a computer and then
press DELETE. A warning message appears, asking to confirm the deletion. ClickYes to
delete the computer, or No to return to Communication Setup.

PLCS

PLCs on your Modicon network are added to the Device List on the PLC tab. PLCs can

be attached to Modbus, Modbus Plus, and TCP/IP, networks and can also act as a bridge

between networks. Modicon Network Setup supports up to three Modbus ports, three

Modbus Plus ports, and six TCP/IP ports per PLC.

TO ADD A PLC TO THE DEVICE LIST :

1. On the Network Setup Toolbar, click New, then click PLC. Or, click the PLCs
tab, right-click anywhere in the Device List, point to New, and then click PLC on
the shortcut menu. The new PLC appears in the PLC Tab.
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2. By default, the name of the new device is "PLC". Enter a unique name for the new
device. The name can be changed at any time by right-clicking a PLC on the PLCs
tab and then clicking Rename from the shortcut menu. A new name can also be
entered in the Name box on the Properties tab.

3. Select the PLC to view and edit its configuration properties, which appear below
the Device List.

See PLC Configuration Properties for more information on configuring com-

munication settings.

TO DELETE A PLC FROM THE DEVICE LIST

1. Delete PLCs from the Device List by right-clicking within the PLC stab and then click-
ing Delete from the shortcut menu. Or, select a device and then press DELETE. A
warning message appears, asking to confirm the deletion. Click Yes to delete the PLC, or
No to return to Communication Setup.

LINKDEVICES

Link devices on your Modicon network are added to the Device List on the Link Devices

tab.

TO ADD A LINK DEVICE TO THE DEVICE LIST :

1. On the Network Setup Toolbar, click New, then point to New Device, then click
the device you want to add. Or,or right-click the Device List, point to New, and

- 149 -



FTVersionTrak User Guide
Chapter 5 – Administrator Guide • Modicon Network Set Up

then click Link Device on the shortcut menu. The new Link Device appears in the
Link Devices tab.

2. By default, the name of the new device is "Link Device". Enter a unique name for
the new device. This name can be changed at any time by right-clicking a device on
the Link Devices tab and then clicking Rename. A new name can also be entered
in the Name box on the Properties tab.

3. Select the link device to view and edit its configuration properties, which appear be-
low the Device List.

See Link Device Configuration Properties for more information on configuring com-

munication settings.

TO DELETE A LINK DEVICE FROM THE DEVICE LIST

1. Delete link devices from the Device List by right-clicking a device on the Link Devices
tab and then clicking Delete from the shortcut menu. Or, select a device and then press
DELETE. A warning message appears, asking to confirm the deletion. Click Yes to de-
lete the device, or No to return to Communication Setup.
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ConfigurationProperties

INTRODUCTION TOCONFIGURATION PROPERTIES

Use the configuration properties to set communication parameters for the computers,

PLCs, and link devices on your network. To view a device's configuration properties, se-

lect the device in either the Device List or in the Network Tree within the Network Setup

dialog box. The configuration properties for the selected device appear below the Device

List.

NOTE: Each type of device has its own set of con-

figuration properties, some of which require a more

advanced level of knowledge than others. Please consult

with your Modicon network administrator or your hard-

ware's documentation before and during device

configuration to ensure communication settings are con-

figured properly.

COMPUTERCONFIGURATION PROPERTIES

The Computer Configuration Properties appear when you select a Computer device from

the Device List.

After adding a new computer to the Device List, a default list of five ports appear for con-

figuration, including:

l Two Modbus ports (COM1 and COM2)

l Two Modbus Plus ports (SA85_1 and SA85_2)

l One TCP/IP port (Ethernet 0)
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More ports may be added and configured if necessary (see the following section). Please

note that it is possible to configure ports in Computer Configuration Properties that do not

exist on the actual hardware.

TO CONFIGURE COMMUNICATION PORTS FOR A SELECTED

COMPUTER:

1. Determine the type(s) of connection the computer makes to the network and select
the appropriate port for the connection. Verify that the selected port number
matches the port connected to the network.

2. Select the menu under the Network column for the selected port and choose the
network that the computer belongs to. If you do not see the correct network listed,
verify that the network has been created and exists under the proper protocol. See
Network Tree for more information.

3. Repeat steps 1 and 2 for additional connections to other networks.

4. If additional ports need to be configured, click the button below the last lis-
ted port. A new line appears.

5. Select thePort menu andselect the type ofport you would like toconfigure. If you se-
lect aport that is already listed, anerrorappears, andyou will not be able tocontinue.

To remove the error, either select a port that is not listed or delete the port by high-

lighting the row and pressing DELETE.

6. Continue adding and configuring ports until all physical ports on the computer are ac-
curately represented in the configuration properties. Modicon Network Setup supports
up to three Ethernet ports, up to two SA85 ports, and up to 16 COM ports on a single
computer.

PLCCONFIGURATION PROPERTIES

The PLC Configuration Properties appear when you select a PLCdevice from the Device

List.
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After adding a new PLC to the Device List, a default list of 12 ports appear for con-

figuration, including:

l Three Modbus ports

l Three Modbus Plus ports

l Six TCP/IP ports

TO CONFIGURE COMMUNICATION PORTS FOR A SELECTED PLC :

1. Determine the type(s) of connection the PLC makes to the network and select the
appropriate port for the connection.

2. Select the menu under the Network column for the selected port and choose the
network that the computer belongs to. If you do not see the correct network listed,
verify that the network has been created and exists under the proper protocol. See
Network Tree for more information.

3. Configure the port by assigning a port address and setting additional port parameters.
See Configuring Network Ports for more information.

4. Repeat steps 1– 3 for additional connections to other networks.

5. Continue adding and configuring ports until all physical ports on the PLC are ac-
curately represented in the configuration properties.
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6. If the selected PLC connects two or more networks, select the check boxed titled
This PLC acts as a bridge between networks.

7. If you have not already done so, rename the PLC to a unique name by editing the
Name text box.

LINKDEVICES

LINK DEVICE CONFIGURATION PROPERTIES

Modicon Network Setup support six different types of network link devices, which can be

added and configured from the Link Devices tab of the Device List. Each type of link

device has its own set of configuration properties, and some may require an advanced

knowledge of Modicon network device address mapping to be configured correctly. Please

refer to the device's user documentation for proper configuration instructions.

NOTE: If your network link device is operating correctly,

all relevant configuration information will be available from

the device itself or its configuration utility. The con-

figuration parameters listed in Link Device Configuration

Properties must exactly match the parameters configured

within the device itself. Otherwise, attempts to connect to

PLCs using the Network Connection utility may fail.

BP85 CONFIGURATION PROPERTIES

The BP85 Modbus Plus Bridge can be used to connect two Modbus Plus networks. The

BP85 Configuration Properties appear when you select a BP85 link device from the

Device List. See the Modbus Plus Network Planning and Installation Guide (890 USE 100 00)

Rev. 6.0 for more information about configuring this device.

After adding a new BP85 device, the following configuration properties appear below the

Device List:
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To configure communication ports for the BP85 device:

1. Set the Modbus Plus addresses for Port 1 and Port 2 of the device in the Port 1 Ad-
dress and Port 2 Address boxes. These addresses should already be set on the
device itself.

2. Change the default port settings for each port by clicking Port Settings. The Port
Settings dialog box appears.

l Response T.O. – specifies the amount of time, in seconds that the software waits
for a response from the PLC before returning a time-out error. Any whole number
between 1 – 25 can be used.

l BM85 Network – select NO if you are not communicating via a BM85
Bridge/MUX or modem. Select YES to set a two-minute response timeout for ap-
plications using a Bridge/MUX or modem.
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l Retries –specifies the number of times the software will try to re-establish com-
munications with the PLC after a time-out error. Any whole number between 0 –
10 can be used. Use 0 for no retries.

3. In the Connected to Network list for the selected port, select the network that
the port connects to. If you do not see the correct network listed, verify that the
network has been created and exists under the proper protocol. See Network Tree
for more information.

4. If you have not already done so, rename the device to a unique name by editing the
Name box.

BM85 CONFIGURATION PROPERTIES

The BM85 Modbus Plus Bridge Multiplexer provides four serial ports to connect Modbus

devices or networks to a Modbus Plus network. The BM85 Configuration Properties ap-

pear when you select a BM85 link device from the Device List. See the Modicon Modbus

Plus Network BM85 Bridge Multiplexer User's Guide (890 USE 103 00) Rev. 1.0 for more in-

formation about configuring this device.

After adding a new BM85 device, the following configuration properties appear below the

Device List:

To configure communication ports for the BM85 device:

- 156 -



FTVersionTrak User Guide
Chapter 5 – Administrator Guide • Modicon Network Set Up

1. Set the Modbus Plus addresses in the Modbus+ Address box. This address should
already be set on the device itself.

2. Change the default port settings for the Modbus Plus port by clicking Port
Settings. The Port Settings dialog box appears.

l Response T.O. – specifies the amount of time (in seconds) that the software
waits for a response from the PLC before returning a time-out error. Any whole
number between 1 – 25 can be used.

l BM85 Network – select NO if you are not communicating via a BM85
Bridge/MUX or modem. Select YES to set a two-minute response timeout for ap-
plications using a Bridge/MUX or modem.

l Retries – specifies the number of times the software will try to re-establish com-
munications with the PLC after a time-out error. Any whole number between 0 –
10 can be used. Use 0 for no retries.

3. In the Connected to Network list for the Modbus Plus port, select the network
that the port connects to. If you do not see the correct network listed, verify that
the network has been created and exists under the proper protocol. See Network
Tree for more information.

4. Under Modbus Ports, for each Modbus port (Port 1 – Port 4) that has a connection
to a Modbus network device, select the port.

5. After selecting a Modbus port, select the type of port you wish to configure:

l Network – if this port is only acting as a link to another network, no further set-
tings need to be made to the port.

l Master –if this port is connected to a Modbus master device, the Port Settings
button is enabled. Click the button to change the default settings. The Port Set-
tings dialog box appears.
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l Protocol – specifies the transmission mode. The communications mode toggles
between RTU (default) and ASCII.

l Response T.O. – specifies the amount of time, in seconds that the software
waits for a response from the PLC before returning a time-out error. Any whole
number between 1 – 25 can be used.

l Retries – specifies the number of times the software will try to re-establish com-
munications with the PLC after a time-out error. Any whole number between 0 –
10 can be used. Use 0 for no retries.

l Baud Rate –the rate of communications between the computer and modem. (de-
fault: 9600)

l Parity – specifies a parity bit for error detection. Can be set to EVEN, ODD, or
NONE. (default: Even)

l Stop Bits – specifies the number of stop bits per transmission as either 1 or 2.
(default: 1)

l BM85 Network – select NO if you are not communicating via a BM85
Bridge/MUX or modem. Select YES to set a two-minute response timeout for
applications using a Bridge/MUX or modem.
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l Dial Modem –select when the selected form of serial communications is
through a modem. The modem parameters must be set to exactly the same com-
munication parameters that you will use.

l Telephone Dialing –specifies which type of dialing to use. Specify pulse dialing
only if this is the only type your phone line supports. The communications mode
toggles between Tone (default) and Pulse.

l Initialization Command – the initialization commands sent to the modem. Con-
sult your modem manual for a list of appropriate commands.

l Number to Dial – specifies the phone number to be dialed.

l Slave –if this port is connected to a Modbus slave device, the Address text box
is enabled. Enter the Modbus slave address for the device in the text box. This
address should already be configured on the device itself.

6. In the Connected to Network list for the selected Modbus port, select the net-
work that the port connects to. If you do not see the correct network listed, verify
that the network has been created and exists under the proper protocol. See Net-
work Tree for more information.

7. If you have not already done so, rename the device to a unique name by editing the
Name box.

8. Configure network mappings for the device by selecting the Mappings tab. The
BM85 Mapping Table appears.

l For each Modbus Plus route, enter the Destination Index under the Index
column, and the 5-byte Modbus Plus route under the Modbus+ Route column.
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l These values must be valid or an error will occur and the configuration will not ac-
cept the entered value. To find more information about the error, move the mouse
pointer over the icon. A tooltip appears, indicating the source of the problem
and the accepted values.

l For more information on route mapping, please consult the Modicon Modbus Plus
Network BM85 Bridge Multiplexer User's Guide (890 USE 103 00) Rev. 1.0 or the
device's configuration application.

1 74 CEV 300 10 CONFIGURATION PROPERTIES

The 174 CEV 300 10 Modbus to Ethernet Bridge can be used to connect TCP/IP net-

work devices to Modbus network devices. The 174 CEV 300 10 Configuration Properties

appear when you select a 174 CEV 300 10 link device from the Device List. See the 174

CEV 300 10 Modicon TSX Momentum Modbus to Ethernet Bridge User Guide (890 USE 155 00)

for more information about configuring this device.

After adding a new 174 CEV 300 10 device, the following configuration properties appear

below the Device List:
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To configure communication ports for the 174 CEV 300 10 device:

1. In the IP Address text box, set the TCP/IP port address. This address should
already be set on the device itself.

2. Change the default port settings for the TCP/IP port by clicking Port Settings.
The Port Settings dialog box appears.

l TCP Port – IP Port protocol number. Any unique whole number can be used.
The default value is 502.

l Response T.O. –specifies the amount of time, in seconds that the software
waits for a response from the PLC before returning a time-out error. Any whole
number from 1 – 25 can be used. The default value is 3.

l Retries – specifies the number of times the software will try to re-establish
communications with the PLC after a time-out error. Any whole number from
0 – 10 can be used. Use 0 for no retries.

3. In the Connected to Network list, select the network the port connects to. If you
do not see the correct network listed, verify that the network has been created and
exists under the proper protocol. See Network Tree for more information.

4. In the Modbus Address box, set the Modbus addresses. This address should
already be set on the device itself.

5. Change the default port settings for the Modbus port by clicking Port Settings.
The Port Settings dialog box appears.
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l Protocol –Specifies the transmission mode. The communications mode
toggles between RTU (default) and ASCII.

l Response T.O. – Specifies the amount of time, in seconds that the software
waits for a response from the PLC before returning a time-out error. Any whole
number between 1 – 25 can be used.

l Retries – Specifies the number of times the software will try to re-establish
communications with the PLC after a time-out error. Any whole number
between 0 – 10 can be used. Use 0 for no retries.

l Baud Rate –The rate of communications between the computer and modem.
(default: 9600).

l Parity – Specifies a parity bit for error detection. Can be set to EVEN, ODD,
or NONE. (default: Even).

l Stop Bits – Specifies the number of stop bits per transmission as either 1 or 2.
(default: 1).

l BM85 Network – Select NO if you are not communicating via a BM85
Bridge/MUX or modem. Select YES to set a two-minute response timeout for
applications using a Bridge/MUX or modem.
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l Dial Modem – Select when the selected form of serial communications is
through a modem. The modem parameters must be set to exactly the same com-
munication parameters that you will use.

l Telephone Dialing – Specifies which type of dialing to use. Specify pulse di-
aling only if this is the only type your phone line supports. The
communications mode toggles between Tone (default) and Pulse.

l Initialization Command – The initialization commands sent to the modem.
Consult your modem manual for a list of appropriate commands.

l Number to Dial – Specifies the phone number to be dialed.

6. If this port is connected to a Modbus slave device, select the Connected to Slave
Device check box. Enter the Modbus slave address for the device in the Slave Ad-
dress box. This address should already be configured on the device itself.

7. In the Connected to Network list for the Modbus port, select the network the
port connects to. If you do not see the correct network listed, verify that the net-
work has been created and exists under the proper protocol. See Network Tree for
more information.

8. If you have not already done so, rename the device by typing a unique name in the
Name box.

9. Configure network mappings for the device by selecting the Modbus to TCP/IP
Mappings tab. The Modbus to TCP/IP Mapping Table appears.

l For each configurable route, enter the Modbus Start and End Ranges in their re-
spective columns, and the corresponding slave IP address under the Slave IP
Address column.

l These values must be valid or an error will occur and the configuration will not ac-
cept the entered value. To find more information about the error, move the mouse

- 163 -



FTVersionTrak User Guide
Chapter 5 – Administrator Guide • Modicon Network Set Up

pointer over the icon. A tooltip appears, indicating the source of the problem
and the accepted values.

For more information on route mapping please consult the 174 CEV 300 10 Modicon TSX

Momentum Modbus to Ethernet Bridge User Guide (890 USE 155 00) or the device's con-

figuration application.

1 74 CEV 200 30 CONFIGURATION PROPERTIES

The 174 CEV 200 30 Modbus Plus to Ethernet Bridge can be used to connect TCP/IP

network devices to Modbus Plus network devices. The 174 CEV 200 30 Configuration

Properties appear when you select a 174 CEV 200 30 link device from the Device List.

See the 174 CEV 200 30 Modicon TSX Momentum Modbus Plus to Ethernet Bridge User Guide

(890 USE 151 00) for more information about configuring this device.

After adding a new 174 CEV 200 30 device, the following configuration properties appear

below the Device List:

To configure communication ports for the 174 CEV 200 30 device:

1. Set the TCP/IP port address in the IP Addressbox. This address should already be
set on the device itself.
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2. Change the default port settings for the TCP/IP port by clicking Port Settings.
The Port Settings dialog box appears.

l TCP Port – IP Port protocol number. Any unique whole number can be used.
The default value is 502.

l Response T.O. –Specifies the amount of time, in seconds that the software
waits for a response from the PLC before returning a time-out error. Any whole
number from 1 – 25 can be used (default: 3).

l Retries – Specifies the number of times the software will try to re-establish com-
munications with the PLC after a time-out error. Any whole number from 0 – 10
can be used. Use 0 for no retries.

3. In the Connected to Network list for the Ethernet (TCP/IP) port, select the net-
work that the port connects to. If you do not see the correct network listed, verify
that the network has been created and exists under the proper protocol. See Net-
work Tree for more information.

4. Set the Modbus Plus addresses in the Modbus+ Address box. This address should
already be set on the device itself.

5. Change the default port settings for the Modbus+ port by clicking Port Settings.
The Port Settings dialog box appears.
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l Response T.O. – Specifies the amount of time, in seconds that the software
waits for a response from the PLC before returning a time-out error. Any whole
number from 1 – 25 can be used.

l BM85 Network – Select NO if you are not communicating via a BM85
Bridge/MUX or modem. Select YES to set a two-minute response timeout for ap-
plications using a Bridge/MUX or modem.

l Retries – Specifies the number of times the software will try to re-establish com-
munications with the PLC after a time-out error. Any whole number from 0 – 10
can be used. Use 0 for no retries.

6. In the Connected to Network list for the Modbus+ port, select the network that
the port connects to. If you do not see the correct network listed, verify that the
network has been created and exists under the proper protocol. See Network Tree
for more information.

7. If you have not already done so, rename the device by typing a unique name in the
Name box.

8. Configure network mappings for the device by first selecting the MB+ to Ethernet
tab. The Modbus Plus to TCP/IP Mapping Table appears.

l For each configurable route, enter the Destination Index under the Destination
Index column, and the corresponding IP address under the IP Address column.

l These values must be valid or an error will occur and the configuration will not ac-
cept the entered value. To find more information about the error, move the mouse
pointer over the icon. A tooltip appears, indicating the source of the problem
and the accepted values.
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9. Configure the TCP/IP to Modbus Plus mappings by selecting the Ethernet to
Modbus+ tab. The TCP/IP to Modbus Plus Mapping Table appears.

l Foreachconfigurable route, enter the Destination Indexunder theDestination In-
dex column, and the corresponding5-byte Modbus Plus route under theModbus+
Route column. These values must be validoranerrorwill occurand the configuration
will not accept the enteredvalue. Formore informationonroute mappingplease con-
sult the 174CEV200 30ModiconTSXMomentum Modbus Plus toEthernetBridgeUser
Guide (890USE151 00)orthe device's configurationapplication.

1 74 CEV 200 40 CONFIGURATION PROPERTIES

The 174 CEV 200 40 Modbus Plus to Ethernet Bridge can be used to connect TCP/IP

network devices to Modbus Plus network devices, with more advanced capabilities than

the 174 CEV 200 30 device, such as dynamic routing and address filtering. The 174 CEV

200 40 Configuration Properties appear when you select a 174 CEV 200 40 link device

from the Device List. See the Modbus Plus to Ethernet Bridge 174 CEV 200 40 User Guide

(890 USE 191 00) for more information about configuring this device.

After adding a new 174 CEV 200 40 device, the following configuration properties appear

below the Device List:

To configure communication ports for the 174 CEV 200 40 device:

- 167 -



FTVersionTrak User Guide
Chapter 5 – Administrator Guide • Modicon Network Set Up

1. Set the TCP/IP port address in the IP Address box. This address should already be
set on the device itself.

2. Change the default port settings for the TCP/IP port by clicking Port Settings.
The Port Settings dialog box appears.

l TCP Port – IP Port protocol number. Any unique whole number can be used.
The default value is 502.

l Response T.O. –Specifies the amount of time, in seconds that the software
waits for a response from the PLC before returning a time-out error. Any whole
number from 1 – 25 can be used. The default value is 3.

l Retries – Specifies the number of times the software will try to re-establish
communications with the PLC after a time-out error. Any whole number from
0 – 10 can be used. Use 0 for no retries.

3. In the Connected to Network list for the Ethernet (TCP/IP) Port, select the net-
work that the port connects to. If you do not see the correct network listed, verify
that the network has been created and exists under the proper protocol. See Net-
work Tree for more information.

4. Set the Modbus+ address in the Modbus+ Address box. This address should
already be set on the device itself.

5. Change the default port settings for the Modbus+ port by clicking Port Settings.
The Port Settings dialog box appears.
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l Response T.O. – Specifies the amount of time, in seconds that the software
waits for a response from the PLC before returning a time-out error. Any whole
number between 1 – 25 can be used.

l BM85 Network – Select NO if you are not communicating via a BM85
Bridge/MUX or modem. Select YES to set a two-minute response timeout for ap-
plications using a Bridge/MUX or modem.

l Retries – Specifies the number of times the software will try to re-establish com-
munications with the PLC after a time-out error. Any whole number from 0 – 10
can be used. Use 0 for no retries.

6. In the Connected to Network list for the Modbus+ Port, select the network that
the port connects to. If you do not see the correct network listed, verify that the
network has been created and exists under the proper protocol. See Network Tree
for more information.

7. If you have not already done so, rename the device by typing a unique name in the
Name box.

8. Configure network mappings for the device by clicking the MB+ to Ethernet tab.
The Modbus Plus to TCP/IP Mapping Table appears.
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l For each configurable route, enter the following under their respective columns:

n Slave Path

n Address Filter

n IP Address

n Destination Index

These values must be valid or an error will occur and the configuration will not accept the

entered value. To find more information about the error, move the mouse pointer over the
icon. A tooltip appears, indicating the source of the problem and the accepted values.

9. Configure the TCP/IP to Modbus Plus mappings by clicking the Ethernet to Mod-
bus+ tab. The TCP/IP to Modbus Plus Mapping Table appears.
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l For each configurable route, enter the following under their respective columns:

n Destination Index

n IP Address

n Modbus+ Address

For more information on route mapping please consult the Modbus Plus to Ethernet Bridge

174 CEV 200 40 User Guide (890 USE 191 00) or the device's configuration application.

MBX BRIDGE CONFIGURATION PROPERTIES

The Cyberlogic® MBX® Bridge is a software-based link device that can be used to con-

nect any combination of Modbus, Modbus Plus, and TCP/IP networks. The MBX Bridge

Configuration Properties appear when you select a MBX Bridge link device from the

Device List. See the MBX® Bridge Helpmanual for more information about configuring this

device.

After adding a new MBX Bridge device, the following configuration properties appear be-

low the Device List:
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To configure communication ports for the MBX Bridge device:

1. For each configured port, enter a Device ID in the Device ID column to identify
the port.

2. In the Network Type column, select the type of network (MB, MB+, or TCP/IP)
for the type connection being made.

3. Enter the Node Address of the connecting device in the Node Address column.

4. In the Connected to Network list for the selected port, select the network that
the port connects to. If you do not see the correct network listed, verify that the
network has been created and exists under the proper protocol. See Network Tree
for more information.

5. Click Settings in the Port Settings column to change the default port settings for
the selected port.

Depending on the type of network selected, the available port settings may differ.

For TCP/IP port settings:
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l TCP Port – IP Port protocol number. Any unique whole number can be used
(default: 502).

l Response T.O. – Specifies the amount of time, in seconds that the software
waits for a response from the PLC before returning a time-out error. Any whole
number from 1 – 25 can be used. The default value is 3.

l Retries – Specifies the number of times the software will try to re-establish com-
munications with the PLC after a time-out error. Any whole number from 0 – 10
can be used. Use 0 for no retries.

For Modbus Plus port settings:

l Response T.O. – Specifies the amount of time, in seconds that the software
waits for a response from the PLC before returning a time-out error. Any whole
number between 1 – 25 can be used.

l BM85 Network – Select NO if you are not communicating via a BM85
Bridge/MUX or modem. Select YES to set a two-minute response timeout for
applications using a Bridge/MUX or modem.

l Retries – Specifies the number of times the software will try to re-establish com-
munications with the PLC after a time-out error. Any whole number from 0 – 10
can be used. Use 0 for no retries.
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For Modbus port settings:

l Protocol –Specifies the transmission mode. The communications mode toggles
between RTU (default) and ASCII.

l Response T.O. – Specifies the amount of time, in seconds that the software
waits for a response from the PLC before returning a time-out error. Any whole
number from 1 – 25 can be used.

l Retries – Specifies the number of times the software will try to re-establish com-
munications with the PLC after a time-out error. Any whole number between 0 –
10 can be used. Use 0 for no retries.

l Baud Rate – The rate of communications between the computer and modem.
Default value is 9600.

l Parity – Specifies a parity bit for error detection. Can be set to EVEN, ODD,
or NONE. Default value is EVEN.

l Stop Bits – Specifies the number of stop bits per transmission as either 1 or 2.
Default value is 1.
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l BM85 Network – Select NO if you are not communicating via a BM85
Bridge/MUX or modem. Select YES to set a two-minute response timeout for
applications using a Bridge/MUX or modem.

l Dial Modem – Select when serial communications is through a modem. The mo-
dem parameters must be set to exactly the same communication parameters that
you will use. 

l Telephone Dialing – Specifies which type of dialing to use. Specify pulse di-
aling only if this is the only type your phone line supports. The communications
mode toggles between Tone (default) and Pulse.

l Initialization Command – The initialization commands sent to the modem.
Consult your modem manual for a list of appropriate commands.

l Number to Dial – Specifies the phone number to be dialed.

6. If you have not already done so, rename the device by typing a unique name in the
Name box.

7. Configure network mappings for the device by clicking the Mappings tab. The
MBX Bridge Mapping Table appears.

For each configurable route, enter the following:

l Source Device ID

l Slave Path
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l Source Filter

l Destination Device ID

l Network Type

l Destination Routing

These values must be valid or an error will occur and the configuration will not accept the

entered value. To find more information about the error, move the mouse pointer over the
icon. A tooltip appears, indicating the source of the problem and the accepted values.

For more information on route mapping please consult the MBX® Bridge Help manual or

the device's configuration application.

Working with Network Setup

AddingNetworks andDevices

Modicon Network Setup stores configuration information for network devices such as com-

puters, PLCs, and network link devices. Computers and PLCs are connected together via a

shared network protocol, such as Modbus, Modbus Plus, and TCP/IP. In Modicon Net-

work Setup, the connected devices that share a common network protocol are members of

a single network. These networks can be connected together via a network link device,

which acts a member of both adjoined networks.

Before adding networks and devices to Modicon Network Setup, it is a good idea to map

out your Modicon network, so that the relationships between your network devices, and

the protocols with which they are communicating, are clearly seen. This step may have

been done during the initial planning of your Modicon network. If so, your planning doc-

ument(s) will be of great use when configuring Modicon Network Setup. If not, the

Modicon Modbus Plus Network Planning and Installation Guide (890 USE 100 00) contains com-

prehensive information regarding network planning, as well as worksheets that allow you to

create a visual map of your network.

Once you have created a map of your network, you may begin adding network components

to Modicon Network Setup. Start by adding networks to your setup configuration.
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TOADDNETWORKS TO THECONFIGURATION:

1. On the Network Setup Toolbar, click New, point to Network, and then select the
appropriate network protocol:

l Modbus

l Modbus Plus

l TCP/IP

Alternatively, you can right-click a network protocol in the Network Tree, point to New

on the shortcut menu, and then click Network on the shortcut menu.

The new network appears in the Network Tree below the selected network type.

2. By default, the network is named New Network. Enter a unique name for the network
so that it can be easily identified. For example, if you are adding a TCP/IP network
that represents the shared connection between all of your computers, you might call
the network Company Intranet. This makes adding network member devices to the
network much easier.

3. Continue adding networks to the Network Tree until all networks have been added.
In the following example, four networks have been added:

l Company Intranet – a TCP/IP network that connects each computer to each
other.

l Main Bus – a Modbus Plus network that most of the company's PLCs are con-
nected to.
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l MB East and MB West – two Modbus networks that connect older PLCs to
the Main Bus and directly to specific computers.

After adding the networks, each network device must be added to the configuration. To

add devices to the configuration:

Click New from the Network Setup Toolbar, then click the type of device you want to

add:

l Computer

l PLC

l Link Device

If adding a link device, click the type of link device to add:

l BP85 Modbus Plus Bridge

l BM85 Modbus Plus Bridge Multiplexer

l 174 CEV 300 10 Modbus to Ethernet Bridge

l 174 CEV 200 30 Modbus Plus to Ethernet Bridge

l 174 CEV 200 40 Modbus Plus to Ethernet Bridge

l Cyberlogic® MBX® Bridge

SavingYour Network Configuration

While you are creating and editing your network configuration in Modicon Network Setup,

the changes that are made will not be used until the configuration is saved. After saving the
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configuration, it becomes the current configuration, meaning that the saved network set-

tings will be used when connecting to a PLC using FTVersionTrak. Otherwise, when

configuration changes have not been saved, the configuration remains in an editable state

known as the working configuration.

By clicking Save on the Network Setup Toolbar, your working configuration becomes the

current configuration, and will be used to connect to your networked PLCs.

Because FTVersionTrak is by nature a multi-user product, it is possible that more than one

user may be editing the network configuration at the same time. To prevent you from ac-

cidentally overwriting changes made by another user working concurrently on the network

configuration, FTVersionTrak will not allow you to save a network configuration if

changes were made and saved by another user while you have the Network Setup dialog

box open on your computer. If an attempt to save is made, the following message appears:

Close the Network Setup dialog box and reopen to load the latest current configuration be-

fore being able to save changes.

You may also archive the network configuration at the same time it is saved to the current

configuration by clicking Options on the Network Setup Toolbar, and then selecting the

Archive on Save option. With this option selected, every time you save your network con-

figuration, the saved configuration is archived and can be viewed in History of Network

Setup.

ArchivingNetwork Configurations

Unlike saving, which replaces the current configuration with the latest edits, archiving cre-

ates a copy of the current configuration and places it in a network setup version history,

much like the version history in the main FTVersionTrak application. Archiving can be

used to record sequential changes made to the network configuration, and provides a way

to recover older versions of the configuration without having to manage data files that can

be lost or overwritten.

Archive the current configuration by clicking Archive on the Network Setup Toolbar. You

can also archive the configuration whenever it is saved by clicking Options on the Net-

work Setup Toolbar and then selecting the Archive on Save option.
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Import / Export

Importing and exporting allows you to save and load a data file containing your network

configuration to your local computer.

TOEXPORT A NETWORK CONFIGURATION FILE:

1. Click Export on the Network Setup Toolbar. The FTVersionTrak Network Setup
Export Version dialog box appears.

2. Browse to the location in which you would like to save the configuration file.

3. The default filename for the configurationfile isFTVT.dat. Click Save to save the con-
figurationfile with this name. Torename the file, type anew name in the File name box
andclick Savewhenfinished. The configuration file is successfully exported.

TO IMPORT AN EXPORTED CONFIGURATION FILE INTONETWORK SETUP:

1. Click Import on the Network Setup Toolbar. The FTVersionTrak Network Setup
Import Version dialog box appears.
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2. Browse to the location in which you saved an exported configuration file.

3. Select the file and then click Open. The following message appears:

4. Click Yes to save the your changes to the current configuration before importing.
Click No to overwrite changes made to the configuration and complete the import.

5. After the import has been completed, click Save on the Network Setup Toolbar
to save the imported configuration.
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History of Network Setup

The Network Setup History is a list of all archived copies of the network configuration,

along with their associated version number, the name and location of the user who

archived the copy, and the date and time the configuration was archived. Much like the ver-

sion history in the main FTVersionTrak application, the History of Network Setup dialog

box can be used to compare archived copies, save specific archived versions to a local com-

puter, rollback to earlier archived configurations, or view a report of the archive history.

TOVIEW THEHISTORY OF YOURNETWORK SETUP CONFIGURATION:

1. Click History on the Network Setup Toolbar. The History of Network Setup dia-
log box appears.

2. From within the History of Network Setup dialog box, a variety of actions may be
performed:

n Compare –Compares two archived network configurations.

n Get – Similar to Export; saves a copy of a selected network configuration to the
local machine.

n Rollback – Replaces the current configuration with the selected archived copy,
destroying all archived versions newer than the one selected.

n Report – Generates the History of Network Setup Report.
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ComparingConfigurations

Similar to the Compare functionality of the mainFTVersionTrak application, ModiconNet-

work Setupcanprovide adetailedcomparisonbetweenarchivedconfigurations, current

configurations, orexported local copies ofnetwork configurations. These comparisons high-

light the similarities anddifferences betweendifferent versions ofyournetwork configuration.

TOCOMPARE VERSIONS OF THENETWORK SETUP CONFIGURATION:

1. Click Compare on the Network Setup Toolbar. The Compare Network Setup Ver-
sions dialog box appears.

2. Select which versions of the configuration to compare.

l Archived Version – All configurations that have been archived in History of
Network Setup. By default, the latest archived version is selected. Select other
archived versions by entering the version number in the box.

l Current Version – The current configuration actively being used to connect to
networked PLCs.

l Local Version – A copy of the configuration that has been exported to a file.
You must specify the path to the file by entering the path in the box or by click-

ing and browsing for the file.
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By default, the latest archived version is compared to the current version. Once you

have selected the versions to compare, click OK. The Compare Network Setup

Versions Viewer appears.

3. The Compare Network Setup Versions Viewer displays two, side-by-side windows
containing the network configuration parameters of each selected version. The se-
lected version is identified above its respective window. The viewer window
displays three types of comparison criteria:

l Match – Displayed with a white background by default, this indicates that the
configuration parameters are the same for both versions.

l Deletion – Displayed with a blue background by default, this indicates that the
second version is missing configuration parameters that the first version con-
tains, suggesting that the information has been deleted.

l Insertion – Displayed with a yellow background by default, this indicates that
the first version is missing configuration parameters that the second version con-
tains, suggesting that the information has been added.

4. Change the viewer's default colors by clicking Choose Color. The Choose Colors
dialog box appears.
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l Change the color of each comparison criteria's background and foreground by click-
ing Change.

l Click Default to revert back to default colors.

l Click OK to accept the selected colors.

5. Generate a Compare Network Setup Report by clicking Generate Report.

Network SetupReports

INTROCUTION TONETWORK SETUPREPORTS

Modicon Network Setup comes with a variety of powerful and informative reports that

help make network setup and connectivity troubleshooting easier. Four different types of

reports give you a clear picture of you network setup configuration. These reports include:

n Network Setup History Report

n Network Setup Report
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n Compare Network Setup Report

n Network Setup PLC Assignment Report

See Generating Reports for more information about FTVersionTrak reporting options and

capabilities.

NETWORK SETUPHISTORYREPORT

This report displays a list of archived versions of the network configuration.

To generate this report:

1. From the Network Setup dialog box, click History on the Network Setup Toolbar.
The History of Network Setup dialog box appears.

2. ClickReport. The FTVersionTrak Network Setup History Report dialogboxappears.
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3. Under Include, select which items to include in the report header.

l Author – Include an author name in the report header.

l Date – Include the date and time the report was generated in the report header.

l Server and Database – Include the name of the server and the repository that
the report was generated from in the report header.

l Headers – Include header names of the reported data in a column structure.

4. Enter an optional comment to attach to the report in the Comment box.

5. Under Data to report, select which data to include in the report. Click As dis-
played to include all data in the report. Click Select data to report to select which
data to include from the list below:

l Version –The version number of each archived configuration, with newer ver-
sions listed first.

l Username – The username and location responsible for creating the archived
configuration.

l Date – The date each archived configuration was created.

6. Select the format of the report to generate from the buttons on the right side of the
FTVersionTrak Network History Setup Report dialog box:

l View – Opens the report as a *.TXT file in Microsoft Notepad.

l Save – Opens a Save As dialog box to save the report as a *.TXT file.

l Print – Opens a Print dialog to send the report to a printer.

l Copy –Copies the file toWindows Clipboard tobe inserted intoanotherdocument.

NETWORK SETUPREPORT

This report is a text report of the configured connection methods saved within Modicon

Network Setup.
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To generate this report:

1. From the Network Setup dialog box, click Network Report on the Network Setup
Toolbar. The FTVersionTrak Network Setup Report dialog box appears.

2. Under Include, select which items to include in the report header.

l Author – Include an author name in the report header.

l Date – Include the date and time the report was generated in the report
header.

l Server and Database – Include the name of the server and the repository that
the report was generated from in the report header.

l Headers – Include header names of the reported data in a column structure.

3. Enter an optional comment to attach to the report in the Comment box.

4. Under Data to report, select which data to include in the report. Click As displayed
to include all data in the report . Click Select data to report to select which data to
include from the list below:

l Device Name –The name of the network device as it appears in the Device
List.

l Network –The name of the network to which the listed device belongs, as lis-
ted in the Network Tree.

- 188 -



FTVersionTrak User Guide
Chapter 5 – Administrator Guide • Modicon Network Set Up

l Protocol –The network protocol (Modbus, Modbus Plus, TCP/IP).

l Value – The configuration parameters associated with the device.

5. Select the format of the report to generate from the buttons on the right side of the
FTVersionTrak Network Setup Report dialog box:

l View – Opens the report as a *.TXT file in Microsoft Notepad.

l Save – Opens a Save As dialog box to save the report as a *.TXT file.

l Print – Opens a Print dialog box to send the report to a printer.

l Copy –Copies the file toWindows Clipboard tobe inserted intoanotherdoc-
ument.

COMPARENETWORK SETUPREPORT

This report is a text report of the result of comparing network configurations.

To generate this report:

1. From the Network Setup dialog box, click Compare on the Network Setup Tool-
bar. The Compare Network Setup Versions dialog box appears.

2. Compare two network configurations. See Comparing Configurations for more in-
formation. The Compare Network Setup Versions Viewer appears.
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3. Click Generate Report on the Viewer toolbar. The Compare Network Setup Ver-
sions Report dialog box appears.

4. Under Include, select which items to include in the report header.

l Author – Include an author name in the report header.

l Date – Include the date and time the report was generated in the report
header.

l Server and Database – Include the name of the server and the repository that
the report was generated from in the report header.

l Headers – Include header names of the reported data in a column structure.
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5. Enter an optional comment to attach to the report in the Comment box.

6. Under Data to report, select which data to include in the report. Click As dis-
played to include all data in the report or click Select data to report to select
which data to include from the list below:

l Show Different Only – only display differences in the report.

l Compare Result –the result of the network configuration comparison.

l Device Type – the type of device listed (computer, PLC, link device).

l Device – the name of the network device as it appears in the Device List.

l Network Type – the network protocol (Modbus, Modbus Plus, TCP/IP).

l Network – the name of the network as listed in the Network Tree.

l Method – the configuration parameters associated with the device.

7. Select the format of the report to generate from the buttons on the right side of the
Compare Network Setup Versions Report dialog box:

l View – Opens the report as a *.TXT file in Microsoft Notepad.

l Save – Opens a Save As dialog box to save the report as a *.TXT file.

l Print – Opens a Print dialog box to send the report to a printer.

l Copy –Copies the file toWindows Clipboard tobe inserted intoanotherdoc-
ument.

NETWORK SETUPPLCASSIGNMENTREPORT

This report lists the PLCs that have been configured in Network Setup, and the WorkShop

program files assigned to them.

To generate this report:

1. From the Network Setup dialog box, click PLC Report on the Network Setup
Toolbar. The FTVersionTrak Network Setup PLC Assignment Report dialog box
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appears.

2. Under Include, select which items to include in the report header.

l Author – Include an author name in the report header.

l Date – Include the date and time the report was generated in the report header.

l Server and Database – Include the name of the server and the repository that
the report was generated from in the report header.

l Headers – Include header names of the reported data in a column structure.

3. Enter an optional comment to attach to the report in the Comment box.

4. Under Data to report, select which data to include in the report. Click As displayed
to include all data in the report or click Select data to report to select which data
to include from the list below:

l File – the WorkShop program file name.

5. Select the format of the report to generate from the buttons on the right side of the
FTVersionTrak Network Setup PLC Assignment Report dialog box:
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l View – Opens the report as a *.TXT file in Microsoft Notepad.

l Save – Opens a Save As dialog box to save the report as a *.TXT file.

l Print – Opens a Print dialog box to send the report to a printer.

l Copy –Copies the file toWindows Clipboard tobe inserted intoanotherdocument.

Assigning and Connecting to PLCs

AssigningandConnectingtoPLCsOverview

Once network setup is complete, you can assign your Modicon WorkShop program files to

specific PLCs on your network. When these program files are viewed or edited in FTVer-

sionTrak, the network configuration finds each possible way to connect to the destination

PLC from the originating computer. In this way, any computer on the network can auto-

matically connect to any PLCs on the network, without having to set different

communication parameters on every machine or change them to connect to another PLC.

AssigningPLCs

To assign WorkShop program files to connect to specific PLCs:

1. In the FTVersionTrak File List, right-click the file(s) you want toassign toPLCs and
thenclickAssignPLC fromthe shortcut menu. The Assign PLCdialogboxappears.
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2. The selected files are listed in the Program column. In the Destination list, select
the PLC you wish to assign to the file.

3. Repeat steps 1 and 2 for each program file in the Program column.

4. If you want to assign multiple program files to the same PLC, select more than one
file in the Program column. Or, click Select all to select all program files. Then, in
the Apply to All Selected list, click the PLC you want to assign to the selected pro-
gram files.

5. Click Reset to remove all assignments, or click OK to accept and continue. When
the assigned program files are edited or viewed in FTVersionTrak, they will attempt
to connect to the selected PLC.

Choosinga Connection

After assigning PLCs to WorkShop program files, users can connect to the assigned PLCs

whenever they edit or view the file from within FTVersionTrak.

To connect to an assigned PLC:

1. Select the program file in the FTVersionTrak File List and click View File on the
Edit menu, or right-click the program file and then click View File or Edit File
from the shortcut menu. The Choose Connection dialog box appears.

2. Modicon Network Setup will find every possible communications path between the
originating computer and the destination PLC. Each available path will be displayed
in the menu of the Choose Connection dialog box. Select the path you want to use
and then click OK to connect using the selected method.

NOTE: If the selected communication path successfully

connects to the PLC, the next time you attempt to connect

using this method will result in the successful path being dis-

played by default in the Choose Connection dialog box. If

the selected path is unsuccessful, it will be removed from

the list.
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Email Notifications

Introduction to Email Notifications

FTVersionTrak can be configured to automatically send Email messages to users at the con-

clusion of certain events. For instance, when a repository folder is renamed or a repository

file is checked out, Email messages can be sent to repository users. These messages, also

known as the notifications, will provide users with detailed information about the events.

For instance, the messages can contain the name of the user who checked out the file or

the time when the folder was renamed.

Email notifications can also be associated with scheduled tasks. When events related to

scheduled tasks are completed, Email messages are sent to the specified users.

ConfiguringEmail Service

l Some configuration is required before Email notifications can be used. For ad-
ditional information, see Introducing Email Service Setup.

Notifications for Files andFolders

l See Notification Events for Files and Folders for a list of file- and folder-related
events for which a user can receive notification.

l See Attach Notifications to Files for detailed instructions on how to attach, or en-
able, notifications for files.

l See Attach Notifications to Folders for detailed instructions on how to attach, or
enable, notifications for a folder.

Notifications for ScheduledTasks

l Email Notifications related to scheduled tasks can be assigned when the scheduled
task is created. The creator of the scheduled task determines which repository
users will receive notifications. See Attach Notifications to Scheduled Tasks for
additional information.
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Email Service Setup

IntroducingEmail ServiceSetup

In order to use notifications, the following items must be set up and configured within

FTVersionTrak:

l Configuration information about the Email server used to send the messages.
See Email Server Configuration for more information about entering the Email
server information. 

l Information about the email accounts of repository users.
See Email Accounts Configuration for more information about configuring the
Email accounts of repository users.

l (optional): Mailing lists.
See Mailing Lists Configuration for information about setting up mailing lists
within FTVersionTrak.

l Email templates.
Email templates define the type of event that requires notification, the specific
event which will trigger the notification, who will receive the notification, and the
content of the message. Many default templates are included with FTVersionTrak.
These templates can be modified, or you can create your own templates. See
Email Templates Configuration for more information about setting up Email tem-
plates.

Email Server Configuration

In order to use Email notifications, information about how the Email server is configured

must be entered within FTVersionTrak. If you do not know the correct settings, contact

your network administrator or IT staff for help.

Do the following to enter information about the Email server:

1. Click Email Service Setup on the Tools menu.
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2. On the Server Configuration tab, enter the following information:

l In the SMTP Server box, enter the name of the mail server you want to use.

l In the Port box, enter the port used by the mail server.

l To use SSL, select the Use SSL check box.

3. If the mail server requires authentication, do the following:

l Select the Server Requires Authentication check box.

l In the Name box, enter the Name required for server authentication.

l In the Password box, enter the password associated with that account.

4. Under User Email Sender, in the User box click the user account that will be
used to send the notification messages. (The notification messages will be sent from
this user's account).

NOTE: The Email Address box is automatically con-

figured to use the email address associated with the User.
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5. To send a test email message, click Send Test Email, then enter the email address
of the recipient for the test message.

6. Click Save.

Email AccountsConfiguration

For each registry user, you can specify the following settings related to Email notifications:

l Name: How the user's name will be displayed in the To: field of the Email mes-
sage.

l Address: The email address associated with that user.

l Enabled: Whether the user is enabled to receive email notifications.

Do the following to enter information about the Email accounts:

1. Click Email Service Setup on the Tools menu.

2. Click the Email Accounts tab.

3. If you want a user to have the ability to receive email notifications, select the En-
abled check box.

4. In the Name column, enter how you want the user's name to be appear in the To:
field of the email message.

5. In the Address box, enter the email address that will be used to send notifications
to that user.

6. Click Save.
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MailingListsConfiguration

A mailing list is a list of users. When you need to specify which users will receive Email no-

tification, you can select the users individually, or you can select a pre-configured mailing

list. When you configure a mailing list, you give the mailing list a name and specify which

users are included in the list.

Do the following to configure a mailing list:

1. Click Email Service Setup on the Tools menu.

2. Click the Mailing Lists tab.

3. Click New.

4. In the List Name box, enter the name you want to use for this mailing list.

5. In the Non-Members area, select the users you want to be members of the mailing
list, and then click Add.

6. Click Save.
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Email TemplatesConfiguration

An Email template is group of settings that determine how email notifications will operate.

The Email template specifies the type of notification, the notification event which will trig-

ger the notification, the priority of the notification, and the message text contained in the

notification. There is one default template provided for each notification event (see Restor-

ing Default Email Templates for additional information).

When users want to receive notifications for events related to a file or a folder, they must

select which template they want to use. Users who create scheduled tasks are also able to

choose which template to use when setting up notifications for scheduled tasks.

If you want to change a template, you can modify the default templates, or you can create

new templates. Do the following to create a new Email template:

1. Click Email Service Setup on the Tools menu.

2. Click the Email Templates tab.

3. In the Notification Type box, select the type of notification you want to create.
You can select from the following notification types:

l Tasks – notification will be sent at the conclusion of actions related to a sched-
uled task
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l Folder – notification will be sent at the conclusion of actions performed at the
folder level

l File – notification will be sent at the conclusion of actions performed at the file
level

l Version – notification will be sent at the conclusion of events related to the ver-
sion of a file

4. Under Notification Events, select the event that will trigger the notification. In
the example, the notification event is Rename file. This means that email messages
will be sent after a file has been renamed.

5. Click New.

A default name for the template, such as Rename file 0, is supplied in the Name
box.

6. If you want to change the name, select the default name that appears in the Name
box and enter a new name.

7. In the Priority box, select the priority you want to use. Messages sent using this
template will reflect this priority level.

8. In the Subject box, enter the text you want to appear as the subject of the messages
sent using this template.

9. To enable this notification, select the Enabled check box.

10. Under Message Text, compose the content of the message.

l You can type text in the box.

l You can also include variables from the blue-shaded area by selecting the variable
you want to use, then clicking Place. The variable is added to the message at the
position of the cursor. For example, to include the date and time an event oc-
curred in a message, click Date Time in the blue-shaded area, and then click
Place.

11. Click Save.
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RestoringDefault Email Templates

FTVersionTrak comes with default Email templates. One template is provided for each no-

tification event. If you modify a default template, and then later want to restore that

template to its original, default values, you can restore the template.

To restore a template:

1. Click Email Setup on the Tools menu.

2. Click the Email Templates tab.

3. Under Notification Events, click the event associated with the template you want
to return to its default state.

4. Click Restore.
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The default templates, and their settings, are listed in the following table.

Notification Type Notification Event Template Name

Task

None Task Run Without

Update

Check in Task checked In

File

Failure Task Failed To Run

Folder

Create subfolder Create Subfolder

Destroy folder Destroy Folder

Delete folder Delete Folder

Restore folder Restore Folder

Rename folder Rename Folder

Label folder Label Folder

Add file Add File To Folder

File

Delete file Delete File

Restore file Restore File

Destroy file Destroy File

Rename file Rename File

Share file Share File

Check in file Check In File

Check out file Check Out File

Undo check out

file

Undo Check Out

File

Version

Destroy Version Destroy File Ver-

sion

Sign Version Sign File Version

Label Version Label File Version
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Email Notifications for Files and Folders

NotificationEvents for Files andFolders

Once the required Email configuration steps have been completed (see Introducing Email

Service Setup for additional information), any repository user is able to set up Email no-

tification for an event related to a file or a folder in a repository.

A user can be notified of the following events related to a repository file:

l when the file is deleted

l when the file is restored

l when the file is destroyed

l when the file is renamed

l when the file is shared

l when the file is checked in

l when the file is checked out

l when a check out of the file is undone

l when a version of the file is destroyed

l when the file is signed

l when the file is labeled

A user can be notified of the following events related to a repository folder:

l when a subfolder is created

l when the folder is destroyed

l when the folder is deleted

l when the folder is restored
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l when the folder is renamed

l when the folder is relabeled

l when a file is added to the folder

AttachNotifications toFiles

The process of attaching notifications to a file consists of selecting a file (or files) and then

indicating which Email templates to use with the events related to those files.

Do the following to attach notifications to files:

1. Connect and login to the repository containing the appropriate file or files.

2. In the main FTVersionTrak window, select the file or files you want to use.

3. Do one of the following:

l Click Attach / Detach Notifications on the File menu.

l Right-click the file or files, then click Attach / Detach Notifications from the
shortcut menu.

4. In the Email Notifications window, select the template you want to use for each
event. If you do not want to be notified after an event occurs, select No no-
tification.
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NOTE: Only templates that have been created for a par-

ticular event will appear as selectable options for that event.

For example, the templates listed for the Restore file event

are templates created specifically for restoring folders. See

Email Templates Configuration for more information about

creating and modifying Email templates.

If you selected more than one file in step 2, the templates you select are applied to

all of the selected files.

5. Click OK.

NOTE: Notifications for file- and folder-related events

must be set up on an individual basis. For example, each re-

pository user who wants to be notified when a file named

WorkShop.FSS is checked in must login to FTVersionTrak

and select a template for the Check in file event associated

with WorkShop.FSS.
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Tip: You can also attach and detach notifications from the Search Results window.

DetachNotifications fromFiles

If a user no longer wants to receive notifications about file-related events, the user can de-

tach the notification. Detaching the notification consists of selecting the No Notification

option from the Template column of the Email Notifications window.

1. Connect and login to the repository containing the appropriate file or files.

2. In the main FTVersionTrak window, select the file or files you want to use.

3. Do one of the following:

l Click Attach / Detach Notifications on the File menu.

l Right-click the file or files, then click Attach / Detach Notifications from the
shortcut menu.
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4. In the Email Notifications window, select No notification for the events for
which you do not want to receive notifications.

5. Click OK.

NOTE:  Administrators are able to detach, or delete, no-

tifications using the Notifications Viewer. See Deleting

Notifications for additional information.

AttachNotifications toFolders

The process of attaching notifications to a folder consists of selecting a single folder and

then indicating which Email templates to use with the events related to that folder.
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Do the following to attach notifications to a folder:

1. Connect and login to the repository containing the appropriate folder.

2. In the main FTVersionTrak window, select the folder you want to use.

3. Do one of the following:

l Click Attach / Detach Notificationson the File menu.

l Right-click the folder, then click Attach / Detach Notifications from the short-
cut menu.

4. In the Email Notifications window, select the template you want to use for each
event. If you do not want to be notified after an event occurs, select No no-
tification.

NOTE: Only templates that have been created for a par-

ticular event will appear as selectable options for that event.

For example, the templates listed for the Destroy Folder

event are templates created specifically for destroying

folders. See Email Templates Configuration for more in-

formation about creating and modifying Email templates.
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5. Click OK.

NOTE: Notifications for file- and folder-related events

must be set up on an individual basis. For example, each

user who wants to be notified when a folder named Folder1

is deleted must login to FTVersionTrak and select a tem-

plate for the Delete folder event associated with Folder1.

DetachNotifications fromFolders

If a user no longer wants to receive notifications about folder-related events, the user can

detach the notification. Detaching the notification consists of selecting the No No-

tification option from the Template column of the Email Notifications window.

Do the following to attach notifications to a folder:

1. Connect and login to the repository containing the appropriate folder.

2. In the main FTVersionTrak window, select the folder you want to use.

3. Do one of the following:

l Click Attach / Detach Notifications on the File menu.

l Right-click the folder, then click Attach / Detach Notifications from the short-
cut menu.
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4. In the Email Notifications window, select No notification for the events for
which you do not want to receive notifications.

5. Click OK.

NOTE:  Administrators are able to detach, or delete, no-

tifications using the Notifications Viewer. See Deleting

Notifications for additional information.
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Email Notifications for Scheduled Tasks

AttachNotifications toScheduledTasks

When a scheduled task is initially created, or at any time after a task has been created, the

creator of a scheduled task has the option of attaching Email notifications to that task.

Email notifications options are specified on the bottom of the Create New Task window.

Do the following to set up Email notifications with a task:

1. Go to the Create New Task window by creating a new task or by modifying the
properties of an existing task. See Creating a New Task for more information about
tasks.

2. If Email notification options are not visible, click (Expand).

3. In the Email Notifications area, click Add.
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4. In the Email Notification window, in the Select Notification Event box, click
the notification event you want to use. You can choose to send notifications based
on one or more of the following notification events:

l None: After the task has run, no differences were found between the specified
file on the PLC and the file in the repository.

l Check in: After the task has run, differences were found between the specified
file on the PLC and the file in the repository. The file on the PLC was suc-
cessfully checked in to the repository.

l Failure: There was an error running the scheduled task.
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5. If the Attach Report check box is checked, a copy of the comparison report gen-
erated by the scheduled task will be attached to the email notification.

6. If the Attach Program check box is checked, a copy of the program from the PLC
will be attached to the email notification.

7. Under Select Notification Template, select the notification template you want to
use.

8. Under Select Notification Recipients, select the recipients and/or lists you want
to be notified at the conclusion of the notification event.
You can also click Check all or Uncheck all.

9. Click Save.

NOTE: Various settings related to the Email server and

Email accounts must be properly configured in order to use

Email notifications. See Introducing Email Service Setup for

more information.

Notifications Viewer

UsingtheNotificationsV iewer

The Notifications Viewer is only accessible by Administrators or Owners. The Viewer can

be used to view the notifications that are currently set up within FTVersionTrak. In ad-

dition, the Viewer can be used to delete notifications that are no longer needed.

OPEN THENOTIFICATIONSVIEWER

1. Click Notifications Viewer on the Tools menu to open the Notifications Viewer.

FILTERNOTIFICATIONS

There are several ways to filter how notifications are displayed in the Viewer. You can se-

lect from the following filtering methods:

l Display only the notifications associated with a specific file or folder (see
Filter Notifications by File and Filter Notifications by Folder for additional
information) 
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l Display only the notifications created by a specific repository user (see Fil-
ter Notifications by User for additional information) 

l Display only the notifications associated with a specific event (see Filter No-
tifications by Event for additional information) 

l Display only the notifications associated with files or folders whose names
contain certain characters/patterns (see Filter Notifications by Pattern for ad-
ditional information)

Notifications attached to scheduled tasks are not displayed in the Viewer.

GROUPNOTIFICATIONS

You can also specify how you want the notifications displayed in the Viewer. You can

group the notifications using the following methods:

l Group the notifications according to the name of the file / name of the
folder they are attached to

l Group the notifications according tothe repository userwhocreated the no-
tification

l Group the notifications according to the event they are associated with

l Group the notifications based on whether the notification is attached to a
file or a folder

See Group Notifications for more information on grouping notifications.

See Introduction to Notifications for more information about notifications.

DeletingNotifications

The Notifications Viewer can be used to delete notifications that are no longer wanted.

The Notifications Viewer is only accessible by Administrators or Owners. Deleting a no-

tification using the Viewer is functionally equivalent to selecting No Notification for the

template associated with a file- or folder-related event. When a notification is deleted using

the Viewer, the user will no longer receive notifications for that event.

Only notifications associated with file- or folder-related events are displayed in the Viewer.

Notifications associated with scheduled tasks are not displayed in the Viewer and cannot

be deleted using the Viewer.

To delete one or more notifications using the Viewer:
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1. Click Notifications Viewer on the Tools menu.

2. Optional: Filter or group the notifications so you can easily find the notification you
want to delete.

3. Select the notifications you want to delete.

4. Click Delete Notification.

FilteringandGroupingNotifications

FILTERNOTIFICATIONS BY FILE

To view only the notifications that are associated with a specific file:

1. On the Tools menu, click Notifications Viewer.

2. Click Filter by, then point to Attached To, and then click Specific File.

3.  In the Select Repository File window, select a file. (The Notifications Viewer will
only show notifications associated with this file.)

4. Click OK.
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FILTERNOTIFICATIONS BY FOLDER

To view only the notifications that are associated with a specific folder:

1. On the Tools menu, click Notifications Viewer.

2. Click Filter by, then point to Attached To, and then select Specific Folder.

3. In the Select Repository Folder window, select a folder. (The Notifications
Viewer will only show notifications associated with this folder.)

4. Click OK.

FILTERNOTIFICATIONS BYUSER

To view only the notifications created by a specific user:

1. On the Tools menu, click Notifications Viewer.

2. Click Filter by, and then click Created By.

3. In the Filter By User window, select a user, and then click OK. (The Notifications
Viewer will only show notifications created by this user.)

4. Click OK.

FILTERNOTIFICATIONS BYEVENT

To view only the notifications associated with a specific event, such as the check-in of a

file or the rename of a folder:

1. On the Tools menu, click Notifications Viewer.

2. Click Filter by, and then select Event.

3. In the Filter By Event window, select an event, and then click OK. (The No-
tifications Viewer will only show notifications associated with this event.)

4. Click OK.
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FILTERNOTIFICATIONS BY PATTERN

Toview only the notifications of files and/orfolders whose names match aspecific pattern:

1. On the Tools menu, click Notifications Viewer.

2. Click Filter by, and then click File/Folder Name Pattern.

3. In the Filter By File/Folder window, enter the pattern you want to use. For ex-
ample, to see only the notifications for WorkShop files, enter FSS in the Pattern
box.

4. Click OK.

REMOVE A FILTER

To remove a filter you no longer want:

1. On the Tools menu, click Notifications Viewer. 

2. Click the Filter by menu, and then click Remove Filter.

GROUPNOTIFICATIONS

By default, notifications in the Notifications Viewer are displayed in alphabetical order ac-

cording to the name of the file or the name of the folder the notification is attached to.

This default display method can be customized, however. Notifications in the No-

tifications Viewer can be arranged, or grouped, based on characteristics of the notification.

To specify how notifications are grouped within the Notifications Viewer:

1. Click Notifications Viewer on the Tools menu.

2. Click Group by, then do one of the following:

l Click Attached To to group notifications based on the name of the file or the
name of the folder.

l ClickCreated By togroupnotifications basedonthe userwhocreated the notific-
ations.

l ClickEvent togroupnotifications basedonthe event that triggered the notification.
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l Click Files / Folders to group notifications based on whether the notification is
associated with a file or folder.

In the Group by menu, a check mark is displayed before the selected Group by method.

To return to the default method, clear the check mark from Attached To, Created By,

Event, or Files / Folders.
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Security

Security Overview

FTVersionTrak controls user access and permissions with two levels of security, allowing

an administrator to configure a wide array of options from general access permissions to spe-

cific user-based interaction.

Server Security governs access to the SQL Server instance that manages and stores FTVer-

sionTrak repositories. It provides three tiers of access based on both Windows

Authentication and SQL Authentication. Server administrators can add, edit, and remove

all Windows and SQL logins that access the FTVersionTrak server.

Repository Security manages the permissions granted a repository user or group of users,

specific to each repository. It provides four tiers of access plus group-based custom per-

missions. Repository administrators can add, edit, and disable all available Windows and

SQL logins that access the repository.

NOTE: Security features are not available in FTVer-

sionTrak Pro. Only one administrator-level user is allowed

access to the repository. If your process requires that more

than one named user has access to a repository, you may

need to upgrade to the advanced edition of FTVersionTrak.

Server Security

Access Server Security 

Server Security regulates and maintains user access to FTVersionTrak databases. Ad-

ministrators define the SQL Server instance to be used as an FTVersionTrak database,

select the users that will have access to the database, and determine the method of access

allowed to each user of the database.

To access Server Security:

1. On the Tools menu, click Server Security or click the toolbar button. The
Master Login dialog box appears.
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2. Click OK. By default, Windows Authentication is selected – this is the only au-
thentication method that can be used to access Server Security.

NOTE: Only administrators may access Server Security.

After successfully logging in, the Server Security dialog box appears.

3. The Server Security dialog box displays the following information:
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l Server: Displays the server being configured.

l Accounts: Displays all configured server accounts.

Selectinga Server

1. In the Server Security dialog box, the SQL Server instance that you will be con-
figuring is displayed in the Server box. In cases in which multiple servers reside on
the same machine, clicking Browse will display a list of available servers. Select the
server you would like to configure or click Find Database Servers to search for all
accessible servers.

2. Click OK when finished to return to the Server Security dialog box.

NOTE: Clicking Find Database Servers searches for all

available servers, including servers located on remote ma-

chines. You must be logged in to Windows as an

administrator on the machine on which SQL Server is run-

ning to access Server Security.

V iewingServer Accounts

A list of all available SQL Server accounts is displayed in the Server Security dialog box.

- 222 -



FTVersionTrak User Guide
Chapter 5 – Administrator Guide • Security

Server Security supports two different types of accounts, displayed in the Account Type

column:

l Windows Login – represents a single user with a Windows login on the same
machine as SQL Server connecting via Windows Authentication.

l SQL Login – represents a single user logged in from a local or remote location
to SQL Server via SQL Authentication.

NOTE: To allow workgroup users to log in to FTVer-

sionTrak using Windows Authentication, the server

machine's Local Security Policy must be set to allow local

users to authenticate as themselves. See Setting the Local Se-

curity Policy for more information.

l Show disabled users by selecting the Show Disabled Server Accounts check
box. You may disable an account in the Edit Server User dialog box by clicking
the Edit button.

ManagingServer Accounts

ADDING USERS

To add SQL Server accounts that may access the FTVersionTrak database:

1. In the Server Security dialog box, click Add. The Add SQL Server Account dialog
box appears.
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2. In the Login Type box, select the type of login you would like to add (Windows or
SQL Authentication).

3. Configure the login you would like to add:

WINDOWSAUTHENTICATION

Type the name of the user in the Username text box or click Select to search for available

users. If you choose to search, the Select User dialog box appears.

l Type search criteria in the Enter the object name to select box, or click Ad-
vanced for more options.

l Click Find Now to search for all available logins from a single location.

l Select a login from the list and click OK.
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l Click OK when finished to return to the Add SQL Server Account dia-
log box.
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The Password and Confirm text boxes are inactive; this information is governed by Win-

dows Authentication.

NOTE: To allow workgroup users to log in to FTVer-

sionTrak using Windows Authentication, the server

machine's Local Security Policy must be set to allow local

users to authenticate as themselves. See SQL Server Setup

for more information.

SQL Authentication

l Enter the username and password of the SQL Server account you would like
to configure in their respective fields. Retype the password in the Confirm
box.

NOTE: The SQL Server instance must be configured

to accept SQL Server Authentication. See SQL Server

Setup for more information.

4. Select the Login Disabled check box to block this account's access to the FTVer-
sionTrak database.

5. Click OK when finished to return to the Server Security dialog box.

EDITING USERS

To edit SQL Server accounts that may access the FTVersionTrak database:

1. Click Edit in the Server Security dialog box. The Edit SQL Server Account dialog
box appears.
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2. Select the Login Disabled check box to block this account's access to the FTVer-
sionTrak database.

3. Click OK when finished to return to the Server Security dialog box.

Repository Security

Repository SecurityOverview

Repository security defines access permissions for each repository being protected by

FTVersionTrak. The repository administrator (usually the creator of the repository) de-

termines the users that can access a repository, as well as the level of access each user or

group of users receives. Each repository may have a different administrator, who can either

set predefined access 'levels' for each repository user, or define custom levels of security

for one or many users based on specific repository permissions.

To access Repository Security:

1. On the Tools menu, click Repository Security or click the toolbar button.
The Repository Security dialog box appears.
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ManagingRepositoryUsers

ADDINGUSERS

To add a new repository user:

1. On the Tools menu, click Repository Security or click the toolbar button.
The Repository Security dialog box appears.

2. Click Add User. The Add Repository Account dialog box appears.
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3. Select the account you would like to add and click OK. The Repository User dialog
box appears, which can be used to define the access permissions of the account.

NOTE: All accounts must first be added as SQL Server ac-

counts under Server Securitybefore they can be selected as

repository accounts.

MANAGINGUSER-LEVELACCOUNTPERMISSIONS

To define the access permissions of an individual account:

1. From the Repository Security dialog box, select the account to edit and click Edit.
The Repository User dialog box appears.
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The Access Level tab contains pre-defined access levels that can be applied to a user

quickly and conveniently. The permissions associated with these pre-defined levels are:

l Administrator

l Power Editor

l Limited Editor

l Read-Only.

See Repository Account Permissions for more information about the permissions as-

signed to each access level.

A Custom access level also exists so that repository administrators may define specific re-

pository permissions for a user or group of users. Each of these repository permissions and

their dependencies are detailed in Repository Account Permissions.

Account permissions can also be applied to a user by adding them to a repository group

that already contains a defined permission set. Adding a user to a repository group is a great

way to quickly define security levels to a large group of users with similar needs. FTVer-

sionTrak provides you with a set of default groups based on the pre-defined access levels

described earlier (Administrator, Power Editor, Limited Editor, and Read-Only).

NOTE: Repository accounts cannot be removed from

within Repository Security. Account removal may only be ac-

complished within Server Security by an authorized server

administrator. To deny an account access to a specific re-

pository, disable the account.

Individual users may also be granted specific permissions via repository group membership;

users may also be members of more than one repository group at a time. The actual set of

permissions granted to any user in a repository is therefore the sum of all permissions gran-

ted either on an individual user basis, or via membership in any repository group. The full

details of a user's group membership and permission set can be viewed in the Member Of

tab of the Repository User dialog box.

ManagingRepositoryGroups

FTVersionTrak allows administrators to grant over 80 selectable permissions in 13 dif-

ferent areas of the software to each user in a repository. This powerful set of options gives

administrators the ability to fine-tune the security policy they apply to the repositories they

manage in order to maintain the strictest control over the sensitive files they manage,
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without hindering the productivity of the users who need access to those files. However,

because of the sheer number of security options available, configuring each repository user

with a unique permission set can be cumbersome, especially if the administrator is dealing

with many, or perhaps hundreds, of users.

FTVersionTrak repository groups provide repository administrators with a simple, yet

powerful, way to manage the security policy for a large set of users with varying access

levels. With just a small amount of planning, administrators can create permissions-based

groups that can meet the needs of every type of user in the organization.

TOCREATE A REPOSITORY GROUP:

1. On the Tools menu, click Repository Security or click the toolbar button.
The Repository Security dialog box appears.

2. Click the Groups tab in the Repository Security dialog box. A list of existing re-
pository groups appears. Four pre-defined groups are provided by default:
Administrator, Power Editor, Limited Editor, and Read Only.
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3. Click New Group. The Repository Group dialog box appears.
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4. Enter a name for the group in the Group name box. Depending on your security
needs, you may want to create groups based on business unit (Maintenance, Engin-
eering, Marketing, and so on) or employee type (Contractors, Management, and so
on).

5. If you have repository users that you know will be added to the group at this time,
you may select the users from the Available Users list at the bottom of the Re-
pository Group dialog box. (You can add additional users to the group at any time.)
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NOTE: Notice that there is already a user assigned to the

group – this is the account of the repository creator, who is

also the default administrator of the repository. The re-

pository creator always has full permissions granted within

the repository, and is always a member of every repository

group. The repository owner is also by default the owner of

the repository group.

6. Click the Access Level tab at the top of the Repository Group dialog box to define
repository permissions for group members.

The Access Level tab contains pre-defined access levels that can be applied to a re-

pository group quickly and conveniently. The permissions associated with these pre-
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defined levels are Administrator, Power Editor, Limited Editor, and Read-Only. See

Repository Account Permissions for more information about the permissions assigned

to each access level.

A Custom access level also exists so that repository administrators may define specific re-

pository permissions for the repository group. Each of these repository permissions and

their dependencies are detailed in Repository Account Permissions.

NOTE: Individual users may also be granted specific per-

missions outside of group membership; users may also be

members of more than one group at a time. The actual set of

permissions granted to any user in a repository is therefore

the sum of all permissions granted either on an individual

user basis, or via membership in any repository group. The

full details of a user's group membership and permission set

can be viewed in the Member Of tab of the Repository

User dialog box.

RepositoryAccount Permissions

A repository account permission is a right to carry out an operation on or applied to a re-

source within FTVersionTrak. These rights can be granted or revoked by a repository

administrator. The following table lists all permissions that are able to be granted within Re-

pository Security by an administrator-level user. These permissions are grouped by the type

of resource associated with the permission. For example, all file-related permissions, such

as deleting, destroying, and renaming a file, are grouped under the File resource type.

Please note that many permissions require other permissions to be granted in order for the

permission to be valid. For example, nearly all permissions require the user to have the abil-

ity to connect to a repository to be valid. The user is notified when such dependencies are

required for a permission to be granted.

FTVersionTrak provides four default access levels with varying degrees of granted per-

missions: Administrator, Power Editor, Limited Editor, and Read-Only. These four

access levels serve two purposes. First, they provide a quick and simple way to assign a pre-

defined permission set to a user or group of users without having to grant each permission

manually. Second, these default access levels provide administrators of earlier versions of

FTVersionTrak a transition path to the new group-based security structure without re-

quiring a complete redesign of the existing FTVersionTrak security policy. These four

default access levels are carry-overs from previous versions of FTVersionTrak and will re-

tain existing permissions from earlier versions of the software.
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NOTE: Certain repository accounts, such as the account as-

sociated with the creator of the repository, will automatically

be set to the Administrator access level and be granted all

permissions. This account cannot be edited or deleted, to

prevent against accidental removal of all accounts with ad-

ministrative access.

Resource Type: File

Permission Description Default Access Levels

Delete File Delete a file from the repository. Administrator

Power Editor

Limited Editor

Restore File Restore a deleted file. Administrator

Power Editor

Limited Editor

Destroy File Completely remove a file from

repository. Unable to be restored.

Administrator

Power Editor

View File

Properties

View information about the file,

including the file comments and

repository location, properties of

the latest version of a file including

file comments, and check out

status.

Administrator

Power Editor

Limited Editor

Read-only

Rename File Rename file in repository location. Administrator

Power Editor

Limited Editor

Update File

Comment

Add or change file comment. Administrator

Power Editor

- 236 -



FTVersionTrak User Guide
Chapter 5 – Administrator Guide • Security

Resource Type: File

Permission Description Default Access Levels

Share File Place file in multiple repository loc-

ations.

Administrator

Power Editor

Limited Editor

Assign PLC Assign a neworked PLC to a

PLC WorkShop program file to con-

nect to.

Administrator

Power Editor

Check

Out/Check

In

Check the file in and out. Administrator

Power Editor

Limited Editor

Undo My

Own Check

Out

Remove check out status from file

you checked out without creating a

new version.

Administrator

Power Editor

Limited Editor

Undo Check

Out By Oth-

ers

Remove check out status from file

another user checked out without

creating a new version.

Administrator

Power Editor

Limited Editor

Resource Type: File Version State

Permission Description Default Access Levels

View State Access the File Version States dia-

log.

Administrator

Power Editor

Limited Editor
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Resource Type: File Version State

Permission Description Default Access Levels

Create State Create a new file version state. Administrator

Power Editor

Limited Editor

Update State

Description

Add or change the description asso-

ciated with an existing file version

state.

Administrator

Power Editor

Update Pre-

vious State

Edit a previously defined file ver-

sion state.

Administrator

Power Editor

View Sig-

nature

Requirements

Review the details of the signature

requirement.

Administrator

Power Editor

Update

Required Sig-

natures

Add or remove electronic sig-

natures required to advance a file

to a different file version state.

Administrator

Power Editor

Resource Type: Folder

Permission Description Default Access Levels

Create Folder Create a new repository folder or

subfolder

Administrator

Power Editor

Limited Editor

Destroy

Folder

Completely remove a folder from

the repository. Cannot be restored.

Administrator

Power Editor
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Resource Type: Folder

Permission Description Default Access Levels

Delete

Folder

Delete a folder from teh repository. Administrator

Power Editor

Limited Editor

Restore

Folder

Restore a deleted folder. Administrator

Power Editor

Limited Editor

View Folder

Properties

View information about the repos-

itory folder, including folder com-

ments and the number of

repository files located in the

folder.

Administrator

Power Editor

Limited Editor

Read-Only

Rename

Folder

Rename repository folder. Administrator

Power Editor

Limited Editor

Update

Folder Com-

ment

Add or change folder comment. Administrator

Power Editor

Limited Editor

View Folder

History

View a history of activity within

the repository folder

Administrator

Power Editor

Limited Editor

Read-Only
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Resource Type: Folder

Permission Description Default Access Levels

Compare

Folder

Compare the contents of one

folder to another, either in the

repository or on the local machine.

Administrator

Power Editor

Limited Editor

Read-Only

Get Folder Retrieve the contents of a repos-

itory folder to a location on the

local machine.

Administrator

Power Editor

Limited Editor

Read-Only

Label Folder Add a label to all the contents of a

repository folder.

Administrator

Power Editor

Limited Editor

Add File to

Folder

Add a file from the local machine

to the repository for the first time.

Administrator

Power Editor

Limited Editor

Resource Type: Label

Permission Description Default Access Levels

Update Label Modify an existing label. Administrator

Power Editor
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Resource Type: Log

Permission Description Default Access Levels

View Log View the contents of the activity

log.

Administrator

Power Editor

Limited Editor

Read-Only

Report Log Create a report of the contents of

the activity log.

Administrator

Power Editor

Limited Editor

Read-Only

Resource Type: Network

Permission Description Default Access Levels

View Con-

figuration

Access the Network Setup dialog. Administrator

Power Editor

Export Con-

figuration

Export an existing network con-

figuration to a file.

Administrator

Power Editor

Import Con-

figuration

Import a saved configuration into

FTVersionTrak.

Administrator

Power Editor

Save Con-

figuration

Save the active network con-

figuration parameters.

Administrator

Power Editor

Compare Con-

figuration

Compare the current configuration

to a local or archived version.

Administrator

Power Editor
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Resource Type: Network

Permission Description Default Access Levels

Report Con-

figuration

Create a report of the current net-

work configuration parameters.

Administrator

Power Editor

Report PLCs Create a report of the PLCs asso-

ciated with PLC WorkShop files in

the repository.

Administrator

Power Editor

Resource Type: Network Version

Permission Description Default Access Levels

View Net-

work History

View the history of the Network

Setup configuration.

Administrator

Power Editor

Get Network

Version

Save a version of the network con-

figuration to the local machine.

Administrator

Power Editor

Compare Net-

work Version

Compare one version of the net-

work configuration to another.

Administrator

Power Editor

Report Net-

work Version

Create a report that details the his-

tory of the network configuration.

Administrator

Power Editor

Create Net-

work Version

Create a new version of the net-

work configuration.

Administrator

Power Editor

Report Net-

work Version

Create a report that details the his-

tory of the network configuration.

Administrator

Power Editor
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Resource Type: Network Version

Permission Description Default Access Levels

Create Net-

work Version

Create a new version of the net-

work configuration.

Administrator

Power Editor

Purge Net-

work Version

Rolls back latest version of net-

work setup to selected earlier ver-

sion.

Administrator

Power Editor

Resource Type: Report

Permission Description Default Access Levels

View Report View a generated report on the

screen.

Administrator

Power Editor

Limited Editor

Read-Only

Save Report Save a copy of a generated report

to a text file.

Administrator

Power Editor

Limited Editor

Read-Only

Copy Report Copy a generated report to the Win-

dows clipboard.

Administrator

Power Editor

Limited Editor

Read-Only
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Resource Type: Report

Permission Description Default Access Levels

Print Report Send a generated report to the

printer.

Administrator

Power Editor

Limited Editor

Read-Only

Resource Type: Repository Group

Permission Description Default Access Levels

Create Group Create a security group. Administrator

Delete Group Remove a security group from the

database (cannot be recovered).

Administrator

Set Group Per-

missions

Add or remove permissions to a

security group.

Administrator

Add Group

Member

Add a repository user to a secur-

ity group.

Administrator

Delete Group

Member

Remove a repository user from a

security group.

Administrator

Enable/Disable

Group

Disable an active security group

or enable a disabled group.

Administrator

Update Owner

Status

Change the owner of a security

group to another administrator

user.

Administrator
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Resource Type: Repository

Permission Description Default Access Levels

Create Repos-

itory

Create a new repository. Administrator

Power Editor

Destroy

Repository

Completely remove a repository

from the server (cannot be

recovered).

Administrator

Power Editor

Connect to

Repository

Establish a connection to a repos-

itory.

Administrator

Power Editor

Limited Editor

Read-Only

View Repos-

itory Inform-

ation

Review information about a selec-

ted repository.

Administrator

Power Editor

Limited Editor

Read-Only

View Repos-

itory Options

Add or remove permission to view

repository options.

Administrator

Power Editor

Resource Type: Repository User

Permission Description Default Access Levels

View User Review information about a repos-

itory user.

Administrator

Add User Add a user to a repository. Administrator

Delete User Remove a user's ability to connect

to a repository.

Administrator
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Resource Type: Repository User

Permission Description Default Access Levels

Update User

Name

Change a user's login name and/or

password.

Administrator

Set User Per-

missions

Add or remove permissions to a

repository user.

Administrator

Enable/Disable

User

Disable an active repository user

or enable a disabled user.

Administrator

Resource Type: Task

Permission Description Default Access Levels

View Task View the details of a scheduled

task.

Administrator

Power Editor

Create Task Create a new scheduled task. Administrator

Power Editor

Delete Task Delete an existing scheduled task. Administrator

Power Editor

Restore Task Restore a deleted scheduled task. Administrator

Power Editor

Update Task Modify an existing scheduled task. Administrator

Power Editor

Run Task Execute a scheduled task imme-

diately.

Administrator

Power Editor
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Resource Type: Version

Permission Description Default Access Levels

Destroy Ver-

sion

Completely remove a version of a

file in the repository (cannot be

recovered).

Administrator

Power Editor

View History Review the history of a repository

file.

Administrator

Power Editor

Limited Editor

Read-Only

Update Ver-

sion Com-

ment

Add, modify, or delete a version

comment.

Administrator

Power Editor

Limited Editor

Report Ver-

sion

Create a report on a version of a

repository file.

Administrator

Power Editor

Limited Editor

Read-Only

View Con-

tents

View the contents of a multiple file

unit.

Administrator

Power Editor

Limited Editor

Read-Only

Compare Ver-

sion

Compare one version of a repos-

itory file to another.

Administrator

Power Editor

Limited Editor

Read-Only
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Resource Type: Version

Permission Description Default Access Levels

Get Version Retrieve a specific version of a file

to the local machine.

Administrator

Power Editor

Limited Editor

Sign Electronically sign a version of a

repository file.

Administrator

Power Editor

Limited Editor

Label Apply a label to a version of a

repository file.

Administrator

Power Editor

Limited Editor
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Administrative Tools

Administrative Tools Overview

Packaged with FTVersionTrak are a capable array of administrative tools to help manage

your data, including an activity log to track user actions, a task scheduler to automate up-

loading and download programs to your hardware, file and folder compare to view

differences in the repository, and comprehensive repository- and server-level security.

Activity Log

The activity log is a detailed register of actions taken by users within the FTVersionTrak re-

pository. It presents an overview account of changes made to a repository as an efficient

audit trail, including signature and file version comment information. You may filter the

activity log to view only relevant results as well as generate a report of its findings.

To view the activity log:

1. OntheViewmenu, clickActivity Log. The activity log for the active repository ap-
pears.

2. The activity log displays user activity in a read-only spreadsheet format. Each activ-
ity log contains the following information:
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l Date – The date and time of the recorded activity

l User –The username andworkstationname of the userwho initiated the activity

l Action – A tag describing the action of the logged event

l Message – A more detailed comment on the nature and location of the logged
event

3. Click a date at the top of the activity log to go directly to the activity of a selected
date.

4. Click Set Log Filter to filter the results displayed in the log.

5. Click Copy to Clipboard to copy the selected information to be pasted within an-
other application.

6. Click Generate Report to generate a printable and saveable version of the log.

Log Filter Options

The events recorded in the activity log may be filtered to show only the results you are in-

terested in. Click Set Log Filter at the top of the activity log to set these options. The Log

Filter Options dialog box appears.
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n Select the Only show log entries on or before and Only show log entries on
or after check boxes to designate a date range to filter the log results.

n Select the Only show log entries about file check box to only show the activ-
ities associated with a specific repository file.

n Select the Only show log entries from user check box to only show the activ-
ities associated with a specific repository user.

n Select the Only show log entries of the following checked actions check box
to only show activities associated with specific actions:

Managing File Version States

FTVersionTrak gives you the power to track the progress of a project by applying a file ver-

sion state to your file versions. Version states create an even more concise picture of the

evolution of a file from initial entry to finished product by tagging each version or se-

quence of versions with user-definable stages of development. Changing a file version state

or altering file state options are Repository Account Privileges that can be set by the Re-

pository Administrator.

To view and edit File Version States:

1. On the Tools menu, click Repository File States. The File Version States dialog
box appears.

2. Click New to create a new File Version State. The New File Version State dialog
box appears.
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3. Type the name of the state in the Name box. For example, to signify that a file has
been reviewed and accepted by the Project Manager, you could create a File Version
State named Approved. Enter further explanation or instruction about the state in the
Description box. Click OK when finished to return to the File Version States dia-
log box.

4. To edit the details of the state, select the state and then click Details. The File Ver-
sion State Details dialog box appears.

5. Set the details of the selected version state. Options include:
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l Description box – Create or edit the description of the state.

l Require previous state – To require a prerequisite state before transitioning
to another state, select this check box and select a state. In the following ex-
ample, a state named For Approval has been created to indicate that a file is
ready to be reviewed. To ensure that files are not approved before they are
ready, transitioning a file to an approved state requires that the file is currently
listed as For Approval.

6. Require signatures to transition to this state – To require an electronic signature
before transitioning, select this check box. See Electronic Signatures for more in-
formation. The users listed in the User box are the users who are able to sign and
authorize the transition to the new state.

l If Require any signature is selected, then any user in the User box can sign
and authorize the transition to the new state.

l If Require all signatures is selected, then all the users in the User box must
sign to authorize a transition to the new state.

7. To add a user to the User box, click Add, and then click the user you want to add
from the Add Required Signature window.
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8. To remove a user from the User box, click the user you want to remove in the
User box, and then click Remove.

FTVersionTrak Options

To access FTVersionTrak options, click Options on the Tools menu. The Options dialog

box appears.

l Select the Automatically connect to repositories with windows au-
thentication check box to permit users who use windows authentication to
automatically connect to repositories. These users will not have to log in. If you
want users to log in, clear the check box. 

l Select the Show status bar check box to show the Status Bar at the bottom of
the FTVersionTrak window. Clear the check box to hide the Status Bar. 

l Select the Show deleted items check box to show deleted repository files and
folders. Clear the check box to hide deleted repository files and folders. These op-
tions are also available in the View menu. 

l Click Reset Notifications to re-enable any notification dialog boxes that have
been disabled by the user. These notification dialog boxes are not associated with
the Email Notification feature. The following is an example of a notification dialog
box:
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Repository Options

To access repository options, click Repository Options on the Tools menu. The Re-

pository Options dialog box appears.

OptionsTab
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l Select the Comment required with check in operation check box to require
users to enter a comment when checking in a file. If you do not want to require
users to enter a comment, clear the check box. See Checking In Files and Folders
for more information. 

l Specify how long activity log entries should be kept before being automatically de-
leted. You can specify this duration in days, weeks, or months.

n To specify the duration in days, click Days and then enter the number of days.
The valid range for the number of days is 10– 100.

n To specify the duration in weeks, click Weeks and then enter the number of
weeks. The valid range for the number of weeks is 2– 100.

n To specify the duration in months, click Months and then enter the number of
months. The valid range for the number months is 1– 100.

n If you do not want activity log entries automatically deleted, click No Limit.

l To manually delete activity log entries, select the Purge Now check box.

l To restore the repository options to the their default values, click Restore De-
faults.

When the repository options reflect your preferences, click OK. See Activity Log for more

information about activity log entries.
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CommentsTab

From the Comments tab of Repository Options, you can format different comment tem-

plates for common file operations. Every time you perform a comment operation,

FTVersionTrak will use the associated comment template.

l Select your desired file operation and select format.

l Configure the field names and required fields for your selected comment template.

l Preview will allow you to view your work in progress comment template.

l Click save to commit your changes to the template.
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SignatureRequirementsTab
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From the Signature Requirements tab, you can select the file and security operations

that will require signatures to complete.

Comparing Files

ComparingFilesOverview

Any two files on the local machine or in the repository may be compared to each other us-

ing FTVersionTrak's Compare Files utility. You may also compare two versions of the

same file with this feature.

TOCOMPARE TWO FILES:

1. Click Compare Files on the Tools menu or click the toolbar button. A Com-
pare Files dialog box appears. The options on the dialog box depend on the type of
files being compared.
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2. Enter the path of the first file to compare in the Compare box.

l To browse for a file in the repository, click .

l To browse for a file on the local machine, click .

l To compare a specific version of a repository file, select or enter the version num-

ber from the box.

3. Enter the path of the second file to compare in the To box.

l To browse for a file in the repository, click .

l To browse for a file on the local machine, click .

l To compare a specific version of a repository file, select or enter the version num-

ber from the box.

4. If you are comparing two text files, or two versions of a text file, under Text File
Compare Options, select the options you want to use.

l Select the Ignore Leading and Trailing Blanks check box to ignore white
space content at the beginning and end of the files.

l Select the Ignore Leading and Trailing Blanks check box to ignore white
space content at the beginning and end of the files.
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l Select the Ignore All Blanks check box to ignore all differences in white space,
such as spaces and tabs.

l Select the Ignore Case check box to ignore differences in case.

l Select the Ignore Line Endings check box to ignore end of line content.

5. If you are comparing two 505 WorkShop files, or two versions of a 505 WorkShop
file, under 505 Program Compare Options, select the options you want to use.

l For example, if you want to compare only logic, select the Logic check box and
clear the other check boxes.

l For example, if you want to compare only V-Memory and K-Memory, select the
V-Memory and K-Memory check boxes and clear the other check boxes.

6. If you are comparing two PLC WorkShop for Modicon files, or two versions of a
PLC WorkShop for Modicon file, under Modicon Program Compare Options, se-
lect the options you want to use.

l For example, if you want to compare only logic, select the Logic check box and
clear the other check boxes.

l For example, if you want to compare only traffic cop settings, select the Traffic
Cop check box and clear the other check boxes.

7. Click OK to view the file compare results.

ComparingVersions of a File

To compare the differences between two versions of a file:

1. Select the file you want to compare and click History on the Version menu, click

the toolbar button, or right-click and click History from the shortcut menu.
The History dialog box appears.
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2. Select the first version of the file you would like to compare. Then, press CTRL
and select the version of the file you want to compare it with. Finally, click Com-
pare. The Compare Files dialog box appears.

3. Select the Ignore Leading and Trailing Blanks check box to ignore white space
content at the beginning and end of the files (text files only).

4. Select the Ignore All Blanks check box to ignore all differences in white space,
such as spaces and tabs (text files only).

5. Select the Ignore Case check box to ignore differences in case (text files only).

6. Select the Ignore Line Endings check box to ignore end of line content (text files
only).

7. Click OK to view the file compare results.

NOTE: Clicking Compare without selecting more than

one version will compare the selected version to the local

copy. Clicking Compare without selecting any version will

compare the latest version to the local copy.
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FileCompareResults

VIEWING FILECOMPARERESULTS

FTVersionTrak compares three different types of files: binary files, text files, and FasTrak

files. The results of a comparison may differ, depending on the type of files being com-

pared.

FasTrak files are PLC logic files created with either PLC WorkShop for Siemens 505

(*.FSS) or PLC WorkShop for Modicon (*.FMD). When two FasTrak files are compared

to each other, the results are displayed in the FTVersionTrak Viewer. The FTVersionTrak

Viewer displays a side-by-side comparison of all areas of logic, configuration, and other

areas of the program.

l See Viewing File Compare Results for Siemens 505 FasTrak Files and Viewing
File Compare Results for Modicon FasTrak Files for additional information.

Text files, or "plain text" files, only contain textual characters with little or no formatting.

Examples of text files are .TXT files, .HTML source files, and other types of source code

files. When two text files are compared to each other, the results are displayed in the

FTVersionTrak Text Comparison Viewer. The FTVersionTrak Text Comparison Viewer

displays a side-by-side comparison of the two files, with differences highlighted.

l See Viewing File Compare Results for Text Files for additional information.

Binary files include all other file types other than those listed above. When two identical

binary files are compared to each other, the following message appears:

When two different binary files are compared to each other, the following message appears:
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505 FASTRAK FILES

When two PLC WorkShop for Siemens 505 files (*.FSS) are compared, the results are dis-

played in the FTVersionTrak Viewer. The FTVersionTrak Viewer can display a side-by-

side comparison of all areas of logic, configuration, and other areas of the program.

Figure 1–FTVersionTrakViewer displaying 505WorkShopComparisonRes-

ults.

The FTVersionTrak Viewer is divided into four areas:

l Navigation Pane

l Summary Pane

l Details List

l Viewer Toolbar
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THE NAVIGATION PANE

The Navigation Pane displays the compare options that were used to create the com-

parison. (The user selects which compare options to use before a comparison is

performed). Only the options that were selected by the user are displayed in the Navigation

Pane.

Figure 2 – Navigation Pane. In this comparison, only seven compare options

are displayed.

In a 505 WorkShop program, the following compare options can be displayed:

l Logic

l PLC Configuration

l XY Registers

l Control Relays

l WXY Registers

l V-Memory

l K-Memory

l TCP

l I/O

l Profibus I/O

l Forced I/O

l Sequencer Scan Time
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l Alarms

l Loops

l SmarTunes

l Ramp/Soak

l Logic Documentation

l Address Documentation

l Print/Display/Editor Setup

Please see the PLC WorkShop for Siemens 505 manual for more information.

THE SUMMARY PANE

The information that appears in the Summary Pane reflects the currently-selected compare

option in the Navigation Pane. The selected compare option appears as the root of the sum-

mary tree. Each data group (or category) within the compare option appears as a child

below the main root as a branch in the tree.

In the Summary Pane, differences are identified using a colored icon to the left of each cat-

egory or compare option.

l The red icon indicates a difference between the two files.

l The white icon indicates the two files are identical.
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Figure 3 – Summary Pane. Here, the Print/Display/Editor Setup compare op-

tion is selected. A Red Flag is located next to the Logic Display category; this

means there are differences in way the programs have been set up to display

logic.

THE DETA ILS LIST

The Details List displays a side-by-side comparison of the differences between the two

files. The information that appears in the Details List reflects the currently-selected com-

pare option in the Navigation Pane. Differences in the two files are identified with a

customizable color.
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Figure 4 – Details List. Here, differences between the display setup of two

files are displayed.

THE VIEWER TOOLBAR

The Viewer Toolbar, located at the top of the FTVersionTrak Viewer, displays a row of

buttons representing the options available within the FTVersionTrak Viewer.

Figure 5 – Viewer Toolbar.

l Show All – Display all compare options whether there is a difference or not.

l Show Different Only – Display only those compare options where a difference
exists.

l Previous Difference – Display the previous difference.

l Next Difference – Display the next difference.

l Choose Color – Set the color options for the Viewer.

l View Logic – Display logic differences in a graphic format.

l AutoFit Columns – Automatically resize the columns in the Details List to dis-
play all information.

l Generate Report – Generate a Compare 505 WorkShop Files report
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MODICON FASTRAK FILES

When two PLC WorkShop for Modicon files (*.FMD) are compared, the results are dis-

played in the FTVersionTrak Viewer. The FTVersionTrak Viewer displays a side-by-side

comparison of all areas of logic, configuration, and other areas of the program.

Figure 6 – FTVersionTrak Viewer displaying Modicon Program Comparison

Results.

The FTVersionTrak Viewer is divided into four areas:

l Navigation Pane

l Summary Pane

l Details List

l Viewer Toolbar

THE NAVIGATION PANE

The Navigation Pane displays the compare options that were used to create the com-

parison. (The user selects which compare options to use before a comparison is

performed). Only the options that were selected by the user are displayed in the Navigation

Pane.
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Figure 7 – Navigation Pane. In this comparison, only four compare options

are displayed.

InaPLCWorkShopforModiconprogram, the followingcompare options canbe displayed:

l Logic

l PLC Configuration

l Traffic Cop

l ASCII Ports

l Modbus Ports

l Configuration Extensions

l Segment Scheduler

l Segment Information

l Loadables

l Symbols

l 0x Registers

l 1x Registers

l 3x Registers

l 4x Registers

l 6x Registers

l Coils Used
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l Disabled States

l ASCII Messages

l Logic Documentation

l Address Documentation

l Print/Display/Editor Setup

Please see the PLC WorkShop for Modicon manual for more information.

THE SUMMARY PANE

The information that appears in the Summary Pane reflects the currently-selected compare

option in the Navigation Pane. The selected compare option appears as the root of the sum-

mary tree. Each data group (or category) within the compare option appears as a child

below the main root as a branch in the tree.

In the Summary Pane, differences are identified using a colored icon to the left of each cat-

egory or compare option.

l The red icon indicates a difference between the two files.

l The white icon indicates the two files are identical.

Figure 8 – Summary Pane. Here, the Logic compare option is selected. Red

Flags are located next to each segment; this means there are differences in

each segment.

THE DETA ILS LIST

The Details List displays a side-by-side comparison of the differences between the two

files. The information that appears in the Details List reflects the currently-selected com-

pare option in the Navigation Pane. Differences in the two files are identified with a

customizable color.
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Figure 9 – Details List. Here, a difference is found in Network 2.

THE VIEWER TOOLBAR

The Viewer Toolbar, located at the top of the FTVersionTrak Viewer, displays a row of

buttons representing the options available within the FTVersionTrak Viewer.

Figure 10 – Viewer Toolbar.

l Show All – Display all compare options whether there is a difference or not.

l Show Different Only – Display only those compare options where a difference
exists.

l Previous Difference – Display the previous difference.

l Next Difference – Display the next difference.

l Choose Color – Set the color options for the Viewer.

l View Logic – Display logic differences in a graphic format.

l AutoFit Columns – Automatically resize the columns in the Details List to dis-
play all information.

l Generate Report – Generate a Compare Modicon WorkShop Files report.

TEXTFILES

When two text files are compared, the FTVersionTrak Text Comparison Viewer displays a

side-by-side comparison of the contents of the two files, with differences highlighted.
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Figure 11 – FTVersionTrak Text File Comparison Viewer.

The FTVersionTrak Text Comparison Viewer is divided into two areas:

l a side-by-side comparison of the two files, with a color-coded legend that explains
the colors used to indicate the differences in the files

l the Viewer Toolbar

THE VIEWER TOOLBAR

The Viewer Toolbar, located at the top of the FTVersionTrak Text Comparison Viewer,

displays a row of buttons representing the options available within the FTVersionTrak

Text Comparison Viewer.

Figure 12 – FTVersionTrak Text File Comparison Viewer Toolbar.

l To view the differences found in sequential order, click Next Difference to go
to the next difference found between the two files; click Previous Difference to
go to the previous difference.

l To go directly to a specific difference, click the difference you want to view in the
Differences box.

l To search either file for specific text, click Find.
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l To change the colors used in the Comparison Viewer, click Choose Color.

l To generate a report, click Generate Report.

LIVECOMPARERESULTS

Content coming soon.

LiveCompareOptions

Content coming soon.

Comparing Folders

You can compare the contents of any two folders, whether they be on the repository or

your local system.

Tocomparefolders:

1. On the Tools menu click Compare Folders or click the toolbar button. The
Compare Folders dialog box appears.

2. Enter the path of the first folder you would like to compare in the Folder 1 box.

l Browse for a repository folder by clicking .

l Browse for a local system folder by clicking .

3. Enter the path of the second folder you would like to compare in the Folder 2 box.
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l Browse for a repository folder by clicking .

l Browse for a local system folder by clicking .

4. Select the Recursive check box to compare the contents of either of the selected
folders' subdirectories.

5. Select the Compare File Contents check box to compare the similarity of data
between two like-named files.

The contents of the two folders appear as in the following example:

6. Colored highlighting indicates a difference. The differences are defined according to
the compare criteria in the status bar at the bottom of the Compare Folders dialog
box.

l Files contain matching data – A file with the same name and data contents ap-
pears in both of the folders being compared.

l Files contain different data – A file with the same name appears in both of the
folders being compared, but with different data contents.

l File Exists in Folder 1 Only – The file only exists in the folder in the left
column.

l File Exists in Folder 2 Only – The file only exists in the folder in the right
column.

6. Change the status colors by clicking Choose Color.
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7. Compare like-named files by selecting a file in either window. If a like-named file ex-
ists in the other folder, it will be selected automatically. Click Compare Filesto
compare the files.

8. Click Generate Report to generate a Compare Folders Report.

Scheduled Tasks

ScheduledTasksOverview

Use Scheduled Tasks to automatically upload PLC contents to FasTrak files at specified

times. This ensures copies of the programs running in your Simatic 505 or Modicon PLCs

are saved to offline files. These files are stored in FTVersionTrak repositories.

NOTE: Scheduled tasks can be created in FTVersionTrak

PE, but cannot be used in FTVersionTrak PE because these

tasks will not create new versions in repositories, and no ac-

tionsare notrecorded in the Activity Log.

To begin managing scheduled tasks, click Scheduled Tasks on the Tools menu or click

the toolbar button ( ). The Scheduled Tasks dialog box appears.

Scheduled Tasks can be managed with the buttons along the right side of this dialog box.

l Click New Task to create a task.

l Click Test to verify the configured communication path to the specified PLC of
the selected Scheduled Task.

- 277 -



FTVersionTrak User Guide
Chapter 5 – Administrator Guide • Administrative Tools

l Click Run executes the selected Scheduled Task right now instead of its sched-
uled time.

l Click Stop to terminate the selected Scheduled Task if it is currently running

l Click Restore to restore a deleted task.

l Click Delete to delete the selected task.

l Click Properties to edit the properties of the selected task.

Existing tasks are listed with the following information displayed:

l Name - The name of the task.

l Repository - The name of the repository under which the scheduled tasks will
run.

l Run As - The name of the account under which the task runs.

l Action - Describes the action that the task was created to perform:

l CompareUpload -Retrieves afile fromthe PLCandplaces it intoauser's
workingdirectory only if the repository file andPLCfile are different.

l Invalid Task - If an error occurs after creating a task, such as a deletion
of the file to be uploaded, the task becomes invalid.

l Status - The current status of the task:

l Ready–The task is ready to run at the next scheduled time.

l Disabled– The task is currently disabled.

l Deleted - The task was deleted and will not run.

l Not Scheduled–Not all required settings for this task are configured.

l Has Not Run - The task has not yet run.

l Terminated - The last run of the task was terminated by the user.

l Running–The task is currently running.
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l NoMore Runs - There are no more runs scheduled for this task.

l Invalid File - The task is associated with an invalid (non-existing) pro-
gram file.

l InvalidAccount -The owneraccount associatedwith this task is invalid.

l FileName -The name andpathof the versionof the file archived inFTVersionTrak.

l Last Result - The result of the task's action the last time it was run:

l Failed to check in file

l Failed to check out file

l Failed to compare programs

l Failed to connect to repository

l Failed to get file

l Failed to find task record

l Failed to upload

l Succeeded

l Failed

l Destination - The path on the local machine to which the uploaded PLC program
file is saved.

l Last Run - The date and time the task was last performed.

l Next Run - The next date and time the task is scheduled to run.

Creatinga NewTask

Create Scheduled Tasks to upload the contents from Simatic 505 or Modicon PLCs to off-

line FTVersionTrak repository files to help ensure a copy of the current PLC logic is

saved.
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Note: Scheduled Tasks can be created only if you log into

FTVersionTrak with Windows authentication and you are

the Windows Administrator.

To create a new task:

1. Click Scheduled Tasks on the Tools menu or click the toolbar button ( ). The
Scheduled Tasks dialog box appears.

2. Click New Task. The Choose Scheduled Task Type dialog box appears.

This dialog offers four Scheduled Task options. The first three types support the
FasTrak applications that store PLC projects in single files.The fourth selection sup-
ports PLC projects that are stored in families of files by FTSolution for APT.

Select 505 WorkShop Program Upload for PLCs whose logic is edited with PLC
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WorkShop for Siemens 505. The PLC contents are uploaded into.fss files.

Select Modicon WorkShop Program Upload for PLCs whose logic is edited with
PLC WorkShop-32 for Modicon. The PLC contents are uploaded into.fmd files.

Select Hardware Debugger Upload for PLCs whose logic is edited with FTSolu-
tion for APT, but will be uploaded into individual Hardware Debugger .ahd files.

Select Live Compare for PLCs whose logic is edited with FTSolution for APT, but
will be compared to the actual original project source code files.

Click OK.

505 WorkShop, Modicon WorkShop and Hardware Debugger Types

If one of the first three types was selected, the Upload Task dialog box illustrated
below appears

If the Live Compare type was selected, see the Live Compare Type section be-
low.

3. Enter a name for the new task in the Task Name box.

4. Click Browse to search for the PLC WorkShop file to upload. (Either a Simatic

505 (*.FSS) or Modicon (*.FMD) file.)
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5. Click Settings. The Communication Settings dialog box appears.

6. Configure the communications settings for connection to the PLC.

For Modicon Hardware:
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l Serial or Modem Communication Setup

l SA85 Interface Board Communication Setup

l TCP/IP Communication Setup

l APPLICOM Communication Setup

For 505 Hardware:

l Serial or Modem Communication Setup

l TCP/IP Communication Setup

l H1 Board Communication Setup

l Profibus FMS Communication Setup

Click OK in the Communication Settings dialog box to return to the Upload Task

dialog box.

7. Select the path on the local machine to store the archived version in the Destin-
ation box. If the selected repository file has been assigned a working directory, the
working directory path appears in the Destination box. Click Browse to browse to
a different directory.

8. Enter an optional comment about the task in the Comment text box.

9. Toassociate Email Notifications with this task, click ShowEmailNotifications. See
AttachNotifications toScheduledTasks formore informationabout notifications.

10. Click Next when finished. The Create New Task dialog box appears.
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11. Follow the instructions to schedule when the new task occurs.

Live Compare Type

If the Live Compare type was selected, the Create New Task dialog box il-
lustrate below appears.

The Live Compare feature compares the logic in the PLC to the local copy of the
FTSolution source code files from which it was compiled, and identifies any dif-
ferences.

- 284 -



FTVersionTrak User Guide
Chapter 5 – Administrator Guide • Administrative Tools

12. Enter a Task Name to identify it in the Scheduled Tasks list.

13. Enter or Browse the path to the Object File. This is the location in the repository
where the FTSolution project object file resides. Project object file names have an
.aobj extension and are located in the Compile folder.

14. Enter or Select the Version of the FTSolution project stored in the repository to
which the PLC contents are compared. This version number defaults to the most re-
cent version in the repository, but another version number can be selected.

15. Select the Port through which FTVersionTrak connects online to the PLC.

16. Enter or Browse the Working Directory path where the local copy of the project
resides. This entry defaults to the working directories specified for the Object File.

17. Check Save task run results in Working Directory to record the results of the
task locally.

18. Enter a Comment that describes the Scheduled Task.

19. Emails explaining the results of Scheduled Task can be configured. Expand the
Email Notifications to display the email settings.

20. In the Email Notification settings, click Add to display the Email Notifications dia-
log.
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21. Select a Notification Event that emails messages when Scheduled Tasks succeed
or fail.

Consider creating a Failure notification for every Success notification. Failure no-
tifications inform the appropriate people if tasks do not run as scheduled.

Select to whom notifications are sent from the Recipients list, select a template
from the Template list, then click Save to return to the Email Notifications list.

22. A report that identifies differences and the program file can be attached to the email
notifications. In the Email Notifications Events list, check the desired boxes to in-
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clude these items with the emails. Click Next.

23. In the next Create New Task dialog, check the items that are compared when this
Scheduled Task runs. Click Next.
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24. In the next Create New Task dialog, select when the Scheduled Task runs. Click
Next.

25. In the next Create New Task dialog, select at what time of day the Scheduled
Task runs. Click Next.

26. In the next Create New Task dialog, enter and re-enter the Windows user pass-
word. If desired, select the Open advanced properties for this task when I click
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Finish check box. Click Finish.

27. If displaying the advanced properties was selected, the Live Compare Properties
dialog appears. Review and edit its settings if desired. Click OK.

28. When the Scheduled Tasks dialog reappears, the new Scheduled Task is listed.
The task will run at the configured time, but it can be executed now by selecting the
task in the list and clicking Run.
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ModiconSerial or ModemCommunicationSetup

To configure your serial port or modem connection with a Modicon PLC:

1. In Communication Port box, click the communication port you want to use.
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2. If the PLC is password-protected, enter the password in the PLC Password box.

3. Select the appropriate setting for each option in the dialog box:

n Modbus Address – Specifies the value of the controller Modbus address (1-
247).

n Protocol – Specifies the transmission mode. The communications mode toggles
between RTU and ASCII.

n Response T.O. (sec) – Specifies the amount of time, in seconds, that the soft-
ware waits for a response from the PLC before returning a time-out error. Any
whole number between 5 and 25 can be used.

n Retries – Specifies the number of times the software will try to re-establish com-
munications with the PLC after a time-out error. Any whole number between 0
and 10 can be used. Use 0 for no retries.

n Baud Rate – The rate of communications between the computer and modem.

n Parity – Specifies a parity bit for error detection. Can be set to EVEN, ODD, or
NONE.

n Stop Bits – Specifies the number of stop bits per transmission as either 1 or 2.

n BM85 Network – Select NO if you are not communicating via a BM85
Bridge/MUX or modem. Select YES to set a two-minute response timeout for
applications using a Bridge/MUX or modem.

n Dial Modem – Selected when the selected form of serial communications is
through a modem. The modem parameters must be set to exactly the same com-
munication parameters that you will use.

n Telephone Dialing – Specifies which type of dialing to use. Specify pulse di-
aling only if this is the only type your phone line supports.

n Initialization Command – The initialization commands sent to the modem.
Consult your modem manual for a list of appropriate commands.

n Number to Dial - Specifies the phone number to be dialed. The number format
can be dash (262-238-8088), space (262 238 8088), period (262.238.8088), or
none (2622388088). Commas (,) may be used if a pause is needed to gain access
to an outside line before the number is dialed. For example, if 9 is used to gain
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access to an outside line and there is a pause between the time 9 is pressed and a
dial tone, then the number entered should be 9,262-238-8088.

4. Click OK to accept the settings.

ModiconSA85 InterfaceBoardCommunicationSetup

To configure a SA85 interface board for communication with a Modicon PLC:

1. In the Communication Port box, click either SA85 1 or SA85 2. The SA85 set-
tings appear.

2. If the PLC is password-protected, enter the password in the PLC Password box.

3.  Select the appropriate setting for each option in the dialog box:

l Route – Specifies the network location of the PLC you want to communicate
with. Each set of three integers can be a value from 1 – 247 and identifies a
Modbus Plus address. The last address specified is the PLC selected for com-
munications. Any preceding addresses specify the communications path that
leads to the desired PLC. To access the routing path, enter a routing address
(0–247 in the form of X.X.X.X.X) and a 32-character label/path description.
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l Response T.O. (sec) – The response timeout is the amount of time FTVer-
sionTrak waits for a response from the controller before returning a timeout
error.

l BM85 Network – Select NO if you are not communicating via a BM85
Bridge/MUX or modem. Select YES to set a response timeout for applications
using a Bridge/MUX or modem.

l LAN Adapter – Specifies the Local Area Network (LAN) adapter number as-
signed to the SA85 board you are using. If you have multiple SA85 boards
installed, each must have a unique LAN adapter number. Valid values range
from 0 – 9.

l Retries – Specifies the number of attempts to make to connect to the PLC.

4. Click OK to accept the settings.

ModiconTCP/IP CommunicationSetup

To configure a TCP/IP connection with a Modicon PLC:

1. In the Communication Port box, click TCP/IP. The TCP/IP settings appear.
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2. If the PLC is password-protected, enter the password in the PLC Password box.

3.  Select the appropriate setting for each option in the dialog box:

n IP Port – Any number is acceptable as long as it does not interfere with other
protocol numbers.

n Response T.O. (sec) – Specifies the amount of time, in seconds, that the soft-
ware waits for a response from the PLC before returning a time-out error. Any
whole number between 5 – 25 can be used.

n Retries – Specifies the number of times the software will try to re-establish com-
munications with the PLC after a time-out error. Any whole number between 0–
10 can be used. Use 0 for no retries.

n IP Address – Specifies the IP Address for the associated Interface Board. An IP
Address is a 32-bit value that is divided into four 8-bit fields; each separated by a
period. For example, 192.3.2.1 is an IP Address. Each computer on a network
has a unique IP Address. You should consult your network administrator for the
correct IP Addresses for your computer and board.

n MBP Index or Route – Specifies the Bridge MBP Index or Bridge Dynamic
Route as described in the Modicon Modbus plus to TCP/IPmanual.

4. Click OK to accept the settings.

ModiconAPPLICOMCommunicationSetup

To configure an APPLICOM connection with a Modicon PLC:

1. In theCommunicationPortbox, clickAPPLICOM. The APPLICOMsettings ap-
pear.
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2. If the PLC is password-protected, enter the password in the PLC Password box.

3. Select the appropriate setting for each option in the dialog box:

n Channel Number – Specifies the value of the APPLICOM channel.

n Equipment Number – Specifies the value of the equipment number.

4. Click OK to accept the settings.

505 Serial or ModemCommunicationSetup

To configure your serial port or modem connection with a Simatic 505 PLC:

1. Within the Communications Setup dialog box, in the Communication Port box, se-
lect COM 1, COM2, COM 3, or COM4. The Serial Port settings appear.
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2. If the PLC is password-protected, enter the appropriate password information in the
PLC Password, File Password, and Application ID boxes.

3. Select the appropriate setting for each option in the dialog box:

l Response T.O. (sec) – Specifies the amount of time, in seconds, that the soft-
ware waits for a response from the PLC before returning a time-out error. Any
whole number between 5–25 can be used.

l Retries – Specifies the number of times the software will try to re-establish
communications with the PLC after a time-out error. Any whole number
between 0 –10 can be used. Use 0 for no retries.

l Dial Modem – Selected when the selected form of serial communications is
through a modem. The modem parameters must be set to exactly the same com-
munication parameters that you will use.
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l Modem Baud Rate – The rate of communications between the computer and
modem.

l Telephone Dialing – Specifies which type of dialing to use. Specify pulse di-
aling only if this is the only type your phone line supports.

l Force NITP – Specifies ASCII communications for the Simatic 545, 555, and
575 PLCs.

l Initialization Command – The initialization commands sent to the modem.
Consult your modem manual for a list of appropriate commands.

l Number to Dial – Specifies the phone number to be dialed. The number
format can be dash (262-238-8088), space (262 238 8088), period
(262.238.8088), or none (2622388088). Commas may be used if a pause is
needed to gain access to an outside line before the number is dialed. For ex-
ample, if 9 is used to gain access to an outside line and there is a pause between
the time 9 is pressed and a dial tone, then the number entered should be 9,
262-238-8088.

l Use TIWAY – Specifies connection with either the TIWAY host adapter or
UNILINK™.

l MHIU/HIU Address – Specifies the address for the TIWAY Master Host In-
terface Unit / Host Interface Unit.

l Maximum Secondary Address – Specifies the maximum number of sec-
ondary PLCs (up to 254).

l TIWAY Secondary Address – Specifies the controller secondary address for
the associated controller. A controller secondary address is a unique number
from 1 – 254 that is used to identify a controller on the TIWAY link. Each
PLC on TIWAY has a controller secondary address.

4. Click OK to accept the settings.

505 TCP/IP CommunicationSetup

To configure a TCP/IP connection with a Simatic 505 PLC:

1. In the Communication Port box, click TCP/IP. The TCP/IP settings appear.
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2. If the PLC is password-protected, enter the appropriate password information in the
PLC Password, File Password, and Application ID boxes.

3. Select the appropriate setting for each option in the dialog box:

l IP Port – Any number is acceptable as long as it does not interfere with other
protocol numbers.

l Response T.O. (sec) – Specifies the amount of time, in seconds, that the soft-
ware waits for a response from the PLC before returning a time-out error. Any
whole number between 5 – 25 can be used.

l Retries – Specifies the number of times the software will try to re-establish com-
munications with the PLC after a time-out error. Any whole number between 0 –
10 can be used. Use 0 for no retries.

l IP Address – Specifies the IP Address for the associated Interface Board. An IP
Address is a 32-bit value that is divided into four 8-bit fields; each separated by a
period. For example, 192.3.2.1 is an IP Address. Each computer on a network
has a unique IP Address. You should consult your network administrator for the
correct IP Addresses for your computer and board.

l Packed – This option is used for optimizing the Ladder Status and Data Win-
dow updates. This should only be turned off if packed opcodes are not
supported.
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4. Click OK to accept the settings.

505 H1 BoardCommunicationSetup

Before H1 Communications can be established with FTVersionTrak the following pro-

cedures must be completed:

1. Install the Siemens 505-CP1413 or 1613 card.

2. Select I/O range.

3. Select unique interrupt address.

4. Select dual-port ram address.

5. Install TF-1413 or TF-1613 software drivers using the Simatic Net software CD.

6. Configure the CP1413 or 1613 hardware and software using the COML TF and Set-
ting the PG-PC Interface utilities from Siemens' Simatic Net software CD.

7. Restart the PC.

ACCESSINGH1DEVICESUSING FTVERSIONTRAK

1. In the Communications Setup dialog box, select H1 from the Communication
Port box. The H1 Network Access dialog box appears.
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2. Select a node name. These are the node names you configured using the COML TF
utility prior to rebooting. Using the arrow keys or mouse, select an H1 network
node name and click OK.

505 ProfibusFMS CommunicationSetup

INSTALLING THEPROFIBUS–FMSCOMMUNICATIONS PROCESSOR

Before Profibus FMS Communications can be established with FTVersionTrak, the FMS

Communications Processor module must be installed and configured. The SIMATIC 505-

CP5434-FMS Communications Processor module (referred to hereafter as the FMS CP

module) provides the interface required for a SIMATIC 505 programmable logic controller

system to communicate with other devices over a common PROFIBUS network. To in-

stall the FMS CP module in a SIMATIC 505 base, follow the installation instructions in

the SIMATIC 505 PROFIBUS–FMS Communication Processor (505-CP5434-FMS) User

Manual.

The FMS CP module must be configured with the COM5434 configuration software in-

cluded with the module. The COM5434 configuration software operates in Windows 95

or Windows NT only. To install the software, follow the installation instructions in the

SIMATIC 505 PROFIBUS–FMS Communication Processor (505-CP5434-FMS) User Manual.

Each FMS CP module in a 505 base must be configured to communicate over the

PROFIBUS network. The "module local configuration" for each FMS CP module iden-

tifies its station address and the network communication parameters it uses to operate on

the network.

NOTE: You must define the module local configuration for

each FMS CP module using the RS-232 port with the stand-

ard 505 WorkShop programming cable before you can

communicate with it using the PROFIBUS-FMS port.

Refer to the SIMATIC 505 PROFIBUS-FMS Communication Processor (505-CP5434-FMS)

User Manual for complete information on configuring the FMS CP module with the

COM5434 configuration software.
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NOTE: Make sure to select the bus parameters, the baud

rate, and the highest station address (HSA) that match those

of all the other modules on the network. Also be sure to se-

lect a unique station address for each FMS CP module on

the network.

Once each FMS CP module has been configured to operate on the network, connect each

FMS CP station and the CP 5412 card in your PC to the PROFIBUS network, using the

PROFIBUS cables and connectors described in the SIMATIC 505 PROFIBUS-FMS Com-

munication Processor (505-CP5434-FMS) User Manual.

ACCESSING FMSPROFIBUSDEVICESUSING FTVERSIONTRAK

1. In the Communications Setup dialog box, select FMS from the Communication
Port box. The FMS Network Access dialog box appears.

2. Select a node name. These are the node names you configured using the COM5434
configuration software prior to rebooting. Using the arrow keys or mouse, select an
FMS network node name and click OK.
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Backing Up and Restoring the Repository Database

BackingUpandRestoringtheRepositoryDatabaseOverview

As an added precaution to protect your sensitive data, an entire FTVersionTrak repository

database may be backed up and restored using Microsoft SQL Server Management Stu-

dio. In the unlikely event that your repository becomes corrupt or accidentally deleted, it

can be replaced by the backup copy. Repositories can also be moved from one machine or

server instance to another using the same method.

NOTE: Restoring your repository database will only re-

store it to the point in time in which it was last backed up.

We recommend backing up your repository database often

and to a secure location.

Repository databases can be backed up and restored to the same machine in which SQL

Server resides or imported to a remote machine that has access to the instance of SQL

Server that contains your repositories.

NOTE: Only SQL administrators can back up and restore

repositories. See Server Securityfor more information.

BackingUptheRepositoryDatabase

To back up your repository database:

1. Launch SQL Server Management Studio. If you do not have SQL Server Man-
agement Studio installed, see Installing SQL Server Management Studio for more
information. The Connect to Server dialog box appears.
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2. Connect using the administrator login for the instance of SQL Server that contains
your FTVersionTrak repositories. See Server Security for more information. The
main window of SQL Server Management Studio Express appears.

3. Within the Object Explorer pane on the left side of the main window, select Data-
bases.

4. In the Summary pane on the right side of the main window, a list of databases ap-
pears, including your FTVersionTrak repositories.
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5. Right-click the name of the repository you wish toback up, point toTasks, and then
clickBackUp fromthe shortcut menu. The Back UpDatabase dialogboxappears.
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6. Under Backup set, in the Name box, you can specify a name for the backup set.
By default, the name is <repository name>-Full Database Backup. Keep this name con-
sistent if you plan on backing up frequently.

7. In theDestinationbox, make note of the pathandname of the backupfile, whichby de-
fault is<repository name>.bak. You will need toreference this file whenrestoring.

8. Click OK at the bottom of the Back Up Database dialog box to begin backing up
the repository database. Depending on the size of your repository, this may take
some time.

9. After the backup process is finished, a message appears.

10. Click OK to complete the backup.

NOTE: Management Studio Express contains many options

that may facilitate the backup procedure, especially if the re-

pository databases are very large. Click Help in the Back

Up Database dialog box for more information.

RestoringtheRepositoryDatabasetotheSameMachine

In most cases, restoring a repository will take place on the same machine as the one used

when the backup is made. See Importing a Repository Database to a New Machine for in-

structions on restoring a backed up repository to a new machine or another instance of

SQL Server. Before you can restore a repository database, it must first be backed up.

To restore a repository database:

1. Launch SQL Server Management Studio. If you do not have SQL Server Man-
agement Studio installed, see Installing SQL Server Management Studio for more
information. The Connect to Server dialog box appears.
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2. Connect using the administrator login for the instance of SQL Server that contains
your FTVersionTrak repositories. See Server Security for more information. The
main window of SQL Server Management Studio Express appears.

3. In the Object Explorer pane on the left side of the main window, click
Databases.

4. In the Summary pane on the right side of the main window, a list of databases ap-
pears, including your FTVersionTrak repositories.
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5. Right-click the name of the repository you wish to restore, point to Tasks, point
to Restore, and then click Database from the shortcut menu. The Restore Data-
base dialog box appears.
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6. If you are restoring the same repository location that was backed up, all of the de-
fault settings should be correct. Click OK to begin restoring the repository.

NOTE: If you would like to restore an exact copy of the

backed-up repository, click Options at the top left corner of

the dialog box and select the Overwrite the existing data-

base check box before clicking OK at the bottom of the

Restore Database dialog box.

REPLACING AREPOSITORYDATABASEWITH ADIFFERENTBACKUP

To replace an existing FTVersionTrak repository database with a backed-up copy of an-

other database:

1. Launch SQL Server Management Studio. If you do not have SQL Server Man-
agement Studio installed, see Installing SQL Server Management Studio for more
information. The Connect to Server dialog box appears.

2. Connect using the administrator login for the instance of SQL Server that contains
your FTVersionTrak repositories. See Server Security for more information. The
main window of SQL Server Management Studio Express appears.
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3. In the Object Explorer pane on the left side of the main window, click
Databases.

4. In the Summary pane on the right side of the main window, a list of databases ap-
pears, including your FTVersionTrak repositories.

5. Right-click the repository database you wish to replace, point to Tasks, point to
Restore, and then click Database from the shortcut menu. The Restore Database
dialog box appears.

6. Under Source for restore, click From device and then click Browse . The
Specify Backup dialog box appears.

- 309 -



FTVersionTrak User Guide
Chapter 5 – Administrator Guide • Administrative Tools

4. Click Add and browse to the location of the backup file that you want to restore.
Click OK in the Specify Backup dialog box to return to the Restore Database dialog
box. The database now appears under Select the backed up sets to restore.

5. Note that the original name of the database appears under the Name column. Select
the check box under the Restore column.

6. Click Options in the top left corner of the Restore Database dialog box. The
Restore Database options appear.
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7. Under Restore the database files as, two files are listed. These two files will need
to be renamed to the match the name of the database that is being replaced. For ex-
ample, the database that is being replaced in the preceding example is named
Project A, and it is being replaced by a database named Test3. The two files that
need to be renamed are Test3.mdf and Test3_log.LDF. In the following figure,
they are renamed Project A.mdf and Project A_log.LDF. Click in the file path in
the Restore As column to rename each file.
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NOTE: Continuing this process will overwrite the data

present in the existing repository. This process cannot be re-

versed. Continue at your own risk.

8. Select the Overwrite the existing database check box. Click OK when finished
to begin replacing the database. Depending on the size of your repository, this may
take some time.

9. After the backup process is finished, a message appears.

10. Click OK to complete the backup.

Importinga RepositoryDatabasetoa NewMachine

Using the Restore Database function of SQL Server Management Studio Express, you can

import a backed up repository database to another computer or another instance of SQL

Server 2005. Before performing the following steps, you must create a repository on the

server in which you will be importing the database. This repository will be overwritten by

the imported data. You must also make a note of all the server accounts that will need ac-

cess to the repository, and their authentication type. This information will not be imported,

and must be entered manually. See Server Security for more information.

To import a repository database to a new machine or another instance of SQL Server:

1. Back up the repository database that you will be importing using Management Stu-
dio Express.

2. Move the backup file (*.BAK) to the new machine or otherwise verify that the new
instance of SQL Server has access to the file.

3. On the new machine or SQL Server instance, launch Management Studio Express
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and follow steps 1–8 of Restoring the Repository Database with a Different Backup.

4. Launch SQL Server Configuration Manager on the new machine.

5. Right-click the SQL Server instance that contains the newly-imported repository
(usually SQL Server (FTVERSIONTRAK)) and then click Properties from the
shortcut menu. The SQL Server Properties dialog box appears.
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6. On the Log On tab, click Built-in account and then select Local System. Click
OK to return to the main window.

7. Close the Configuration Manager and return to Management Studio Express.

8. To add existing users to the server, right-click Security in the Object Explorer,
point to New, and then click Login from the shortcut menu. The Login - New dia-
log box appears.

9. Select the proper authentication type (either Windows authentication or SQL Server
authentication) for the user you are adding.

l If selecting Windows authentication, enter the Login name.

l If selecting SQL Server authentication, enter the Login name and Password.

10. Click OK when finished.

11. Repeat steps 8–10 for each additional user.
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NOTE: Windows authenticated users must have a Win-

dows login on the new machine to have access to the

repository. If this is not possible, create a SQL Server ac-

count for these users in FTVersionTrak Server Security.

12. To add existing users to the database, select the name of the repository database in
the Object Explorer and right-click Security in the database Summary pane.
Then, point to New and click User from the shortcut menu. The Database User -
New dialog box appears.

13. Enter each user's login name in both the User name text box and the Login name
text box. Click OK when finished.

14. Repeat steps 12-13 for each additional user.

15. Right-click the repository database in the Object Explorer and then click New
Query from the shortcut menu. The SQL Query Editor tab appears.
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16. Enter the following SQL statement in the SQL Query Editor, substituting <login
name> for a login name added to the database.

SP_change_users_login 'update_one', '<loginname>', '<loginname>'

17. Press ENTER and enter the same line above, substituting <login name> for each
login you need to add, as shown in the following example.

18. After all login names have been entered, click in the Management Studio
toolbar. A Messages tab appears, displaying the results of the SQL query. If
everything has been entered correctly, the following message is displayed.

19. Close the Management Studio Express application. The repository database and user
information has been successfully imported.
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Activity Log report 117
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network 176

administrative tools 249

Administrator Guide 123

APPLICOM 294
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ASCII 291
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backup 302, 305

backup file 310

BM85 Bridge/MUX 157, 291

BP85 154

Bridge/MUX 291

C
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change management 13, 15
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undo 76
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file 37
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customer support 14
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delete

delete versions of a file 88
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files 61
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H
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History Report 102

I
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L
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log filter options 250
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M
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N

network configurations 179
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network setup 142, 178

saving 178

network setup history 182

network setup prerequisites 142

network setup toolbar 143

network tree 144

new folder 54

Notifications Viewer 214
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PLC 148, 152, 193-194, 277, 294-295, 297

assigning 193

PLC WorkShop 264-265, 270

Modicon 264, 270

Siemens 505 264-265

port 151

privileges 228, 235

PROFIBUS 300

PROFIBUS-FMS 300

R

removing 223

users 223

rename 54, 60

report 104, 106-107, 186

compare files 106-107

network setup history report 186

search results 104

reports 99-100, 102, 107, 110, 113, 115, 117, 185,

187, 189, 191

Activity Log Report 117

compare 505 WorkShop files 110

compare folders 115

Compare Modicon WorkShop Files

Report 107

Compare Network Setup Report 189

compare text files 113

filesystem 100

generating 99

history 102

Network Setup PLC Assignment

Report 191

Network Setup Report 187

Network Setup Reports 185

repository 45-46, 48, 227, 254

connecting 48

creating 46

security 227

repository database 302, 305

repository file system 45

repository options 255-258

repository privileges 48
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deleted files 62

restore database 312

restoring default email templates 202

restrictions 135

rollback 89

RTU 291

S

SA85 151, 292

saving 178

schedule 277

scheduled tasks 277

search 92, 98, 104

files 92

search results 98, 104

search syntax 94

security 220, 227-228

serial 151

serial port 290, 295

server 46, 49, 137, 220, 222

server security 220, 222

setting 67

working directory 67

setup 137

Siemens 505 265

sign 83

Simatic 505 277

Simatic 505 PLC 297

SQL 222

SQL authentication 51, 220, 223-224

SQL login 223

SQL server 137-138, 220, 222-223, 312

SQL server authentication 226

SQL Server Management Studio 302, 305, 308,

312

state 83, 251

status bar 40

T

tasks 277

TCP/IP 151, 160, 164, 167, 171, 293, 297

text 113

text files 273

TIWAY 297

troubleshooting 137-138

U

UAC 126

undo check out 76

upload 277, 279

user 223

editing 226

removing 223

user access control 126

username 51, 224

V

version 88, 262
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